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GENERAL SAFETY PRECAUTIONS 

The equipment described in this manual has been designed in accordance with EN61010 

"Safety requirements for electrical equipment for measurement, control and laboratory 

use", and has been supplied in a safe condition.  To avoid injury to an operator or service 

technician the safety precautions given below, and throughout the manual, must be strictly 

adhered to, whenever the equipment is operated, serviced or repaired.  For specific safety 

details, please refer to the relevant sections within the manual. 

The equipment is intended solely for electronic measurement and should be used for no 

other purpose. The equipment protection may be impaired if it is not operated in a manner 

as specified by Solartron and detailed in this document. Solartron accept no responsibility 

for accidents or damage resulting from any failure to comply with these precautions. 

GROUNDING  

To minimise the hazard of electrical shock, it is essential that the equipment be connected 

to a protective ground through the AC supply cable.  The continuity of the ground 

connection should be checked periodically. 

AC SUPPLY VOLTAGE  

Never operate the equipment from a line voltage or frequency in excess of that specified.  

Otherwise, the insulation of internal components may break down and cause excessive 

leakage currents. The equipment is to be used with an IEC 60799 compliant mains supply 

cord, rated for the correct voltage and power rating as detailed on the rear panel. 

FUSES 

Before switching on the equipment check that the fuses accessible from the exterior of 

the equipment are of the correct rating.  The rating of the AC line fuse must be in 

accordance with the voltage of the AC supply. 

T10A H 250V (100-120V mains supply) 

T5A H 250V (220-240V mains supply) 

Should any fuse continually blow, do not insert a fuse of a higher rating.  Switch the 

equipment off, clearly label it "unserviceable" and inform a service technician. 

EXPLOSIVE ATMOSPHERES 

You must NEVER OPERATE the equipment, or any sensors connected to the equipment, 

in a potentially explosive atmosphere.  The equipment is NOT designed for use in these 

conditions and could possibly cause an explosion. 

SAFETY SYMBOL 

For the guidance and protection of the user, the following safety symbol appears on the 

equipment: 

Symbol Meaning 
 

 

General safety hazard. Refer to the operating manual for detailed 

instructions. 

 

Electrical safety hazard. This symbol may appear alongside the general 

safety hazard symbol, together with a voltage. 
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General Safety Precautions  (continued from previous page) 

 

Symbol Meaning 

 

Safety hazard involving heavy weights. A numerical value for the 

amount of weight may appear alongside this symbol. Take care when 

handling and carrying. Follow the manufacturer’s instructions, and ask 

for assistance if necessary. 

NOTES, CAUTIONS AND WARNINGS  

For the guidance and protection of the user, Notes, Cautions and Warnings 

appear throughout the manual.  The significance of these is as follows: 

NOTES highlight important information for the reader’s special attention. 

CAUTIONS guide the reader in avoiding damage to the equipment. 

WARNINGS guide the reader in avoiding a hazard that could cause injury or 

death. 

AVOID UNSAFE EQUIPMENT  

The equipment may be unsafe if any of the following statements apply: 

• Equipment shows visible damage. 

• Equipment has failed to perform an intended operation. 

• Equipment has been stored in unfavourable conditions. 

• Equipment has been subjected to severe physical stress. 

If in any doubt as to the serviceability of the equipment, don't use it.  Get it 

properly checked out by a qualified service technician. 

LIVE CONDUCTORS  

When the equipment is connected to its measurement inputs or supply, the 

opening of covers or removal of parts could expose live conductors.  The 

equipment must be disconnected from all power and signal sources before it is 

opened for any adjustment, replacement, maintenance or repair.  Adjustments, 

maintenance or repair must only be done by qualified personnel, who should 

refer to the relevant maintenance documentation. 

EQUIPMENT MODIFICATION  

To avoid introducing safety hazards, never install non-standard parts in the 

equipment, or make any unauthorised modification.  To maintain safety, always 

return the equipment to your Solartron service provider for service and repair. 
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Text Conventions 

The following text conventions are used in the ModuLab XM MTS 

documentation: 

• Bold text is used for headings.  

• Blue text is used for names and titles of features of the ModuLab XM 

hardware and software, when it is required that the user, at this point, should 

find these features on the system.  

• Italic text is used for words and phrases that have a specific meaning within 

ModuLab XM, without being names or titles, for example project, 

experiment and step. Definitions of the italicised words and phrases are in the 

Glossary of Terms.  

• Finger pointers are used for cross-references, for example:  

 Chapter 8, Glossary of Terms. 
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1. The ModuLab® XM MTS System  

1.1 SYSTEM OVERVIEW 

The ModuLab XM MTS Materials Test System is a highly versatile test system 

for measuring the characteristics of materials. A number of modules are 

combined into a single chassis, avoiding the need for stacking and wiring separate 

units. The modules are arranged in groups, known as instrument groups, each 

with a materials core module to enable DC measurements to be taken. Other 

modules in the group may provide AC functionality, or the measurement of high 

voltages, high impedances, or high power applications. Each instrument group in 

a chassis may perform a separate experiment, so there can be multiple 

experiments running simultaneously. 

The modules in each group communicate with each other through the chassis 

backplane, and some of them are connected to an Ethernet hub, also mounted in 

the chassis, so that the system can be connected to an external PC running the 

ModuLab XM software for control and monitoring purposes. 

The modules are mounted in slots in the chassis and can be removed and replaced 

as described in the Installation Guide, so that you can design and modify the 

system according to your requirements (although it is normally supplied with the 

modules assembled and configured for a specific purpose). 

The ModuLab XM system is available with two different chassis sizes, depending 

on the number of modules required: 

• The 4-slot chassis that takes up to four modules. 

• The 8-slot chassis that takes up to eight modules. 

 For more sophisticated test purposes, it is possible to build an expanded 

system by combining multiple ModuLab XM chasses through the Ethernet 

link, as described in the Installation Guide.  

1.1.1 Instrument Groups 

A group of modules in the chassis, consisting of a materials core module (XM 

MAT 1MHz) and a number of optional modules, is known as an instrument 

group. 

There are a number of optional module types, and an instrument group can 

contain only one module of each type. These are the frequency response analyzer, 

high voltage module, femto ammeter, sample and reference module, and booster. 

The optional modules, if fitted, must be installed in the correct slots in relation to 

the materials core module, as follows: 

• If a frequency response analyzer is used, it must be in the adjacent slot to the 

left of the core module. 

 
 ModuLab XM is a trademark of Solartron Analytical. 
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• If a high voltage module, femto ammeter, sample and reference module or 

booster is used, they must be in adjacent slots to the right of the core module. 

If there is more than one module type, they must be arranged in the following 

order, from left to right: 

1.  High voltage module; 

2.  Femto ammeter module; 

3.  Sample and reference module; 

4.  Booster module, occupying two slots. 

As long as these rules are observed, a core module and its companion modules 

may occupy any slots in the chassis, and if core modules are used on their own to 

take measurements, they can be installed in adjacent slots in any order. 

Some examples of module arrangements are shown in Figure 1-1.  

 

Figure 1-1 Example of instrument groups 

In this example, the modules are arranged from left to right as follows: 

• Group 1. A frequency response analyzer alongside a core module, followed 

by a high voltage module, femto ammeter, sample and reference module, and 

2A booster, for DC and AC measurements at high voltage, and either at high 

impedance or high power. The femto ammeter and 2A booster can be 

installed within the same group, but cannot be used in the same experiment. 

Either the femto ammeter would be used for high impedance, or else the 2A 

booster for high power. 

• Group 2. A core module by itself to perform DC measurements. 

Group 2

MAT

Group 1

MATMFRA MHV MFA MBST 2AMREF
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The ModuLab XM MTS system is normally supplied with all the modules 

installed, according to your requirements, so that it is only necessary to check that 

the modules are present and in the correct order. 

1.1.2 Getting Started with ModuLab XM MTS 

When you receive delivery of your ModuLab XM system, you will need to work 

through the manuals in the following order: 

• The Getting Started manual gives a limited set of installation instructions, 

sufficient to connect the ModuLab XM chassis to a PC and run a simple DC 

experiment using a ready-made software configuration, and a test unit known 

as the Dielectric Reference Module to represent a material sample. This test 

will verify that the core module can communicate with the PC and is able to 

obtain some results from the test unit. 

• The Installation Guide gives instructions about how to set up the system and 

perform a wider range of experiments, so that all the installed modules can be 

tested using the Dielectric Reference Module (or the ModuLab MTS 0.1 Ω 

Test Unit for high power applications). A variety of hardware configurations 

are described, including expanded systems with multiple chasses. 

• This User Guide describes how to set up your system to perform experiments, 

using a number of standard connection configurations that will be suitable for 

most types of material samples. You can set up your experiments from the 

ModuLab XM software, so that the sample is subjected to excitation signals 

to produce a variety of responses, in terms of waveforms which may be 

linear, oscillating, staircase, etc. The results can be displayed graphically 

during the experiment, or the stored results can be displayed afterwards and 

exchanged with other users. 

An online Help system is supplied with the ModuLab XM software, so that you 

can quickly access information about the software features that you are using.  

 

Be careful when lifting and carrying the ModuLab XM system, as it 

is heavy and has no carrying handles. It should normally be carried 

by two people, gripping firmly under the footrests at the front and 

rear. 

 General Safety Precautions at the beginning of this manual. 
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2. ModuLab XM MTS Control 
Features  

2.1 INTRODUCTION TO THE USER INTERFACE 

The ModuLab XM MTS system is controlled by a PC running the ModuLab XM 

software which has been installed as described in the ModuLab XM MTS 

Installation Guide, or the Getting Started Guide. 

When the installation is complete, the user will be able to set up projects, which 

define the experiments to be performed and the graphical and tabulated display of 

results. 

To start the ModuLab XM MTS software: 

1. On the PC, double-click the ModuLab XM MTS icon on the Windows 

desktop: 

 

Alternatively, you can navigate to the ModuLab XM MTS application from 

the Windows Start menu. The path is: 

Start → All Programs → Solartron Analytical → ModuLab XM → ModuLab 

XM MTS 

The ModuLab XM MTS software opens, briefly displaying a screen as 

follows: 
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This is followed by the opening screen as follows: 

 

This screen has a left-hand navigation panel, displaying the structure of the 

currently open project, in this case Getting Started. The right-hand window 

displays a screen corresponding to the currently selected item in the 

navigation panel, in this case a Welcome screen, which is the same for the top 

level item of all projects. 

When ModuLab XM MTS is started, it will open a project according to the 

following rules. 

• If the previous session of ModuLab XM was closed while a project was 

open, ModuLab XM will open with the same project. 

• If the previous session of ModuLab XM was closed without a project, 

ModuLab XM will open without a project and the left-hand navigation 

panel will be empty. You will have to open a project, or create a new one. 

• If you have just installed ModuLab XM and you are running it for the 

first time, the Getting Started project will open by default. 

This User Guide describes how to add a new project and create your own 

experiments, but for the purpose of reviewing the user interface, the Getting 

Started project will be suitable. 
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2. If ModuLab XM MTS has opened without a project, you will need to open 

one or create a new one, then continue with these instructions.  

 Section 5.1.1, Create New Project.  

 Section 5.1.2, Opening and Closing Projects.  

A project normally opens in a 

semi-collapsed state, showing 

the first two levels of the item 

structure in the navigation 

panel, as shown on the left 

below. 

A project structure can be expanded by 

clicking on any (+) symbols alongside the 

item names, then clicking the (+) symbols 

on the subsidiary items. A typical 

expanded structure for the Getting Started 

project, including a data item representing 

the results of the Materials Core Module 

Test (MAT Test), is shown on the right 

below: 
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3. Click on the items in the project structure to display their details in the right-

hand window. For example, if you click the Setup item under MAT Test, the 

experiment setup details will appear as follows: 

 

The User Interface can be described generally as follows: 

Underneath the title bar there is the menu bar and toolbar, and then there are two 

windows: 

• The left-hand navigation panel contains a tree structure of items that can be 

expanded and collapsed by clicking their associated (+) and (-) symbols. At 

the bottom of this window there are two tabs: 

• System. This tab displays a tree structure of items that are used to define 

the user preferences and the equipment, including the chassis and 

materials core modules, together with their associated optional modules 

and external units. 

• Project. This tab displays a tree structure of project items that are used to 

define experiments and data. 

These two tabs can be moved to the top left of the navigation panel, by 

clicking the pin button at the top right of the panel as follows: 
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When the tabs are pinned in this way, the navigation panel only appears when 

the cursor is held over the tab. The tabs can be returned to the bottom of the 

screen by clicking the pin button again. 

• The main right-hand window contains the configuration and data associated 

with the selected item within the tree structure. This may be divided into sub-

screens for different types of display purposes, and some of these can be 

expanded and collapsed using the arrow buttons: 

 . 

When an item is selected in the left-hand navigation panel, the path to the item is 

shown at the top of the right-hand window as follows: 

 

If Show Status Grid is selected from the Experiment menu, a panel appears at the 

bottom of the right-hand window, showing the status of the modules. 

 Section 2.6, Status Grid. 

At the bottom of the screen there is a small panel which displays status messages, 

describing the current activity of the system. 

 Section 2.6.3, Module Information. 

2.1.1 System 

When the System tab is selected and the tree structure is expanded, the navigation 

panel is as follows (depending on the installed equipment): 

 

The structure is as follows: 

• User Preferences. This enables you to give general information about the 

whole system, including units, messages, graphics and country-specific 

features. 

 User Preferences, Section 4.1. 
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• Equipment library. This item displays a summary of the equipment, and 

there is a structure of sub-items as follows: 

• At the first level there is the chassis, or multiple chasses in an expanded 

system. 

• At the second level, under the chassis, there are the instrument groups, 

each with a materials core module and optional modules as required. 

Some of the optional modules are specified in the Instrument Group 

Setup while others are detected automatically by the system. 

 Instrument Group Setup, Section 4.2.3. 

 Equipment library, Section 4.2. 
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2.1.2 Project 

When the Project tab is selected and the tree structure is expanded, the navigation 

panel is as follows (using a different project in this case instead of Getting 

Started, with a wider range of features): 

 

The top level item is the project name, in this case Example Project. This contains 

a structure of items, and may include general purpose folders in which additional 

structures may be created. 

 Folders, Section 2.1.2.1. 
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A project or folder can contain the following items: 

• Experiment. This gives a summary of an experiment and the control features 

that enable you to run it. 

• Setup. This describes how the experiment is to be performed, including 

the sample and the modules to be used. An experiment may contain loops 

and steps as follows: 

• Loop. This defines a set of measurements to be taken repeatedly, and 

may contain any number of steps either directly within the loop or in 

additional nested loops. 

• Step. This defines an excitation signal to be applied to the sample, 

which may belong to any of the following categories: 

General 

Voltage Waveforms (DC) 

Voltage Controlled Impedance (AC, C-V, Mott-Schottky) 

The step types are listed under their appropriate category when a new 

step is added. You can select a step type from the list and an 

appropriate screen will appear, and then you can specify the detailed 

configuration. 

Steps can exist directly under an experiment Setup, or they can be 

within loops to take repeated measurements, or under decision 

options. 

 Step, Section 5.6. 

• Decision. This item contains options to be evaluated so that steps can 

be carried out. 

• Option. This item, under a decision, evaluates a condition and 

carries out steps, depending on the result. 

• Data. This is generated by running experiments and obtaining results 

which are displayed as tabulated lists and graphs. If the experiment 

contains loops and sub-loops, the data will be generated at multiple levels 

in the tree structure. A data filename is specified when the experiment is 

run, although it defaults to the experiment name. 

• Graph. This is a graphic display feature that can access the data generated 

by experiments and display it with the appropriate axes, and make it 

accessible to reports. This feature can be added to a project independently of 

any experiments, and then the data from different experiments can be 

imported for display and comparison. Alternatively, it can be created from a 

data item, after running an experiment, and will access all the results of the 

experiment by default. 

 Graph File, Section 5.11.3. 
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• Report. This is a document containing experiment settings and data, 

including connection diagrams, graphic displays, tables and user comments. 

Reports are generated within a report folder, using the Report Writer. 

 Reports, Section 5.13.  

Graphs and report folders can be added at multiple levels within the project, 

either directly under the project, or under an experiment or folder. 

 The complete list of items that can be added under other items, using Add 

New in the File Menu, is in Section 2.4.1. 

2.1.2.1 Folders 

ModuLab XM MTS uses a system of files and folders, based on the Windows 

directory structure, to build projects. The project itself is a folder, directly under 

the ModuLab XM folder, so that the pathname for the Example Project might be: 

C:\My Data\ModuLab MTS\Example Project 

The project may contain experiments, which are also folders. A folder 

representing a project or experiment has a specific meaning in ModuLab XM, so 

that it is recognised from its contents and the appropriate item appears in the left-

hand navigation panel. Underneath a project or experiment, you can add sub-

folders for general purpose use, with the default name “Folder”, and they can be 

used as a location for other items including other experiments. 

You can also add report folders to a project, experiment or general purpose 

folder, and these will be recognised from their contents as having a specific 

meaning in ModuLab XM. They appear in the navigation panel as report items, 

and when you click on them, a Report Writer appears so that you can generate 

report files from the graph files associated with experiments. 

 Reports, Section 5.13. 

Although a report folder has the same properties in Windows as any other folder, 

you cannot add a sub-folder from within ModuLab XM, because it would not 

make sense to do so. There would be no point, for example, having a sub-folder 

containing an experiment , because the reports themselves depend on experiments 

that have already been performed. 

 Add New in the File Menu, Section 2.4.1, for details of the positions in the 

project structure where experiments, report folders and general-purpose 

folder items can be added.  
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2.2 EDITING THE NAVIGATION PANEL 

The tree structure in the navigation panel can be modified in a number of ways. 

• New items can be added where appropriate, under the currently selected item, 

by selecting Add new from the File menu or toolbar, or from the drop down 

menu that appears when right-clicking the item. The available items depend 

on the current position in the tree structure. 

• Items can be cut, copied, pasted or deleted, using the Edit menu or toolbar, or 

the drop down menu that appears when right-clicking the item. However, to 

maintain the structure of the project, these features are only available where 

appropriate, otherwise they are greyed out. 

• Items can be moved from one position in the tree to another, by dragging 

them up and down, but only in circumstances where the structure of the 

project can be maintained. 

• Items can be renamed so that they represent the features of your experiment. 

To rename an item, click once to select it, then click again, then re-type the 

name. This feature is not available for the data items generated from an 

experiment, but is available for the folders in which they are held. 

2.2.1 Navigation Drop Down Menu 

When you right-click on an item in the navigation panel, a drop-down menu 

appears, including sub-menus, containing commands which are mostly from the 

Menu Bar, and are appropriate for the item. A typical drop-down menu is as 

follows: 
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 Corresponding Menu Bar commands, Section 2.4. 

The following commands are specific to the drop-down menu and do not exist in 

the Menu Bar: 

Rename Experiment 

This command is only available when a data folder or sub-item is selected 

from the navigation panel, and recreates the experiment that was used to 

generate the data. This is useful if you receive some data from a third party 

and wish to run the experiment. 

Explorer 

This command opens Windows Explorer at the location in the filing system 

that represents the currently selected item in the navigation panel. This might 

be useful, for example, it you want to copy part of the system configuration or 

data to another part of the filing system, for backup purposes. 
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2.3 FILENAMES AND EXTENSIONS 

The ModuLab XM project structure is based on the Windows filing system, with 

the project as a top level folder. Within this structure, files with certain extensions 

are recognised by ModuLab XM and interpreted to create the structure in the 

navigation panel. For example: 

• Files with the INFO extension contain general information about the project. 

• Files with the DATA extension contain data generated by experiments. 

If a file exists within the structure, that is not recognised by ModuLab XM, or has 

been created by ModuLab XM for use with other applications, it will appear in 

the navigation panel complete with the file extension. This will include CSV files 

containing exported data, and RTF files representing reports. When one of these 

files is selected in the left-hand navigation panel, a File Information dialogue box 

will appear as follows: 

 

 Section 5.14 for details of this dialogue box, and Section 5.13.2 for an 

example of how it might be used to open a report file in a word-processing 

application. 
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2.4 MENU BAR 

2.4.1 File Menu 

Add New 

Add a new item under the currently selected item in the navigation panel. A sub-

menu of available additions will appear, otherwise this menu item is greyed out. 

The available items, according to the current selections, are as follows: 

Selected Navigation 
Panel Tab 

Selected Item Items available for 
addition 

System Equipment Library chassis 
virtual chassis 

chassis instrument group 

virtual chassis virtual instrument group 

instrument group temperature controller 

virtual instrument group temperature controller 

Project project folder* 
experiment 
graph 
report** 

folder* folder* 
experiment 
graph 
report** 

experiment folder* 
graph 
report** 

Setup 
(appears automatically 
under experiment) 

step 
loop 
decision 

loop step 
loop 
decision 

decision option 

option step 
loop 
decision 

* A folder that has been added for general purpose use, not representing a project, 

experiment or report. 

** A report folder, not the report files that it may contain. 

 New Experiment, New Step and New Report in the Experiment menu, 

Section 2.4.4. These have the effect of adding items directly under the 

appropriate top level items (project, experiment or experiment Setup), 

regardless of the sub-item that has been selected. 

 Virtual Equipment, Section 4.2.5, for details of virtual chassis and virtual 

instrument group. 
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New Project 

Create a new project. A dialogue box appears in which you can specify a project 

name and various other features, and then the project appears in the navigation 

panel with the Project tab selected. 

If a project is already open, containing items that have changed, the Close Project 

dialogue box will appear, so that you can specify the items that need to be saved, 

then the new  project will appear. 

 Create New Project, Section 5.1.1. 

Open Project 

Open a project that has previously been created. A filing system browser window 

appears, with an appropriate folder selected (depending on previously opened 

projects), and you can expand the folder and select the project to be opened, then 

click OK. The project will appear in the navigation panel with the Project tab 

selected. 

If a project is already open, containing items that have changed, the Close Project 

dialogue box will appear, so that you can specify the items that need to be saved, 

then the new  project will appear. 

 Opening and Closing Projects, Section 5.1.2. 

Close Project 

Close the currently open project, so that it disappears from the navigation panel. 

The panel will become empty, including the features that normally appear under 

the System tab. 

If changes to the project have been made, the Close Project dialogue box will 

appear so that you can save the changes, then the project will close. 

 Opening and Closing Projects, Section 5.1.2. 
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Recent Projects 

Display a list of recently opened projects as follows: 

 

When a project is selected from the list, it will open in the navigation panel and 

any currently open project will be closed.  

If changes to the currently open project have been made, the Close Project 

dialogue box will appear so that you can save the changes, then the project will 

close. 

 Opening and Closing Projects, Section 5.1.2. 

If Clear List is selected, all projects will be removed from the list so that next 

time it appears it will display List Empty! 

ECS Projects 

Open a project using the ModuLab XM Electrochemical System. This feature is 

the same as Recent Projects except that the list of projects in the drop down menu 

will be suitable for ECS. When you select a project, the MTS version of the 

ModuLab XM software will close and the project will open in the ECS version, 

so that ModuLab XM ECS will appear in the title bar as follows: 

 

The ECS Projects item in the File menu will change to MTS Projects so that you 

can select an appropriate project and it will open in ModuLab XM MTS. 
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Add Shortcut 

Add a shortcut folder at the bottom of the tree in the navigation panel, for 

accessing files anywhere on the filing system. This is initially a blank shortcut 

which has no destination, and when selected it will display a blank File 

Information screen. You can then browse the filing system and select a 

destination folder, and the shortcut will be populated with the files. You can then 

click on the files and open them from the appropriate applications. 

 Shortcut Folder, Section 5.14.1. 

Remove Shortcut 

Remove the selected shortcut folder. 

Save 

Save the project so that it becomes updated with the currently selected 

experiment. 

Save All 

Save the whole project including all the experiments. 

Page Setup 

Set up the page size and orientation, etc., for printing. A standard Windows 

dialogue box appears as follows: 

 

Exit 

Close the ModuLab XM MTS software. 
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If changes to the currently open project have been made, the Close Project 

dialogue box will appear so that you can save the changes, then the ModuLab 

XM software will close. 

 Opening and Closing Projects, Section 5.1.2. 

2.4.2 Edit Menu 

Undo 

Undo the latest change to the project. Click repeatedly to work backwards and 

undo the latest history of changes. If no changes have been made since the project 

was opened, this menu item is greyed out. 

In some circumstances the Undo command may be appended by the latest action. 

For example, if you have just added an item to the navigation panel, it will say 

Undo Insert Node. 

Redo 

Redo the latest change after selecting Undo. If Undo has not been used, this menu 

item is greyed out. 

Cut 

Delete the currently selected item, including the structure of sub-items, from the 

navigation tree and store it in the clipboard. 

Copy 

Copy the currently selected item, including the structure of sub-items, to the 

clipboard without deleting it from its current location. 

Paste 

Paste an item, including a structure of sub-items, that has been previously copied 

to the clipboard using Cut or Copy. The item will be pasted under the currently 

selected item, but only if the operation maintains a valid structure of items and 

sub-items (for example you can’t paste an experiment under another experiment). 

The item can be pasted to another project, but you can’t have two projects open at 

once. You have to cut or copy the item from the current project, then close the 

project and open a new one, then paste the item. 

Delete 

Delete the currently selected item without copying it to the clipboard. The 

structure of sub-items will also be deleted. 

Rename 

Rename the currently selected item. A text cursor will appear on the item. 

You can also rename an item by selecting it, pausing for an interval that is too 

long for a double-click, then selecting it again. 
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2.4.3 View Menu 

Project 

Select the project, in the navigation panel. 

Equipment 

Select the Equipment library, in the navigation panel. 

Options 

Select the User Preferences, in the navigation panel. 

Tree Size Small 

Tree Size Medium 

Tree Size Large 

Tree Size Huge 

Specify the size of the icons in the navigation panel. 

2.4.4 Experiment Menu 

Show Status Grid 

Display the current status of the modules. A display panel appears which is 

updated with measurements when an experiment is running and provides access 

to Start/Stop and Pause/Continue, etc. This is a toggle feature so that it shows or 

hides the status grid. 

 Status Grid, Section 2.6. 

Stop All 

Stop all experiments from running. 

Run 

Display the Start Experiment screen associated with an experiment structure, 

when an item within the structure is selected. If the Start Experiment screen is 

already on display, the experiment will run, same as pressing the Run button 

within the screen. 

New Experiment 

Add a new experiment to the project, together with Setup and step items. The 

experiment will be added directly under the project, regardless of the item that 

has been selected in the project structure.  

 Add New from the File menu, Section 2.4.1, to add an experiment as a sub-

item within a folder.  

New Step 

Add a new step to an experiment. The step will be added directly under the 

experiment Setup, regardless of the item that has been selected in the experiment 

structure. 

 Add New from the File menu, Section 2.4.1, to add a step as a sub-item 

within a loop. 
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New Report 

Add a new report folder to an experiment, The report folder will be added 

directly under the experiment, regardless of the item that has been selected in the 

experiment structure. 

 Add New from the File menu, Section 2.4.1, to add a report folder as a sub-

item within a general-purpose folder, or directly under the project. 

2.4.5 Window Menu 

Reset Toolbar 

Reset the toolbar to its default configuration after changes have been applied. 

(The toolbar can be customised from the drop-down menu at the right). 

V=IR calc 

This is a simple calculator that works out values of the equation V=IR. There are 

two data entry fields with white backgrounds and a result field with a yellow 

background as follows: 

 

Type a number in any data entry field and the value in the result field will be re-

calculated. If you click the result field, it will turn white and another field will 

become the result field, according to the following sequence: 

Click V, when yellow, to make R the new result field. 

Click I, when yellow, to make V the new result field. 

Click R, when yellow, to make I the new result field. 
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2.4.6 Help Menu 

Contents 

Display the ModuLab XM MTS help system in a window with a navigation panel 

on the left and the help topics on the right. The navigation panel has four tabs: 

Contents Navigate a table of contents to display the help topics. This 

tab is selected by default when Contents is selected from 

the Help menu. 

Index Make a selection from an alphabetical list of index entries 

and display the associated topics. 

Search Search the Help system for any word or phrase and display 

the associated topics. 

Favorites Add the currently displayed topic to your list of favorites, 

for further reference. 

Index 

Display the ModuLab XM MTS help system in a window with a navigation panel 

on the left and the help topics on the right. The tabs are as described above, under 

Contents, but the Index tab is selected. 

FAQ 

Display a list of frequently asked questions, as a topic within the help system. 

PDF Manuals 

Display a set of folders containing the ModuLab XM ECS and MTS manuals in 

Adobe Acrobat PDF format. These files have been compiled as tagged PDF so 

that the cross-references and table of contents are hyperlinked to their 

destinations, and the section headings can be displayed in a side panel for easy 

navigation. The files can be displayed using the Adobe Reader, available as a free 

download from: 

www.adobe.com 

Check for updates 

Display the Downloads page from the Solartron website. Downloads are available 

for a number of Solartron products. 

Technical support 

Display the Technical Support page from the Solartron website. 

About 

Display the ModuLab XM MTS splash screen giving the current version number. 

Click the screen to close it. 
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2.5 TOOLBAR 

 

The toolbar emulates some of the commonly used commands available from the 

menu bar, as follows: 

Add New 

 
Add a new item under the currently selected item in the navigation 

panel. The drop-down menu at the right of the button gives a list of 

available additions. If there are no additions, the button and menu are 

greyed out. 

 This button is equivalent to Add New in the File Menu, Section 

2.4.1. 

The icon used for this button depends on what can be added. When you 

click the icon, the corresponding item is added, otherwise you can click 

the drop-down menu to add alternative items. The icons are as follows: 

 
The folder icon appears in circumstances where a folder can 

be added. 

 
The step selection icon appears when a step can be added to 

an experiment setup, loop or decision option. 

 
The option icon appears when an option can be added to a 

decision. 

 
The chassis icon appears when a chassis can be added to the 

equipment library. 

 
The instrument group icon appears when an instrument group 

can be added to a chassis. 

 

Open Project 

 
Opens a project that has previously been created. A filing system 

dialogue box appears with an appropriate folder selected (depending on 

previously opened projects) and you can expand the folder and select the 

project to be opened, then click OK. 

 This button is equivalent to Open Project in the File Menu, Section 

2.4.1. 

Save 

 
Save the project so that it becomes updated with the currently selected 

experiment.  

 This button is equivalent to Save in the File Menu, Section 2.4.1. 
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Save All 

 
Save the whole project including all the experiments.  

 This button is equivalent to Save All in the File Menu, Section 

2.4.1. 

Cut 

 
Delete the currently selected item from the navigation tree and store it in 

the clipboard.  

 This button is equivalent to Cut in the Edit Menu, Section 2.4.2. 

Copy 

 
Copy the currently selected item to the clipboard without deleting it from 

its current location.  

 This button is equivalent to Copy in the Edit Menu, Section 2.4.2. 

Paste 

 
Paste an item that has been previously been copied to the clipboard using 

Cut or Copy. The item will be pasted under the currently selected item, 

which may be in a different project. 

 This button is equivalent to Paste in the Edit Menu, Section 2.4.2. 

Undo 

 
Undo the latest change to the project. Click repeatedly to work 

backwards and undo the latest history of changes. If no changes have 

been made since the project was opened, this menu item is greyed out.  

 This button is equivalent to Undo in the Edit Menu, Section 2.4.2. 

Redo 

 
Redo the latest change after selecting Undo. If Undo has not been used, 

this button is greyed out.  

 This button is equivalent to Redo in the Edit Menu, Section 2.4.2. 

Show Status Grid 

 
Display the current status of the modules. A display panel appears which 

is updated with measurements when an experiment is running and 

provides access to Start/Stop and Pause/Continue, etc. This is a toggle 

button so that it shows or hides the status grid. 

 Status Grid, Section 2.6. 

 This button is equivalent to Show Status Grid in the Experiment 

Menu, Section 2.4.4. 
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Run 

 
Display the Start Experiment screen associated with an experiment 

structure, when an item within the structure is selected. If the Start 

Experiment screen is already on display, the experiment will run, same as 

pressing the Run button within the screen 

 This button is equivalent to Run in the Experiment menu, 

Section 2.4.4. 

Stop All 

 
Stop all experiments from running. 

 This button is equivalent to Stop All in the Experiment menu, 

Section 2.4.4. 

2.6 STATUS GRID 

 

If Show Status Grid is selected from the Experiment menu, a panel appears at 

the bottom of the right-hand window, showing the status of the modules as 

follows: 

 

There is one row of status information for each instrument group that has been 

installed in the system, and has been tested using the Test button in the 

Instrument Group Setup. 

 Instrument Group Setup, Section 4.2.3. 

This example shows the status of a single group while an experiment is running. 

If you double-click on a row in the status grid, while an experiment is running, 

the appropriate graph will appear, and will display each new point as the 

measurements are taken. 

The columns in the tabulated list are: 

Instrument 

The instrument group which is used to take measurements. 

Chassis 

The chassis and slot to which the materials core module is fitted. 

Step 

The name of the step that is currently being run, if an experiment is running on 

this module, otherwise the status is Idle. If an experiment pauses or stops because 

it has reached an experiment limit or produced an error, this column will give 

status details. 

 Paused Experiments, Section 2.6.1. 
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Time 

The top row displays the elapsed time for the step, and the bottom row displays 

the time remaining. 

Measurements 

The top row displays the DC measurements for the step, including voltage, 

current and charge. The bottom row displays the AC measurements, if applicable, 

including frequency, impedance magnitude and phase. 

The measurements appear with background colours that change according to the 

following circumstances: 

• A yellow background means the measurement is within the voltage or current 

range specified in the Instrument Experiment Setup, or if the range is set to 

Auto, the measurement is within the range selected by the system. 

 Instrument Experiment Setup, Section 5.3.4. 

• A blue background means the measurement is “under-range”. It is below the 

voltage or current range specified in the Instrument Experiment Setup, or if 

the range is set to Auto, it is below the range selected by the system. 

• An orange background means the measurement is “over-range”. It is above 

the voltage or current range specified in the Instrument Experiment Setup, or 

if the range is set to Auto, it is above the range selected by the system. 

NOTE: In all the above circumstances, if auto-ranging is used, the 

measurements are likely to be temporarily under-range or over-

range while the system is searching for the correct range to use. 

For impedance steps, the DC current may always be under-range 

because the AC current is normally larger than the DC current 

and the under-range detection is based on the DC measurements. 

• A red background indicates that an experiment limit has been reached. When 

this happens, the experiment will pause, but can be made to continue under 

appropriate circumstances using the control buttons at the right of the status 

grid. Experiment limits can be imposed from both the ModuLab XM 

hardware and software. 

 Experiment Limits, Section 5.3.5. 

 Paused Experiments, Section 2.6.1. 

Control 

The following control buttons are available: 

 Stop the experiment. This button appears only when an experiment is 

running (including open circuit measurements). 

 Open Circuit Measurements, Section 2.6.1. 

 Pause the experiment. This button appears only when an experiment 

is running (excluding open circuit measurements). 
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 Resume an experiment that has been paused, so that it continues 

taking measurements from the point within the step where it was 

paused. This button only appears when the experiment has been 

paused, either by the user by pressing the Pause button, or by the 

system because a problem has occurred with the experiment. 

 Skip the current step and move on to the next step. This button 

appears only when an experiment is running (excluding open circuit 

measurements). 

 Start measuring the open circuit voltage. This button only appears 

when the experiment has been stopped after taking some 

measurements, otherwise the system will not know which 

configuration of modules to use. 

2.6.1 Paused Experiments 

An experiment will pause if the Pause button in the Status Grid is pressed by the 

user, or if something happens during the experiment that causes a measured value 

to reach a specified limit. 

Experiment limits can be imposed in two ways: 

• From the ModuLab XM software, by specifying limiting values of voltage, 

current and charge in the Experiment Limits sub-screen. 

 Experiment Limits, Section 5.3.5. 

• From the ModuLab XM hardware. The Materials Core Module is fitted with 

short circuit protection so that a switch opens when the current reaches an 

unsafe level. If this happens, the Error (red) LED on the module front panel 

will come on, but it is unlikely to happen because of various built-in 

safeguards. 

 Installation Guide. 

An experiment is much more likely to pause because of the Experiment Limits in 

the software, and it might happen in the following circumstances: 

• An experiment limit specified in the software has been exceeded. This can be 

resolved by changing the limits, or setting up the steps so that the 

measurements remain within the required limits. 

• Something has gone wrong with the sample or the connecting cables, so that 

a short circuit has caused a measurement to reach an experiment limit. 

If a limit is reached, for whatever reason, the appropriate values in the status grid 

will be highlighted with a red background and the reason for pausing the 

experiment will be given in the Step column. 

Here is an example of a status grid where the experiment has paused during a 

linear sweep because the measured current has reached a limiting value of 5µA: 
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 If the Stop button in the Status Grid is pressed, while the experiment is 

paused, the experiment will stop and the status grid will be as follows: 

 

 Alternatively, if the Skip button in the Status Grid is pressed, while the 

experiment is paused, it will continue with the next step, if there is one, 

and will complete successfully if the experiment limit is not reached. 

2.6.2 Open Circuit Measurements 

In some circumstances, an open circuit measurement might have to be taken at 

the beginning of an experiment, for example a solar panel might have become 

charged, or a capacitor may have retained some charge from a previous 

experiment or other electrical process. 

When an experiment is set up and ready to run, and the OC Measure button is 

pressed in the Start Experiment screen, the Status Grid appears as follows: 

 

 Start Experiment, Section 5.2.2. 

The Step column displays Measuring OCV and the results in the Measurements 

column will be updated as the measurements are taken. When the red control 

button is clicked, the measurements will stop and the status will change to Idle, as 

follows: 

 

The red control button has disappeared and has been replaced by an OC button, 

for re-starting the Open Circuit measurements. This is the same as the OC 

Measure button in the Start Experiment screen. 

2.6.3 Module Information 

If you click the Module Information button at the bottom of the Status Grid, a 

sub-panel opens to give information about the currently selected instrument 

group as follows: 

 

This panel gives the status of the selected instrument group, under the heading 

Instrument Information, as follows: 

• The instrument group, for example Group 1. 



ModuLab XM MTS Materials Test System: User Guide ModuLab XM MTS Control Features 

21006013_AE  2-27 

• The current activity being performed by the group, for example Measuring. 

This corresponds to the Status field in the Equipment Summary and Start 

Experiment screens. 

 Equipment Summary, Section 4.2.1. 

 Start Experiment, Section 5.2.2. 

• The experiment name, for example MAT Test. 

• The step that is currently running, same as the Step column in the status grid. 

The following additional features are available: 

Cyclic Control 

 
This button reverses the direction of cyclic steps, for the selected 

instrument group. 

Display Graph 

 

This button displays a graph of the data being generated by the currently 

selected instrument group. 

2.7 ERROR AND WARNING ICONS 

In some of the screens in the ModuLab XM system, error and warning icons will 

appear if an inappropriate entry is made in a field. The icons will flash for a few 

seconds when they first appear, then they will become steady. 

There are two types of warning: 

 A red error icon appears if a selection is made that will cause the system 

to function incorrectly. An experiment will not run if there is an error. 

For example, in the Hardware Requirements sub-screen, if you select an 

Experiment type and Instrument configuration that requires some optional 

modules, and then you select an Instrument Group to use that does not 

have the modules fitted, a red error icon will appear alongside the module 

fields. 

 An amber warning icon will appear if a selection is made that allows the 

system to function, but possibly not at its optimum performance. A 

warning will not prevent an experiment from running. 

For example, if you select an entry for grounding that might be 

inappropriate, an amber warning icon will appear. 
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A screen showing red and amber icons is as follows: 

 

 Hardware Requirements, Section 5.3.2. 

2.8 CLOSING MODULAB XM 

The ModuLab XM application can be closed using either of the following 

methods: 

• Using Exit, from the File menu. 

• Using the control button at the top right corner of the main 

application window.  

In either case, the project will be closed and the Close Project dialogue box will 

appear asking you to save changes to the project. 

 Opening and Closing Projects, Section 5.1.2. 

 



ModuLab XM MTS Materials Test System: User Guide 

21006013_AE  3-1 

3. Setting Up and 
Running  Experiments  

3.1 OVERVIEW 

This chapter describes how to set up and run experiments with the ModuLab XM 

MTS system connected to a number of different types of sample according to a 

set of pre-defined hardware and connection configurations that are specified in 

the ModuLab XM MTS software. 

Before you can perform any of these experiments, it will be necessary to install 

the system and complete the installation tests, as described in the Getting Started 

Guide and Installation Guide, and the experiments that you are able to perform 

will depend on the modules that are installed. 

A number of ready-made experiments are available with the ModuLab XM 

software, for use with the ModuLab Test Unit (or the ModuLab 0.1 Ω Unit for 

high power applications), and these are described in the Installation Guide. 

However, because of the wide variety of material samples, it is impractical to 

provide examples for use with real experiments. Instead we will see how to create 

your own experiment, starting with a new project. 

3.2 AN EXAMPLE EXPERIMENT 

In this example, an experiment is performed on a real material sample, not a test 

unit. The sample is subjected to a DC Linear Sweep, using a materials core 

module without any optional modules (although you can specify additional 

modules and use the appropriate configuration as required). The results are 

displayed as graphs and tables. The experiment is then repeated, using a core 

module and a frequency response analyzer, with the same DC Linear Sweep 

followed by a Constant Level Impedance step, and the results are again displayed 

as graphs and tables. 

In the following sub-sections we will see how to do the following: 

 Create a New Project including an Experiment (Section 3.2.1) 

 Set up the Experiment (Section 3.2.2) 

 Set up the Step (Section 3.2.3) 

 Connect the Hardware and Run the Experiment (Section 3.2.4) 

 Display Graphs and Tables (Section 3.2.5) 

 Add an AC Step and repeat the Experiment (Section 3.2.6) 
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3.2.1 Create a New Project including an Experiment 

When a new project is created, it contains a single experiment and step by default, 

although you can add new items as appropriate. To create a new project with an 

experiment and step, proceed as follows: 

1. Run the ModuLab XM MTS software and select New Project from the File 

menu. A dialogue box will appear as follows: 

 

2. In the Name field, type a project name, for example My Project. 

3. If required, type a description of your project in the Comment field, for 

example some details of the experiments to be performed. 

4. Click the More button to display the expanded dialogue box as follows: 

 

5. Make sure the Create experiment too box is checked, then click 

Create Project. A structure of items will appear in the navigation panel, 

depending on the tab that has been selected at the bottom of the panel: 

• If the System tab is selected, the User Preferences and Equipment library 

will appear, although they do not belong to the project. The User 

Preferences are specific to the user of Windows, and the Equipment 

library is defined during the system installation. 

• If the Project tab is selected, the project name and structure of items 

appears. 
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6. Click on the System tab, then click on User Preferences to display the 

Preferences as follows: 
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7. In the Graph Preferences sub-screen, click on the row for Voltage Waveforms 

(DC), to expand it and display the default graph types as follows: 

 

8. Check that the default graph types for Linear Sweep I-V Characterisation are 

I vs. V for Graph 1 and None for Graph 2. If required, click on the appropriate 

cells to display the list boxes of graph types, and specify the correct options. 

9. Click on the Project tab, at the bottom of the navigation panel, to display the 

project name as follows: 

 

10. Make sure the project structure is fully expanded. If collapsed, click on the 

(+) symbol on the project name, and on the sub-items, to expand the project 

structure. 
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11. Click on the experiment to display the Start Experiment screen as follows: 

 

This screen has the following features: 

• There is a tabulated list of Experiment Hardware Requirements, which 

specifies by default that a materials core module is required. 

• There is a tabulated list of Instrument Groups Available, together with 

their hardware specifications under Instrument Group Capability. The 

available hardware, including all the optional modules, was detected by 

the ModuLab XM software, or defined by the user, during the system 

installation. Each instrument group occupies one row in the table, and the 

check boxes in the Use column specify which groups are to be used for 

the experiment. Multiple boxes can be checked to run the experiment on 

multiple samples, but only one will be used in this example. An 

instrument group can only be used for an experiment if it meets or 

exceeds the Experiment Hardware Requirements, otherwise the row in 

the tabulated list will turn red. 

 For example, the row representing Group 2 turns red when the 

experiment includes an impedance step, because it does not have an 

FRA, as shown in Section 3.2.6, step 7. 
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• There is a connection diagram showing how the core module and optional 

modules should be connected to the sample. This diagram could be any 

one of a number of standard configurations available from the Hardware 

Requirements in the experiment setup screen. 

 Set up the Experiment, Section 3.2.2. 

• There is an OC Measure button which displays open circuit 

measurements on the sample, in case you want to see how the sample is 

performing without an excitation signal, before you run the experiment. 

• There is a Run button which runs the experiment and collects data, and 

stores it in the data file that is named in the field above the button. The 

Run button should only be used when the experiment has been fully 

defined and is expected to obtain some meaningful results. 

3.2.2 Set up the Experiment 

When you have added the new project and experiment, as described in the 

previous section, you can set up the experiment as follows: 

1. Click on Setup, in the navigation panel, to display the experiment setup as 

follows: 

 

This screen has a connection diagram in the top right corner and a description 

underneath. The central column contains a number of sub-screens which you 

can use to configure the experiment. 
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2. If required, you can click on the connection diagram to display an enlarged 

view as follows, then click the Close button to return to the experiment setup 

screen. 

 

3. Make sure the Hardware Requirements sub-screen is expanded, using the 

arrow button  if necessary, and click the Advanced check box so that the 

sub-screen appears as follows:  

 

This screen contains a set of list boxes so you can configure the experiment to 

use the appropriate hardware. 

 Hardware Requirements, Section 5.3.2. 
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NOTE: If there is only one instrument group, the Instrument 

configuration list box will not display the slot numbers and 

chassis number, so the field will be reduced to: 

Group 1 

4. Select the appropriate entries from the Experiment type and Instrument 

configuration list boxes, and the corresponding connection diagram and 

description will appear. 

5. The Instrument Group to use field defaults to the first group that meets the 

requirements of the experiment, in the tabulated list in the Start Experiment 

screen. Select the appropriate group, if this is not the one you want to use. 

 Start Experiment, Section 3.2.1, Step 11. 

The remaining fields, representing the core module and optional modules will 

be greyed out, because they represent the installed hardware in the group. 

They become available if the Custom option is selected for the Instrument 

Group to use. This option enables projects to be transported between different 

ModuLab XM systems regardless of the installed hardware, but an experiment 

cannot be run until a specific instrument group has been selected. 

The Instrument Group to use field defaults to Custom if no group is available 

that is capable of performing the experiment. 

 If you select an Experiment type and Instrument configuration that 

requires some optional modules, and then select an Instrument Group 

to use that does not have the modules fitted, a red error icon will 

appear alongside the module fields. The experiment will not run until 

the error is corrected. 

6. Select an entry from the Grounding list box. The options are: 

Internal The ModuLab XM system is internally grounded (LO 

connected to ground). This option should only be used if the 

sample is not grounded. 

External The ModuLab XM system is externally grounded through the 

sample (LO floating). This option should only be used if the 

sample is grounded. 

NOTE: The LO point is a common reference voltage for modules within a 

group. For details see the Installation Guide. 

 An amber warning icon will appear if the selected grounding is 

inappropriate for the experiment. 

7. After setting up the Hardware Requirements, expand the additional sub-

screens using the arrow button  and fill in the fields if necessary to specify 

the detailed configuration of the experiment. The additional sub-screens are: 

 Sample Setup, Section 5.3.3. 

 Instrument Experiment Setup, Section 5.3.4. 

 Experiment Limits, Section 5.3.5. 
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3.2.3 Set up the Step 

After setting up the experiment, which includes a single undefined step by 

default, you will need to set up the step to apply a stimulus to the sample and take 

the required measurements. A number of step types are available, including linear 

sweep, triangular sweep, etc., but for the purpose of this example we will 

configure the step to perform a linear DC voltage sweep. 

 Step Types, Section 5.8. 

1. Click on the step, in the left-hand navigation panel, and a list of step 

categories will appear as follows:  

 

2. Expand the Voltage Waveforms (DC) sub-screen to display the list of step 

types in this category as follows: 
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3. Click on Linear Sweep I-V Characterisation to display a set of configuration 

screens for this step type as follows: 

 

The item called Step, in the navigation panel, has changed to Linear Sweep. 

The sub-screens in the central column are for configuration of the step, and 

the two graphs on the right are for illustration and setup purposes as follows: 

• The upper graph is a general representation of the waveform and explains 

the meaning of the parameters in the setup. 

• The lower graph shows the waveform that will actually be applied to the 

sample, and will change when the values of the parameters are modified. 

4. In the Scan Setup screen, make sure the Start level is at its default value of 0V 

and set the End level to 6V and the Scan rate to 200mV/s, and, so the screen 

is as follows: 

 

This will give a duration of half a minute for the scan, and the time axis on the 

lower graph will be updated next time you click on a field (or on the graph 

itself). 
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5. Expand the Time Domain Measurement Setup sub-screen so it appears below 

the Scan Setup sub-screen. Make sure the Measurement mode is set to 

V change (to follow the voltage scan), and set the Integration period to 1 

second per sample and the Amount of change to 200mV, so the screen is as 

follows: 

 

In this example, the Scan rate is 200 mV/s and the Amount of change 

specifies that a measurement occurs after every 200mV of signal change, so 

there is 1 measurement per second. Data collected by the system is integrated 

to filter out noise, and the amount of filtering is defined by the Integration 

period, so that a short period follows the waveform more precisely but a long 

period filters out more noise. 

The Integration period should not exceed the interval between measurements, 

and if it does, the system will use the interval between measurements as a 

maximum value. In this case, the Integration period has been set to 1 second 

to match the interval between measurements. 

6. If necessary, expand the remaining sub-screens and edit the fields as 

described in the various sub-sections under the Step Setup. However, for the 

purpose of this experiment, it will be sufficient to leave these sub-screens at 

their default values. 

 Step Setup, Section 5.7. 

3.2.4 Connect the Hardware and Run the Experiment 

You can connect the ModuLab XM MTS system to the sample at any stage while 

setting up the experiment from the software, as soon as you have displayed the 

appropriate connection diagram (by selecting the Experiment type and Instrument 

configuration in the Hardware Requirements sub-screen). 

 Set up the Experiment, Section 3.2.2, and Hardware Requirements, 

Section 5.3.2. 

The connection diagram is displayed on the Start Experiment screen, so you can 

check the connections and then run the experiment as follows: 

1. Click on the experiment to display the Start Experiment screen: 
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2. Make sure the Use box has become checked, for the instrument group to be 

used in this experiment, and all other boxes are cleared. Any group could be 

used, provided that it meets the Experiment Hardware Requirements 

(indicated by a green row in the tabulated list of groups). However, the 

default group is the one that was selected in the Instrument Group to use field, 

in the Hardware Requirements sub-screen, and this is the one we will use in 

this experiment. 

 Hardware Requirements sub-screen, Section 3.2.2, Step 3. 

3. Connect the ModuLab XM system to the sample using the appropriate cables. 

WARNING: In some circumstances it may be useful to connect the 

ModuLab XM Test Unit first (or the ModuLab XM 0.1 Ω 

Unit for high power applications) and do a dummy run of 

the experiment, before connecting the system to a real 

material sample. However, the primary purpose of the Test 

Unit is to test the modules under conditions of safety, and it 

does not represent the characteristics of material samples, 

which may vary greatly from each other. Do not rely on the 

Test Unit as an alternative to carefully checking the 

characteristics of your system. 
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4. If you like, you can type a name in the Data file field, but for the purpose of 

this example we will leave it at its default, which is the same as the 

experiment name. 

 

5. If you like, you can perform an open circuit measurement, to see how the 

sample will perform without applying an excitation signal from the generator, 

otherwise go to Step 7. To perform an open circuit measurement, click the 

OC Measure button to display the Status Grid as follows: 

 

An Open Circuit step appears in the Status Grid and the results in the 

Measurements column will be updated as the measurements are taken. 

6. Click the red control button at the right of the Status Grid to stop the Open 

Circuit experiment. The status will change to Idle and the measurements will 

stop animating. The Status Grid will be as follows: 

 

The red control button has disappeared and an OC button has appeared. This 

is the same as the OC Measure button in the Start Experiment screen, and re-

starts the Open Circuit measurements. 

7. Click the Run button to run the experiment, and a Data File item will appear 

in the navigation panel, under the experiment, and will automatically be 

expanded to show the sub-items. 
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8. While the experiment is running, click the Data File item to display a graph, 

which is updated as each new measurement is taken. This graph gives an 

overview of the data for the experiment, in terms of voltage against time, as 

follows: 

 

9. While the experiment is still running, click the item for the instrument group. 

This will display the data for the step that is currently running on this core 

module, in terms of current density against voltage, as follows: 
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10. While the experiment is still running, click on the step (in this case Linear 

Sweep) so that it shows the data for the step as follows: 

 

The data will continue to be updated while the experiment is running, until it 

is complete. 

11. Click again on the three items in the navigation panel to display the 

completed results as follows: 
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Now that we have observed these three displays of results, both during and after 

the experiment, they can be summarised as follows: 

• The Experiment 1 screen gives a graph of voltage against time for the 

experiment as a whole. 

• The Group 1 screen gives the results that are currently being collected by this 

core module, while the experiment is running. The results correspond to the 

current step, and are displayed in terms of current density against voltage 

because these are the axes used by the step. When the experiment has been 

completed, the graph changes to voltage against time, because it represents 

the core module more generally, without any specific reference to a step, and 
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since there is only one core module, the graph is the same as in the Data File 

screen. 

• The Linear Sweep screen gives the data for the step, and the graph axes 

represent current density against voltage (I vs. V) which is the default for this 

step type, specified in the Graph Preferences. 

 Step 7, Section 3.2.1. 

NOTE: The Group 1 item is only temporary in systems that have only one 

core module, and it exists for the purpose of displaying the results of 

a sequence of steps while the experiment is in progress. If you close 

the project after the experiment is complete, and re-open it again, the 

Group 1 item will not be present and the Linear Sweep step will 

appear immediately under the Data File. However, the instrument 

group items remain permanently in the structure in systems that have 

more than one core module. 

3.2.5 Display Graphs and Tables 

In this example so far, we have displayed a single graph on each screen of results. 

However, you can change the axes to display different data, or you can display a 

second graph, or a tabulated list of data. Here is an example of how to change the 

display by editing the Axes sub-screen: 

1. Make sure the step (in this case Linear Sweep) is selected in the data file 

structure in the navigation panel, to display the results for the step. 

2. In the Axes sub-screen, select Charge Density in the Y1 list box. 

3. In the Graph 2 list box, select V vs. Time. The sub-screen will expand to 

show the axis fields for the second graph, but you can leave them at their 

default values. 

4. In the Table list box, select Bottom. The sub-screen will be as follows:  

 

 Axes, Section 5.10.2. 

5. Click the Refresh button, if required, to re-display the data. This will only be 

needed if an amber warning icon appears alongside the button. The display is 
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automatically refreshed when the Table field is changed, and the screen will 

be as follows: 

 

This display contains two graphs and a tabulated list of results with columns that 

include the data displayed in the graphs. There are various ways of processing the 

results of experiments, including manipulation of graphs, import and export of 

data between experiments, and exchange of data between users of different 

systems 

 Data, Section 5.10, and Graphs, Section 5.11. 
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3.2.6 Add an AC Step and repeat the Experiment 

Now that we have run the experiment with a DC step (by configuring the step that 

was included in the experiment by default), we will add a new AC step to perform 

impedance measurements. To run an experiment with AC steps, a frequency 

response analyzer has to be installed for use with the core module. 

A variety of AC step types are available, but for the purposes of this example, we 

will use  Constant Level Impedance. In this step type, a constant DC voltage is 

applied to the sample, while a frequency sweep is superimposed on it. 

 Step Types, Section 5.8. 

To add the AC step and repeat the experiment, proceed as follows: 

1. Right-click on the Setup item, under the Experiment, to display the drop-

down list box and hold the cursor over Add New, then select Step as follows: 

 

NOTE: You could use New Step instead of Add New and then Step, and 

it would make no difference in this case, although the two 

commands are functionally different. 

 Add New, Section 2.4.1 and New Step, Section 2.4.4. 
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A list of step categories will appear as follows: 

 

2. Expand the Voltage Controlled Impedance sub-screen to display the list of 

step types in this category as follows: 
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3. Select Constant Level. The item called Step, in the navigation panel, will 

change to Constant Level Impedance, and the display will be as follows: 

 

The sub-screens in the central column of this display are the same as for the 

DC step, except for the following: 

• The Scan Setup sub-screen has a single field to specify a Level for the 

constant DC voltage to be applied to the sample. 

• There is an additional sub-screen for Impedance Setup, to specify what 

sort of alternating signal is to be superimposed on the DC voltage. 

• The Time Domain Measurement Setup sub-screen is limited to periodic 

measurements, because there is no voltage change on which to base the 

measurement rate. 

4. Specify an appropriate Level in the Scan Setup sub-screen. If you like, you 

can leave it at its default value of zero, as follows: 

 

 Scan Setup for Constant Level Impedance, Section 5.8.4.6. 
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5. Fill in the Impedance Setup with appropriate values. If you like, you can leave 

it at its default values as follows: 

 

 Impedance Setup, Section 5.7.1. 

6. Expand the Time Domain Measurement Setup sub-screen and fill it in with 

appropriate values. If you like, you can leave it at its default values as 

follows: 

 

 Time Domain Measurement Setup, Section 5.7.2. 

7. Continue with the instructions for the DC experiment and you will find that in 

the tabulated list of hardware, in the Start Experiment screen, the FRA will 

appear in the list of Experiment Hardware Requirements as follows: 

 

NOTE: In the Instrument Group Capability, the row representing Group 2 has 

turned red, indicating that it is unsuitable for use with this experiment. 

The column representing the FRA has turned a darker shade of red, 

indicating that this is the reason why the group cannot be used. It 

does not have an FRA, so it cannot carry out the impedance step. 

When you run the experiment, the steps will run successively, first the Linear 

Sweep, then the Constant Level Impedance. When the data item appears for 
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Constant Level Impedance, you will be able to click on it and watch the graphs 

being drawn. These will depend on the User Preferences, but there will normally 

be a single Bode plot of impedance magnitude and phase angle against frequency 

as follows: 

 

You will be able to display other AC plots by editing the Axes sub-screen. 

 Display Graphs and Tables, Section 3.2.5, and Axes, Section 5.10.2. 

3.3 HARDWARE AND CONNECTION CONFIGURATIONS 

The hardware and connection configurations used by the ModuLab XM MTS 

system fall into the following categories: 

 Normal (Section 3.3.2) 

 Sample and Reference (Section 3.3.3). 

 Installation Test (Getting Started Guide and Installation Guide) 

Each of the sub-sections, under these main headings, describes one of the pre-

defined hardware and connection configurations (except for the Installation Test). 

The configuration for General Materials Testing is described first as an example, 

giving a brief outline of how to set up and run an experiment. 

 Example: General Materials Testing, Section 3.3.1. 

The remaining experiments are the same, except for the following: 

• In the ModuLab XM MTS software, you have to select the required 

experiment type and instrument configuration, to display the appropriate 

connection diagram. 

• You have to connect the modules to the test sample according to the 

displayed diagram. 

Steps may be added to experiments as follows: 
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• For time domain analysis, use any step type under Voltage Waveforms (DC). 

 Section 5.8.2. 

• For impedance analysis, use any step type under Voltage Controlled 

Impedance, at the required DC voltage level. Impedance tests require an FRA 

module to be fitted. 

 Section 5.8.3. 

The ModuLab XM system may be grounded internally or externally, depending 

on the grounding of the sample. 

• If the sample is not grounded, the ModuLab XM system must be grounded 

internally (LO grounded) . 

• If the sample is grounded, the ModuLab XM system must be grounded 

externally (LO floating). 

 The LO point is a common reference voltage for modules within an 

instrument group. For details see the Installation Guide. 
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3.3.1 Example: General Materials Testing 

This configuration is used for general purpose tests on a wide range of materials 

The materials core module is used to control the DC conditions on the sample and 

a frequency response analyzer may be added if impedance measurements are 

required. This configuration is suited to testing samples that do not require 

extremely high or low voltage / current measurements. Samples can be tested 

over a ±8V range with current levels up to ±100mA, which is sufficient for many 

types of materials. 

To set up an experiment with this configuration: 

1. Run the ModuLab XM software and set up an experiment. 

 Set up the Experiment, Section 3.2.2. 

In the Hardware Requirements sub-screen, make the following selections 

from the list boxes: 

Experiment Type: Normal 

Instrument configuration: Mat only 

A connection diagram will appear as shown in Figure 3-1. 

 

Figure 3-1 General materials testing 

2. Review the values in the experiment setup, and change them if necessary, so 

that they are compatible with the characteristics of the material. 

 Experiment Setup, Section 5.3.  

3. Add some steps and loops, or change the existing steps and loops, making 

sure that the values in the dialogue boxes are compatible with the 

characteristics of the material. 

 Step, Section 5.6, and Loop, Section 5.4. 
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WARNING: Always check the characteristics of the material, and set up 

the ModuLab XM system accordingly, to ensure safe 

operation of the experiment. You can do a dummy run first, 

using the Dielectric Reference Module, but in most 

circumstances this will not predict the response of real 

material samples which may have entirely different 

characteristics. 

4. Connect the core module to the sample using the appropriate cables, as shown 

in Figure 3-1. 

5. Run the experiment and review the results. 

 Section 3.2.4.  

NOTE: These instructions apply specifically to this experiment. If you are 

running one of the other experiments, make the appropriate selections 

from the ModuLab XM software and use the corresponding 

connection diagram. 

3.3.2 Normal Experiment Type 

The experiment configurations in the Normal category are used for a wide range 

of applications, including: 

• High voltage experiments, for example when testing dielectrics, insulators, 

ceramics and display panel materials, 

• High impedance experiments, for example nanotechnology and insulator 

tests. 

• High power experiments involving, for example, high conductivity materials 

and superconductors. 

The configurations are: 

 General Materials Testing, Section 3.3.2.1 (example, Section 3.3.1) 

 High Voltage, Section 3.3.2.2 

 High Impedance, Section 3.3.2.3 

 High Voltage / High Impedance, Section  3.3.2.4 

 Low Voltage with Booster, Section 3.3.2.5 

 High Voltage with Booster, Section 3.3.2.6 

3.3.2.1 General Materials Testing 

This configuration is used for general purpose tests on a wide range of materials.  

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Normal 

Instrument configuration: Mat only 

 Details of this configuration are given in the example, Section 3.3.1. 
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3.3.2.2 High Voltage Materials Testing 

This configuration is used for testing materials that require high stimulus voltage 

and/or measurement of high voltage signals. The MHV 100 module is used, 

producing a voltage up to 100V. 

WARNING:  Take care to use this module so that the voltage output does not 

constitute a safety hazard. See the General Safety Precautions at 

the beginning of this manual. 

Typical examples where the high voltage module may be required are testing 

dielectrics, insulators, ceramics and display panel materials. 

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Normal 

Instrument configuration: Mat + HV 

A connection diagram will appear as shown in Figure 3-2. 

 

Figure 3-2 High voltage system 

For some applications, higher current levels may be required and this can be 

accomplished by adding a booster to this configuration.  

 High Voltage with Booster, Section 3.3.2.6 

3.3.2.3 High Impedance Materials Testing 

This configuration combines the materials core module with a highly sensitive 

current to voltage converter (femto ammeter) module. This includes all of the 

ranges of the standard core module, so it can measure up to ±100mA, but 

provides additional ranges at the low current end for measuring femto amps 

(10-15 amps) or less. 

The femto ammeter may be required, for example, in nanotechnology or the 

measurement of very high resistance samples such as insulators. 
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The characteristics of this configuration is mid-range voltage / current stimulus 

but with current measurement into the femto-amp range. 

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Normal 

Instrument configuration: MAT + Femto Ammeter 

A connection diagram will appear as shown in Figure 3-3. 

 

Figure 3-3 High impedance system 

3.3.2.4 High Voltage / High Impedance Materials Testing 

This provides a combination of high voltage, using the MHV 100 module, 

together with femto amp current resolution using the femto ammeter module. 

This is very useful for tests where the sample has very high resistance. 

This configuration may be required, for example, in nanotechnology or the 

measurement of very high resistance samples such as insulators. 

A high voltage is required to drive the sample, but the resulting current, due to the 

high resistance of the sample, is very low. 

WARNING: The current return to the femto ammeter can have a voltage of up 

to 100V if the sample is excited by a high voltage module. Take 

care to use these modules so that they do not constitute an 

electrical safety hazard. See the General Safety Precautions at the 

beginning of this manual. 

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Normal 

Instrument configuration: Mat + HV + Femto Ammeter 
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A connection diagram will appear as shown in Figure 3-4. 

 

Figure 3-4 High voltage / high impedance system 

3.3.2.5 Low Voltage with Booster 

In this configuration, the materials core module and booster are configured to test 

material samples at high power and low voltage (±2A, ±8V). The core module is 

connected to the booster, and the booster is connected to the sample. 

The booster may be required, for example, for testing high conductivity materials 

and superconductors. 

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Normal 

Instrument configuration: Mat + 2A 

A connection diagram will appear as shown in Figure 3-5. 

 

Figure 3-5 Low voltage system with booster 
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NOTE: The booster requires 4 Terminal connections to be specified in the 

Instrument Experiment Setup, because voltage measurements from 

Vhi and VLo are required for low impedance samples. An error 

message will appear in the Start Experiment screen if 2 Terminal 

connections are specified. 

 Section 5.3.4, Instrument Experiment Setup. 

 Section 5.2.2, Start Experiment. 

3.3.2.6 High Voltage with Booster 

In this configuration, the materials core module, high voltage module and booster 

are configured to test the sample at high power and high voltage (±2A, ±20V). 

The core module is connected to the booster and the booster is connected to the 

sample. The voltage measurement electrodes are connected to the high voltage 

module (not the core module) because high voltages are present in the sample. 

This configuration may be required, for example, for testing high conductivity 

materials and superconductors. 

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Normal 

Instrument configuration: Mat + HV + 2A 

A connection diagram will appear as shown in Figure 3-6. 

 

Figure 3-6 High voltage system with booster 

NOTE: The booster requires 4 Terminal connections to be specified in the 

Instrument Experiment Setup. 

 Section 5.3.4, Instrument Experiment Setup. 



ModuLab XM MTS Materials Test System: User Guide Setting Up and Running Experiments 

21006013_AE  3-31 

3.3.3 Sample and Reference 

The sample and reference module (MREF) reduces cable capacitance effects that 

may occur during impedance steps, by comparing the capacitance of the sample 

with known reference capacitors. This optional module can be used in 

combination with other modules in the instrument group, so that the circuit 

connections to the sample are modified as follows: 

• The cables that would otherwise connect to the Hi and Lo electrodes on the 

sample are instead connected to the Gen and I connectors on the Sample and 

Reference module. 

• The Hi and Lo Smp connectors on the Sample and Reference module are 

connected to the Hi and Lo electrodes on the sample. 

The compensating capacitance is introduced internally or externally as follows: 

• For internal referencing, the Hi and Lo Reference sockets on the Sample and 

Reference module are connected to their corresponding Hi and Lo Internal 

Reference sockets, using appropriate cables. 

• For external referencing, the Hi and Lo Reference sockets are connected to 

the Hi and Lo electrodes of a known external capacitor, using appropriate 

cables. 

In both cases, the cables used for referencing must be identical to the cables 

connecting to the sample, and of the same length. 

The choice between internal and external referencing has to be specified in the 

ModuLab XM software, in the Sample Setup sub-screen, and the appropriate 

connections diagram will appear. 

 Section 5.3.3, Sample Setup. 

The specification of the Sample and Reference module for use in an experiment 

does not necessarily mean that it has to be used in all the impedance steps. The 

Measurement Mode in the Impedance Setup for each step can be set as follows: 

Sample only Measurements are taken from the sample without 

using the Sample and Reference module. 

Sample & Reference The Sample and Reference module is used 

according to the experiment Setup. 

 Section 5.7.1, Impedance Setup. 

The following additional considerations apply to the Sample and Reference 

module: 

• Internal grounding should always be used because the internal reference 

capacitors cannot be externally grounded. A user reference capacitor could be 

externally grounded, but it would discharge and give no meaningful results. 

If the Experiment type in the Hardware Requirements sub-screen is set to 

Sample & Reference, and the Ground field is set to External, an amber 

warning icon will appear. 

 Section 5.3.2, Hardware Requirements 
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• 2 Terminal connections are always used with the Sample and Reference 

module because the reference channels (Ref) are associated with the sample 

channels (Smp) and there is no referencing for the voltage measurement 

channels VHi and VLo. An error message will appear in the Start Experiment 

screen if 4 Terminal connections are specified in the Instrument Experiment 

Setup. 

 Section 5.2.2, Start Experiment. 

 Section 5.3.4, Instrument Experiment Setup. 

• The 2A booster cannot be used with the Sample and Reference module 

because it requires 4 Terminal connections. 

In the following sub-sections, the Sample and Reference module is used with 

various other modules, and the connection diagrams (Figures 3-7 to 3-10) show 

internal referencing, although external referencing could also be used. 

3.3.3.1 General Materials Testing with Reference Capacitance 

This configuration is used for general purpose impedance tests on a wide range of 

materials, where compensation is required for cable capacitance. A Sample and 

Reference module is used with a materials core module and an FRA. 

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Sample & Reference 

Instrument configuration: Mat only 

A connection diagram will appear as shown in Figure 3-7. 

 

Figure 3-7 General materials testing with internal referencing 

 In this configuration, the Sample and Reference module has been added to 

General Materials Testing, Section 3.3.1. 



ModuLab XM MTS Materials Test System: User Guide Setting Up and Running Experiments 

21006013_AE  3-33 

 The alternative connection diagram for external referencing is available by 

selecting User Reference in the Sample and Ref field, in the Sample Setup, 

Section 5.3.3. 

3.3.3.2 High Voltage Testing with Reference Capacitance 

This configuration is used for impedance testing of materials that require high 

stimulus voltage in circumstances where compensation is required for cable 

capacitance. A Sample and Reference module is used with a materials core 

module, a high voltage module and an FRA. 

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Sample & Reference 

Instrument configuration: Mat + HV 

A connection diagram will appear as shown in Figure 3-8. 

 

Figure 3-8 High voltage system with internal referencing 

 In this configuration, the Sample and Reference module has been added to 

High Voltage Materials Testing, Section 3.3.2.2. 

 The alternative connection diagram for external referencing is available by 

selecting User Reference in the Sample and Ref field, in the Sample Setup, 

Section 5.3.3. 
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3.3.3.3 High Impedance Testing with Reference Capacitance 

This configuration is used for impedance testing of materials that pass very low 

currents in circumstances where compensation is required for cable capacitance. 

A Sample and Reference module is used with a materials core module, a femto 

ammeter and an FRA. 

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Sample & Reference 

Instrument configuration: Mat + Femto Ammeter 

A connection diagram will appear as shown in Figure 3-9. 

 

Figure 3-9 High impedance system with internal referencing 

 In this configuration, the Sample and Reference module has been added to 

High Impedance Materials Testing, Section 3.3.2.3. 

 The alternative connection diagram for external referencing is available by 

selecting User Reference in the Sample and Ref field, in the Sample Setup, 

Section 5.3.3. 
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3.3.3.4 High Voltage / High Impedance Testing with Reference Capacitance 

This configuration is used for impedance testing of materials that pass very low 

currents at high voltage, in circumstances where compensation is required for 

cable capacitance. A Sample and Reference module is used with a materials core 

module, high voltage module, femto ammeter and an FRA. 

To access this configuration and display the connection diagram, select 
the following entries from the Hardware Requirements sub-screen 
(Section 5.3.2) 

Experiment Type: Sample & Reference 

Instrument configuration: Mat + HV + Femto Ammeter 

A connection diagram will appear as shown in Figure 3-10. 

 

Figure 3-10 High voltage / high impedance system with internal referencing 

 In this configuration, the Sample and Reference module has been added to 

High Voltage / High Impedance Materials Testing, Section 3.3.2.4. 

 The alternative connection diagram for external referencing is available by 

selecting User Reference in the Sample and Ref field, in the Sample Setup, 

Section 5.3.3. 
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4. Software Reference: System  

The ModuLab XM MTS user interface is divided into two main sections, System 

and Project, depending on the tab that has been selected at the bottom of the left-

hand navigation panel. 

 

This Chapter describes the features available under the System tab, which are: 

 User Preferences, Section 4.1. 

 Equipment Library, Section 4.2. 

Details of experiments, results and reports are available in the Software Reference 

for the features under the Project tab. 

 Software Reference: Project, Chapter 5. 
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4.1 USER PREFERENCES 

The User Preferences screen displays general information about the ModuLab 

XM system and software. This screen is available from the User Preferences item 

in the left-hand navigation panel, with the System tab selected. When all the sub-

screens are expanded, it appears as follows: 

 

The User Preferences are unique to each user of the system. When a user logs in 

to Windows and runs the ModuLab XM software, their specified preferences are 

applied to all projects. 

 The sub-screens are discussed in sub-sections 4.1.1 to 4.1.4. 
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4.1.1 General Settings 

This sub-screen in the User Preferences screen defines general information for the 

ModuLab XM system. 

 

The fields are as follows: 

Temperature units 

The units of temperature at which measurements are made. The units may be: 

°C 

°F 

K 

Corrosion units 

The units in which corrosion rates are measured. The units may be: 

mm/year 

mil/year  (mil = 1/1000 inch) 

CSV separator character 

The character which separates successive data fields in a CSV file. It may be: 

, 

; 

Tab 

Mains Frequency 

The frequency of the mains power supply, which may be: 

50 Hz 

60 Hz 

This is used in the Time Domain Measurement Setup, where an integration period 

can be specified in units of mains cycles. 

 Time Domain Measurement Setup, Section 5.7.2. 

4.1.2 Messages 

This sub-screen in the User Preferences screen contains boxes which you can 

check to select messages to be displayed in various circumstances. 
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In the current version there is just one message: 

Warn if calibration expired? 

A message is displayed if the calibration of a module has passed its expiry 

date and needs to be returned to Solartron for recalibration. 

4.1.3 Graph Preferences 

This sub-screen in the User Preferences screen defines options to be applied to 

graphic and tabulated data, when experiments have been run and results are 

displayed. Most of the options specified here are defaults which can be changed 

from the Graph Setup sub-screen, when setting up a step, or from the Axes or 

Trace Setup sub-screens, when displaying data. 

 Graph Setup, Section 5.7.6. 

 Axes, Section 5.11.1. 

 Trace Setup, Section 5.10.4. 

When the User Preferences screen is first opened, it appears as follows: 

 

The following fields apply generally to graphs and tables, without reference to the 

step type, but the options can be specified separately for DC only graphs and 

Impedance graphs. 

Arrangement of graphs 

When two graphs are displayed, by specifying both Graph 1 and Graph 2 in 

the Graph Setup or Axes sub-screens, the graphs can be displayed alongside 

each other from left to right, or one above the other from top to bottom. The 

options are: 

Left/Right 

Top/Bottom 

Position of data table 

This field defines the default position of tabulated data in relation to the 

graphs. The options are: 
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None Do not display tabulated data. 

Right Display tabulated data to the right of the graphs. 

Bottom Display tabulated data below the graphs. 

The options can be changed from the Axes sub-screen when the results are 

displayed. 

Graph trace style 

This field defines the default options for displaying data as lines and symbols 

on the graphs. The options are: 

Lines 

Symbols 

Lines & Symbols 

The options can be changed from the Trace Setup sub-screen when the results 

are displayed. 

Graph trace symbol size 

The default size of symbols, when used to display graphic data. The options 

are the odd numbers from 1 to 15. The symbol sizes can be changed from the 

Trace Setup sub-screen when the results are displayed. 

Default Graph Types 

In this group of fields, each row represents a step category, and you can click the 

rows to expand the categories and display the step types as follows: 
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There is one row for each step type, containing drop-down list boxes for the 

default variables to be displayed on two graphs, called Graph 1 and Graph 2. The 

available variables for DC and impedance steps are listed in the Layout of 

Graphic Displays. 

The option for Graph 2 defaults to “none” because you would normally want to 

specify variables that are different from Graph 1. 

 Layout of Graphic Displays, Section 5.11.1. 
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4.1.4 Advanced 

This sub-screen in the User Preferences screen defines advanced options for 

ModuLab XM. 

 

The fields are: 

Default options scheme 

This specifies a collection of default options to be used in cases where they 

are required to be country-specific. The list box has the following entries: 

UK 

Europe 

USA 

The selected option, together with the Reset to defaults button, will apply the 

country-specific defaults throughout ModuLab XM. For example, in the 

General Settings, the Temperature units will be set to °C for the UK and °F 

for the USA. 

 General Settings, Section 4.1.1. 

Reset to defaults 

If any optional values in the program have been changed, this button resets 

them to their default values. 

Show advanced/undocumented options 

If this box is checked, the sub-panel opens so that you can change various 

features of the software that are not available from the other screens. This list 

of features may change from time to time with new software versions. 
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4.2 EQUIPMENT LIBRARY 

The Equipment library gives a description of the hardware that makes up the 

ModuLab XM MTS system, and is defined by a set of items in the left-hand 

navigation panel, with the System tab selected. 

The Equipment library item is at the top of the hierarchy, and underneath it there 

are other items as follows: 

• There is a chassis item for each chassis in the system. 

• Underneath each chassis there are instrument group items, representing a 

core module and a number of optional modules which are specified 

automatically or manually as follows: 

• The high voltage module, femto ammeter and 2A booster are 

automatically detected by the system. 

• The frequency response analyzer has to be specified by the user in the 

Instrument Group Setup. 

 Instrument Group Setup, Section 4.2.3. 

• A temperature controller can be manually added to the instrument group. 

 Temperature Controller, Section 4.2.4. 

It is possible to set up virtual equipment and run simple experiments for test 

purposes, without actually having any equipment. 

 Virtual Equipment, Section 4.2.5. 

4.2.1 Equipment Summary 

The Equipment Summary is available from the Equipment library item, at the top 

of the equipment hierarchy as follows: 

 

The summary consists of a tabulated list of equipment, with one row for each 

instrument group, and with columns representing the features of the group. The 

rows can be re-arranged into reverse order by clicking the headers. 

NOTE: The tabulated list only appears on systems where equipment has been 

installed, otherwise there will be a Search button to identify the 

system hardware. 

 Installation Guide 
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In a system where equipment has been installed, the columns in the tabulated list 

are as follows: 

Instrument Groups Available 

This set of columns identifies the instrument groups and their location in a 

chassis. 

The columns are: 

Chassis 

The chassis to which the instrument group belongs. The name is specified in 

the General Settings for the chassis, otherwise it defaults to “Chassis”. 

 Chassis, Section 4.2.2. 

Group Name 

The name of the instrument group, defined in the Instrument Group Setup. 

The name defaults to “Instrument Group”, but you need to give each group a 

unique name, for example Group 1, Group 2, etc. 

 Instrument Group Setup, Section 4.2.3. 

Slot(s) 

The slots in which the core module and optional modules, which make up the 

group, are fitted in the chassis. The system automatically detects the slot 

numbers. 

Instrument Group Capability 

This set of columns gives the specification of the core module and optional 

modules. The columns are: 

MAT 

The model of the core module, detected automatically by the system. There is 

currently only one model: 

MAT 1MHz 

FRA 

The FRA model. The user has to specify that an FRA exists, in association 

with the core module, and then the system automatically detects the model. 

There is currently only one model: 

MFRA 1MHz 

 The existence of the FRA is specified in the Instrument Group Setup, 

Section 4.2.3. 

HV 

The model of the high voltage module, if fitted. This is detected automatically 

by the system and there is currently only one model: 

MHV 100 

FA 
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This field is ticked if a femto ammeter is fitted. This module is automatically 

detected by the system. 

MRef 

This field is ticked if a sample and reference module is fitted. This module is 

automatically detected by the system. 

2A 

This field is ticked if a 2A booster is fitted. This module is automatically 

detected by the system. 

AuxV 

This field is ticked if auxiliary voltage channels are available to the group. 

The auxiliary channels are automatically detected by the system. 

Auxiliary channels are fitted as standard to the ModuLab XM MTS system 

but may be optional in other versions of ModuLab XM. 

Temp. 

This field is ticked if a temperature controller is included in the group. 

Status 

The current status of the instrument group, same as in the Module Information. 

The status values are: 

Measuring The group is currently taking a measurement. 

In use The group is currently being used by this copy of the ModuLab 

XM software and cannot be used by anyone else. 

Experiment 

Limit 

The group is currently being used for an experiment, but the 

experiment has paused because a measurement has reached a 

limiting value. 

Not in use The group is not being used. 

Error The group has been running an experiment which has paused or 

stopped because of an error. This can occur for a number of 

different reasons, and more specific information is given in the 

Status Grid. 

 Status Grid, Section 2.6. 

 Module Information, Section 2.6.3. 
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4.2.2 Chassis 

The Chassis item is located under the Equipment library item. There will be at 

least one of them as part of the installation, but you can add new ones if required. 

The display associated with the Chassis is as follows: 

 

The right-hand window is divided into sub-screens, each with their respective 

fields as follows: 

General Settings 

Name 

A name for the chassis, in case there is more than one of them. The default 

name is Chassis, but if there is more than one of them, they will each need to 

be given unique names. 

Comments 

A free-format text field in which you can type a description of the chassis. 

Chassis Display 

Display IP address 

The IP address of the chassis display panel. The correct address, 

corresponding to the chassis display, has to be entered to enable the PC to 

communicate with the display. You can enter a four-part number, then click 

the Test Display button to implement it within the ModuLab XM software 

and perform a communication test. 
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Normally the default address should be used, but an alternative address will 

be required if there is already a device on the network that uses the default 

address, for example the display panel in another chassis. 

 Installation Guide for details of how to set up IP addresses on the 

system. 

Use default address? 

If this box is checked, the default address 169.254.254.1 appears in the 

Display IP address field, and the field becomes greyed out. 

Test Display 

This button implements the specified address within the ModuLab XM 

software, and if communication is successful it displays a test message on the 

chassis display. A message will also appear on the PC, to the right of the 

button. 

Advanced 

This sub-screen can be used to change the IP address of the chassis front panel 

display, and at the same time implement the new address within the ModuLab 

XM software and perform a communication test. 

CAUTION: This feature changes the address within the ModuLab XM 

hardware, and you will need to make a note of the new address in 

case it is needed within the Chassis Display sub-screen. If the new 

address is lost, you will no longer be able to communicate with 

the display and will have to return the chassis to Solartron for 

testing. 

The fields are: 

New IP address 

The new IP address to be used for the chassis display. 

New Subnet Mask 

The subnet mask associated with the new IP address for the chassis display. 

New Gateway address 

The gateway address associated with the new IP address for the chassis 

display. 

Change 

This button implements the address within the ModuLab XM hardware and 

software, according to the values in the three fields (New IP address, 

New Subnet Mask and New Gateway address). If communication is 

successful it displays a test message on the chassis display. A message will 

also appear on the PC, to the right of the button. The new address will appear 

in the Display IP address field in the Chassis Display sub-screen. 
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4.2.3 Instrument Group Setup 

Any number of instrument groups can be fitted to a chassis, according to the 

number of available slots and the optional modules within each group. The 

instrument groups appear in the left-hand navigation panel under the chassis, and 

each of them displays an Instrument Group Setup screen as follows: 

 

The fields are as follows: 

Instrument Group name 

A name for the instrument group. This defaults to “Instrument Group”, but you 

should specify a unique name for each group, for example Group 1, Group 2, etc.. 

Comments 

A free-format text field in which you can type a description of the core module. 

Core Module IP address 

The IP address of the core module. The correct address, corresponding to the core 

module, has to be entered to enable the PC to communicate with it. You can enter 

a four-part number, then click the Test button to implement it within the 

ModuLab XM software and perform a communication test. Normally the default 

address should be used, but an alternative address will be required if there is 

already a device on the network that uses the default address. 

 Installation Guide for details of how to set up IP addresses on the system. 

Use default address? 

If this box is checked, the default address 169.254.254.n appears in the Core 

Module IP address field, where n is the slot number plus 10, and the field 

becomes greyed out. 

Test 

This button implements the specified Core Module IP address within the 

ModuLab XM software, and tests the core module and optional modules, but not 

the FRA. If communication is successful it displays a list of modules on the 

chassis front panel, updating it with the latest changes. A message will also 

appear on the PC, in the display panel at the right of the sub-screen. 
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Instrument Web Page 

This hyperlink communicates with the core module and displays information 

about it as a web page. This includes the IP address of the card, in case it needs to 

be changed. 

CAUTION: If you change the address of the core module hardware, you will 

need to make a note of the new address in case it is needed within 

the ModuLab XM software. The address remains on the card 

when it is moved from one chassis to another, and if the address is 

lost, you will no longer be able to communicate with the core 

module and will have to return it to Solartron for testing. 

FRA Present 

If an FRA is fitted, this box needs to be checked to indicate its existence, then the 

system can identify the model and access its features, and the model will appear 

in the Equipment Summary. There is currently only one model: 

MFRA 1MHz 

 Equipment Summary, Section 4.2.1. 

FRA IP address 

The IP address of the FRA. The correct address, corresponding to the FRA, has to 

be entered to enable the PC to communicate with it. You can enter a four-part 

number, then click the Test button to implement it within the ModuLab XM 

software and perform a communication test. Normally the default address should 

be used, but an alternative address will be required if there is already a device on 

the network that uses the default address. 

 Installation Guide for details of how to set up IP addresses on the system. 

Use default address? 

If this box is checked, the default address 169.254.254.n appears in the 

FRA IP address field, where n is the slot number plus 9, and the field becomes 

greyed out. 

Test 

This button implements the specified FRA IP address within the ModuLab XM 

software, and it also tests the core module and optional modules, as if the Test 

button associated with the core module had been pressed. If communication is 

successful it displays a list of modules on the chassis front panel, updating it with 

the latest changes. A message will also appear on the PC, to the right of the 

button. 
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Instrument Web Page 

This hyperlink communicates with the FRA and displays information about it as a 

web page. This includes the IP address of the card, in case it needs to be changed. 

CAUTION: If you change the address of the FRA hardware, you will need to 

make a note of the new address in case it is needed within the 

ModuLab XM software. The address remains on the card when it 

is moved from one chassis to another, and if the address is lost, 

you will no longer be able to communicate with the FRA and will 

have to return it to Solartron for testing. 

4.2.4 Temperature Controller 

A temperature controller can be included in an instrument group, for the purpose 

of conducting experiments where the sample has to be maintained at a specified 

temperature during each step. 

To add a temperature controller to an instrument group: 

1. Click on the System tab, at the bottom of the navigation panel. 

2. Right-click on the Instrument Group item, then click Add New and 

Temperature Controller. The Temperature Controller item will appear under 

the instrument group. 

NOTE: The temperature controller has to be added manually to the 

system because it is not part of the chassis and is not detected 

automatically by the Search button in the Equipment Summary, 

during the ModuLab XM installation. 

 Installation Guide, for details of how to search for 

equipment. 
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When a temperature controller is selected in the left-hand navigation panel, the 

Temperature Controller screen appears as follows: 

 

The Temperature Controller Setup sub-screen has the following fields: 

Name 

The name of the temperature controller 

Comments 

A comment field, so you can specify the purpose of the temperature 

controller, and any other relevant information. 
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Controller Model 

The model of the temperature controller. The options are: 

None 

Eurotherm 2000 Series 

Lakeshore 

Manual Control 

Test Controller 

The text field underneath this field gives details of the selected model. 

Settings 

This field contains two sub-panels: 

• The upper panel contains a set of fields, appropriate for the selected 

model, so you can specify the settings for the model. 

• The lower panel contains a description of the field selected in the upper 

panel. 

 The settings for the available models are described in Sections 4.2.4.1 - 

4.2.4.2. 

The Diagnostics sub-screen enables you to test the controller and take 

measurements, independently of any experiments. 

 Diagnostics, Section 4.2.4.6. 
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4.2.4.1 Eurotherm 2000 Series Temperature Controller 

When the Eurotherm 2000 Series temperature controller is selected as the 

Controller Model, the Temperature Controller Setup screen displays the 

appropriate fields in the Settings panel as follows: 

 

The fields in the Settings panel are as follows: 

Communications 

This group of fields specifies the communication between the PC and the 

temperature controller. The fields are: 

Comms Type 

The communications type. The list box contains the following options: 

RS232 

RS485 

Comm Port 

The COM port number to which the controller is connected. You can type a 

number from 1 to 256. 
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Address 

The device address to be used when the communications type is RS485. You 

can type a number from 1 to 255. 

Other 

This group has the following fields: 

Autotune PID output 

When an experiment is run with Autotune enabled, the system calculates the 

proportional, integral and derivative control parameters for optimum 

performance and writes them to a file. The default pathname is: 

C:\My Data\ModuLab\Controllers\AutoTunePID.txt 

 When you click on the field, this button appears at the right of the 

pathname so you can display a filing system dialogue box and open the 

file in Windows Notepad. The file will only exist if a temperature 

control experiment has already been run. 

Setting file 

The pathname of the file containing the Eurotherm controller settings. The 

default pathname is: 

C:\My Data\ModuLab\Controllers\Eurothrm.set 

 When you click on the field, this button appears at the right of the 

pathname so you can display a filing system dialogue box and select a 

different settings file. You can also right-click on any filename in the 

dialogue box, then click Edit to open the file for editing in Windows 

Notepad. 

Some of the variables in the settings file correspond to the Temperature 

Stability group. Normally the system will use the values specified in the 

group, but if you change them within the file, the system will use the values 

from the file, not the group. For all other settings, the system always uses the 

values from the file. The variables in the file appear under the following 

headings: 

Serial Comms Setup 

You can change the baud rate if you have a COM port that does not use 

the default value of 9600. 

Heater / Sample 

The model 2700 controller supports the use of both heater control (the 

control thermocouple in the space between the heating or cooling element 

and the sample), and sample control (the thermocouple directly on the 

sample). If sample control is not required you can disable it and use 

heater only control. 
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Temperature Stabilisation / Stability Parameters 

Under these two headings there are some comments about the stability 

parameters, followed by the parameters themselves. You can edit the 

parameters, but it should not be necessary because you can specify the 

values in the appropriate fields in the Temperature Stability group. 

PID Control 

Autotune should normally be used initially to calculate the optimum PID 

parameters for a temperature control system, and then the parameters can 

be copied from AutoTunePID.txt to Eurotherm.set for future use with 

Autotune disabled. 

Alternatively you can edit Eurotherm.set with your own specific values if 

required. 

Temperature Stability 

This group of fields is common to all temperature controllers, and specifies the 

conditions when temperature is considered to be stable at a value close to the set 

point, for the purpose of temperature control experiments. 

 Temperature Stability, Section 4.2.4.3. 
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4.2.4.2 Lakeshore Temperature Controller 

When the Lakeshore temperature controller is selected as the Controller Model, 

the Temperature Controller Setup screen displays the appropriate fields in the 

Settings panel as follows: 

 

The fields in the Settings panel are as follows: 

Communications 

This group of fields specifies the communication between the PC and the 

temperature controller. The fields are: 

GPIB Interface 

The address of the GPIB interface bus, to which multiple devices can be 

connected. 

GPIB Address 

The address of the temperature controller on the GPIB bus. 
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Other 

This group has just one field: 

Setting file 

The pathname of the file containing the Lakeshore controller settings. The 

default pathname is: 

C:\My Data\ModuLab\Controllers\Lakeshore332.set 

 When you click on the field, this button appears at the right of the 

pathname so you can display a filing system dialogue box and select a 

different settings file. You can also right-click on any filename in the 

dialogue box, then click Edit to open the file for editing in Windows 

Notepad. 

Some of the variables in the settings file correspond to the Temperature 

Stability group. Normally the system will use the values specified in the 

group, but if you change them within the file, the system will use the values 

from the file, not the group. For all other settings, the system always uses the 

values from the file. The variables in the file appear under the following 

headings: 

Temperature Stabilisation / Stability Parameters 

Under these two headings there are some comments about the stability 

parameters, followed by the parameters themselves. You can edit the 

parameters, but it should not be necessary because you can specify the 

values in the appropriate fields in the Temperature Stability group. 

Controller Initialisation 

The variables underneath this heading apply to the initialisation 

procedures for the controller, and are described in the Lakeshore 

documentation. 

Temperature Offset 

The Lakeshore controller provides temperature control from the heater, 

which is a small distance away from the sample. This leaves the sample 

at a temperature which is different from the set point, and a list of offsets 

has to be specified to bring the sample to the correct temperature. Each 

entry in the list has the following format: 

%TemperatureOffset=T1,T2 

where T1 is the required sample temperature and T2 is the offset required 

to achieve it, both in K. For example: 

%TemperatureOffset=110,0.75 

The maximum temperature offset is 50K. 

PID Configure 

The Lakeshore controller does not use auto-tuning so the appropriate PID 

values have to be specified, as described in the Lakeshore documentation. 
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Enable Heater 

The heater or cryostat is set to operate normally up to its maximum range. 

Temperature Stability 

 This group of fields is common to all controllers and is described in the 

next Section. 

4.2.4.3 Temperature Stability 

The Temperature Stability fields are common to all controllers, with some minor 

differences, and they appear in the Settings panel in the Temperature Controller 

Setup as follows: 

 

This group of fields applies stability criteria to experiments under temperature 

control. A temperature loop begins with a temperature settling step which 

continues until the measured temperature fulfils the stability criteria, then it 

moves to the next step in the loop. 

 Temperature Loop, Section 5.9.3. 

There are two temperatures that may be measured: 

• The control temperature is the temperature of the heater or cooler, measured 

by a thermocouple in the space between the sample and the heating or 

cooling element. 

• The sample temperature is the temperature measured by a thermocouple 

placed directly on the sample. This feature is only available on the following 

controller models: 

Eurotherm 2604 

Eurotherm 2704 

Lakeshore 331s 

Lakeshore 332 

Two different tests are applied to a collection of the latest measurements, and the 

set point is considered to have been reached when both of these are fulfilled: 

• Tolerance Test. The measurements are all within a specified tolerance value 

of the set point. 

• Standard Deviation Test. The standard deviation of the measurements is 

below a specified value. 
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The fields in this group are as follows: 

Check Sample Stability / Check Control Stability 

These two fields specify whether or not to wait for the sample or control 

temperature to reach stability, according to the specified tolerances and 

standard deviation. For each field, the options are: 

True 

False 

If both fields are set to True, the set point has been reached when both the 

sample and control temperatures have become stable. 

At least one field should be set to True, to achieve meaningful temperature 

settling. If both fields are set to False, the system immediately considers the 

set point to have been reached. 

Stabilisation Period 

The period of time during which the latest temperature measurements are 

collected, at the rate of one measurement / second, for the purpose of testing 

for tolerance and standard deviation. This field applies equally to the 

collection of sample and control temperatures, and should normally be set to 

about 20 seconds, but may have a maximum value of 300 seconds. 

Sample Tolerance / Control Tolerance 

These two fields specify the tolerance values to be applied to measurements 

of the sample and control temperatures, so that the Tolerance Test is fulfilled 

when all the measurements taken during the Stabilisation Period are within 

this value of the set point. These fields should normally be set to about 2K. 

Standard Deviation 

The system calculates a moving standard deviation of the latest collection of 

temperature measurements, and when it falls below the value specified in this 

field, it is considered to have fulfilled the Standard Deviation Test. This field 

should normally be set to about 0.5K or less. 

Standard deviations are calculated separately for sample and control 

temperatures, so that two tests can be performed, both using the value in this 

field. 

The time period for collection of measurements is specified in the 

Stabilisation Period field. 

Stabilisation Timeout 

Normally it will take some time for the sample temperature to become stable 

after the control temperature has become stable (if the same tolerances are 

applied in each case). 

This field specifies the maximum time in minutes that the system will wait, 

after the control temperature has become stable, and when this period expires 

the sample temperature is also considered to be stable. 

This field is available for the Lakeshore controllers, but not the Eurotherm 

2000 Series controllers. 
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4.2.4.4 Manual Control 

When Manual Control is selected as the Controller Model, the Temperature 

Controller Setup screen displays a blank Settings panel as follows: 

 

Manual Control is used for experiments where an unsupported temperature 

controller is being used, that cannot be connected to the ModuLab XM system. 

During the experiment, the user is prompted to manually set the controller to a 

specific temperature, then click Continue when the temperature is reached. A 

typical prompt is as follows: 

 

This feature enables experiments to be run with any temperature controller, but 

the user must be present to respond to each successive prompt. 
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4.2.4.5 Test Controller 

When Test Controller is selected as the Controller Model, the Temperature 

Controller Setup screen displays a blank Settings panel as follows: 

 

This enables you to run temperature control experiments, for test purposes, when 

a temperature controller is not available. The Test Controller has no settings. 

4.2.4.6 Temperature Controller Diagnostics 

The Diagnostics sub-screen, in the Temperature Controller screen, enables you to 

test the controller and take measurements, independently of any experiments. The 

sub-screen is as follows: 

 

The fields are as follows: 

Connect 

This button establishes communication with the controller, so that it starts taking 

measurements. If communication fails, a dialogue box will appear giving the 

reason. 

Disconnect 

This button discontinues communication with the controller so that it stops taking 

measurements. 
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Set Point / Change 

You can specify a value of the set point, then press the button and the 

measurements taken by the controller will gradually progress towards the new set 

point. 

This pair of fields is available only when the PC is communicating with the 

controller, otherwise it is greyed out. 

Measurement / Value 

This tabulated list gives the variables being measured, such as Sample or Control, 

and the measured value. 

4.2.5 Virtual Equipment 

It is possible to add virtual chasses and instruments to the equipment library and 

set up simple experiments, then run them and get results for test purposes, without 

actually having any equipment. 

A virtual chassis can be added, containing an instrument group with the 

following modules: 

MAT 1MHz 

MHV 100 

MFA 

MBST 2A 

MREF 

A temperature controller can also be added, although it is not part of the chassis. 

The following features can be added to an experiment Setup that uses a virtual 

instrument group: 

Open Circuit step 

Constant Level step 

Standard loop 

Temperature loop, automatically containing a Temperature Settling step 

In the Step Setup, the following fields can be given values for use with the 

experiment. 

• Duration and Level, in the Scan Setup sub-screen. 

• Measurement Rate, in the Time Domain Measurement Setup sub-screen. 

All other fields will use their default values and any changes will be ignored. 

Impedance measurements cannot be made using virtual equipment. If an FRA has 

been included in an instrument group, it will not be possible to run experiments. 

Here is an example of how to add virtual equipment, and set up and run an 

experiment to test a temperature controller: 

1. Click on the System tab at the bottom of the navigation panel, then right-click 

on the Equipment Library. Click Add New, then Virtual Chassis. A new 

Virtual Chassis item will appear. 

2. Right-click on the Virtual Chassis, select Add New and select Virtual 

Instrument. A new Virtual Instrument Group item will appear. 
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3. Click on the Virtual Instrument Group to display the Instrument Group Setup 

sub-screen, then click on the Test button for the core module. The group will 

be populated with the following modules in slots 2 to 7: 

Slot 2 MAT 1MHz with AUX channels 

Slot 3 MHV 100 

Slot 4 MFA 

Slot 5 MREF 

Slots 6 and 7 MBST 2A 

The screen will be as follows: 

 

NOTE: Do not add an FRA because it is not supported in virtual 

equipment and will prevent experiments from running. 

4. Right-click on the Virtual Instrument Group, then click Add New and 

Temperature Controller. The Temperature Controller item will appear. 

NOTE: A temperature controller always has to be added manually, 

because it is not part of the chassis and is not detected by the Test 

button. 
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5. Click on the Temperature Controller item to display the Temperature 

Controller Setup sub-screen, and select a controller model. You can select any 

model, but for the purpose of this example you can select the Test Controller 

because it has no settings, and nothing needs to be specified in the Settings 

panel. The screen will be as follows: 

 

6. Click the Project tab at the bottom of the navigation panel. 

7. Right-click on the Project item at the top of the navigation structure, then 

click on Add New, then Experiment. An experiment item will appear with a 

Setup item and an undefined step item in the structure underneath. 

8. Click on the Setup item to display the Hardware Requirements sub-screen, 

then select the Virtual Instrument Group as the Instrument Group to Use. 

9. Click on the undefined step item and define it as an Open Circuit step. 

10. Right-click on the experiment Setup item, then click on Add New, then Loop, 

then click on Scan Temperature to define it as a Temperature loop. 
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11. Specify the fields in the Temperature Loop sub-screen as required, or leave 

them at their defaults. 

12. The Temperature Loop will contain a Temperature Settle step followed by an 

undefined step. Click on the Temperature Settle step and edit the fields as 

required, or leave them at their defaults. 

13. Click on the undefined step and define it as Constant Level. 

14. Click on the Experiment item to display the Start Experiment screen and 

make sure the Virtual Instrument Group is selected in the Use field, so that 

the screen is as follows: 
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15. Click the Run button. The experiment will run and display the results of the 

Open Circuit step, then it will start the temperature loop and perform the 

appropriate number of cycles around the Temperature Settle step and 

Constant Level step. A graphic display of results will appear as follows: 
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5. Software Reference: Project  

The ModuLab XM user interface is divided into two main sections, System and 

Project, depending on the tab that has been selected at the bottom of the left-hand 

navigation panel. 

 

This Chapter describes the features available under the Project tab, including 

projects, experiments, data, graphs and reports. 

Details of user preferences and equipment are available in the Software Reference 

for the features under the System tab. 

 Software Reference: System, Chapter 4. 

5.1 PROJECTS 

A project defines all the features required to perform experiments, including the 

collection of results and their presentation in the form of tabulated lists and 

graphs, and the preparation of reports. The project definition is contained in the 

structure of items in the navigation panel when the Project tab is selected. 

 Structure of items in a project, Section 2.1.2. 

 Items and sub-items available for addition to a project, using Add New 

from the File menu, Section 2.4.1. 

The project does not contain any information about the system hardware, but it 

has to reference a correct definition of the hardware from the Equipment library, 

to enable the experiments to work. For example, an experiment can only reference 

the core module and other modules that are installed in the system and are present 

in the Equipment library. 

 System, Section 2.1.1  

 Equipment Library, Section 4.2. 
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5.1.1 Create New Project 

A new project can be created by selecting New Project from the File menu. This 

will display a dialogue box in which you can specify a project name and various 

other features of the project. In its expanded state, with the More button selected, 

the dialogue box is as follows: 

 

The fields are: 

Name 

The project name that will appear in the navigation panel when the new 

project is created. 

Comment 

A comment about the project. 

More / Less 

This is a toggle button to expand and contract the dialogue box. The following 

additional fields appear in the expanded state: 

Location 

The folder in the filing system where the project is to be stored, for 

example: 

C:\My Data\ModuLab MTS 

Browse 

Browse the filing system to find a suitable location for the project. The 

selected folder will appear in the Location field. 

Create experiment too 

If this box is checked, an experiment will be created with the project. 

Cancel 

Close this dialogue box without creating a project. 
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Create Project 

Complete the creation of the project so that it appears in the left-hand 

navigation panel. If a project is already open, containing items that have 

changed, the Close Project dialogue box will appear, so that you can specify 

the items that need to be saved, then the new  project will appear. 

 Opening and Closing Projects, Section 5.1.2. 

 Example of how to create a new project and develop an experiment, 

Chapter 3. 

5.1.2 Opening and Closing Projects 

Projects can be opened and closed as follows: 

• To open a project that has previously been created, select Open Project from 

the File menu. A filing system dialogue box appears with an appropriate 

folder selected (depending on previous navigation of the filing system) and 

you can expand the folder and select the project to be opened, then click OK. 

If a project is already open and changes have been made, the Close Project 

dialogue box will appear so that you can save the changes. Then the new 

project will appear in the navigation panel (with the Project tab selected) in 

place of any currently open project. 

• To re-open a recently opened project, hold the cursor over Recent Projects in 

the File menu, to display a recent project list, then select the required project. 

If a project is already open and changes have been made, the Close Project 

dialogue box will appear so that you can save the changes. Then the new 

project will appear. 

A project will remain in the recent project list until the whole list is cleared 

using Clear List, which appears at the bottom of the list. 

• To close a project, select Close Project from the File menu. If changes to the 

project have been made, the Close Project dialogue box will appear so that 

you can save the changes. All structures will then disappear from the 

navigation panel, regardless of whether the System or Project tab is selected. 

The Close Project dialogue box appears in all circumstances where a project 

needs to be closed and changes to the project have been made. This includes 

closing a project yourself, creating a new project or opening an existing project 

when a project is already open, or exiting the ModuLab XM application. 
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The dialogue box is as follows: 

 

The fields and controls are as follows: 

These experiments will be stopped 

This panel contains a list of all experiments that are currently running. All 

experiments will be stopped when the project closes, because they depend on 

the project for their setup and collection of data. Normally, you wouldn’t want 

to close a project while an experiment is running, so this serves as a warning 

that you should click the Cancel button. 

Save changes to the following items 

This panel contains a list of items in the project where changes have been 

made, since the project was opened. In each case, the item is identified from 

the full pathname in the expanded structure in the left-hand navigation panel, 

and there is a check box so that you can specify that the item needs to be 

saved. 

Cancel 

This button closes the dialogue box without closing the project, and without 

saving any items. 

All 

This button checks the boxes for all the items in the list, so that they will all 

be saved when you click Continue. 

None 

This button clears the boxes for all the items in the list, so that none of them 

will be saved when you click Continue. 

Continue 

This button closes the project and saves the changes to the items that have 

been checked. Any experiments that are currently running will be stopped. 
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5.2 EXPERIMENTS 

 

Any number of experiments can be set up within a project, either directly under 

the project or under a folder within the project. Underneath each experiment, 

there is a Setup feature, which enables the general features of the experiment to 

be defined, and at the next level there are steps and loops which define the 

excitation signals to be applied to the sample during the experiment. An 

experiment structure, containing a single step called Linear Sweep, is as follows: 

 

5.2.1 Add New Experiment 

 
To add an experiment to a project or folder, proceed as follows: 

1. Run the ModuLab XM software and open the appropriate project. 

2. Right-click on the project to display the drop-down list box and select 

New Experiment. 
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The new experiment will appear in the navigation panel and the 

Start Experiment screen will appear. 

 Start Experiment, Section 5.2.2. 

The experiment, in its expanded state, will show its own Setup item as 

follows: 

 

3. Click once on the new experiment to select it, then click again, then type an 

appropriate name, for example My Experiment, so the navigation panel 

becomes as follows:  

 

4. Set up the experiment. 

 Sections 3.2.2 and 5.3 (including the sub-Sections) 

5. Under the Setup item, there is a single step called: 

1: Step 

Assign a step type. 

 Section 5.6.2 
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NOTE: It is also possible to add an experiment to a folder within the project, 

by right-clicking on the folder, then selecting Add New, then 

Experiment. This has a different functionality than New Experiment, 

because it adds the item directly under the currently selected item. 

 Add New in the File menu (Section 2.4.1) and 

New Experiment in the Experiment menu (Section 2.4.4). 

5.2.2 Start Experiment 

 

When an experiment is selected from the navigation panel, the Start Experiment 

screen appears as follows: 

 

This is the top level screen for the experiment, which enables the experiment to be 

run, but first it has to be correctly configured from the lower level screens. 

This screen displays the connection diagram, defined in the Hardware 

Requirements, and there are two tabulated lists of equipment as follows: 

• There is a tabulated list of Experiment Hardware Requirements, which 

specifies the modules that are required for the experiment. A core module 

will always be required, but additional modules may also be required as 

follows: 

- A high voltage module, femto-ammeter, sample and reference module or 

booster (2A) may be required, depending on the experiment type and 

instrument configuration specified in the Hardware Requirements sub-

screen, in the experiment setup screen. 

 Hardware Requirements, Section 5.3.2. 
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- Auxiliary voltage channels will be required if they have been enabled in 

the Instrument Experiment Setup sub-screen, in the experiment setup 

screen. 

NOTE: Auxiliary channels are fitted as standard to ModuLab XM 

MTS but may be optional in other versions of ModuLab XM. 

 Instrument Experiment Setup, Section 5.3.4. 

- An FRA will be required if an impedance step has been defined under 

the experiment. 

NOTE: An FRA is always included in the connection diagram, 

regardless of whether or not it is used in the experiment. 

• There is a tabulated list of installed hardware, matching the Equipment 

Summary, with the groups identified under Instrument Groups Available, and 

the module specifications under Instrument Group Capability. Each row of 

the table represents one instrument group, and the row will be coloured green 

if it matches or exceeds the Experiment Hardware Requirements and is 

available for running an experiment. It will turn red, indicating that it cannot 

be used, in either of the following circumstances: 

• The instrument group fails to meet the Experiment Hardware 

Requirements. The cells representing equipment that is either missing or 

not to the required standard will turn a darker shade of red. 

• The instrument group is already running an experiment. This will already 

be obvious if the PC and ModuLab XM system are alongside each other 

in the same room, but not so obvious if they are in different locations on a 

network. The instrument group will turn green when the experiment has 

finished. 

 Equipment Summary (Section 4.2.1). 

The tabulated list of installed hardware has an additional field, not included in 

the Equipment Summary, as follows: 

Use 

This column contains a check box for each instrument group, so that you 

can select which ones to use for the experiment. Any group that meets or 

exceeds the Experiment Hardware Requirements can be used. An 

experiment can be run using multiple core modules, by checking the 

boxes for each of them and connecting a sample to each instrument 

group. 

The default selection will be a single check box, according to the 

following rules: 

• If the experiment has just been added, the box will be checked for the 

first instrument group in the list that meets the requirements. 

• If a group has been specified in the Instrument Group to use field, in 

the Hardware Requirements sub-screen in the experiment setup 

screen, the box for the specified group will be checked. 
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• If the Custom option has been selected in the Instrument Group to use 

field, no box will be checked. The Custom option does not depend on 

any installed hardware, and enables the configuration to be set up so 

that it can be transported between systems. 

Comment 

You can write a comment about the experiment. 

Data File 

This field specifies the name of the data file that appears in the navigation panel 

when the experiment is run. It defaults to the experiment name, and is appended 

by a number if the same name is used more than once. 

OC Measure 

This button performs an open circuit measurement on the sample, to obtain 

results without applying an excitation signal from the generator. The results will 

appear in the status grid at the bottom of the screen, together with a red control 

button so that the measurements can be stopped. When the measurements are 

stopped, the red button is replaced by an OC button so that they can be re-started. 

The open circuit measurement is a useful method of obtaining results on the 

performance of the sample, before running an experiment. 

Run 

This button runs the experiment and writes the results to the specified data file. 

The file name appears in the navigation panel, automatically highlighted, and the 

graphs and tabulated lists of data will appear, and will be updated as each new 

data point is collected. 

(Error and Warning Messages) 

If the experiment has not been set up correctly, a tabulated list of errors and 

warnings will appear at the bottom of the screen as follows: 

 

There are two columns: 

Severity 

The severity of the problem, which may be: 

Warning The experiment will run, but there is something in the 

configuration that doesn’t make sense. For example, if the 

experiment uses the Sample and Reference module, but 

there are no impedance steps that use the “Sample & 

Reference” measurement mode, a warning will appear. 

Error The experiment will not run. Instead a message box will 

appear when you click the Run button, advising you to 

correct the problems found in this tabulated list of errors. 
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Description 

A description of the problem. The message begins with an identification of 

where the problem occurs, for example “Experiment” if it’s in the Setup, or 

the step number if it’s in one of the steps. Then it says what the problem is 

about. 

5.3 EXPERIMENT SETUP 

 

When you select the Setup item, under an experiment in the navigation panel, the 

experiment setup screen appears as follows: 

 

The experiment setup screen is divided into the following sub-screens: 

• Comments 

• Hardware Requirements 

• Sample Setup 

• Instrument Experiment Setup 

• Experiment Limits 
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5.3.1 Comments 

 

The Comments sub-screen, in the experiment setup screen, enables you to enter 

a comment about the experiment. 

 

5.3.2 Hardware Requirements 

 

The Hardware Requirements sub-screen, in the experiment setup screen, 

specifies the hardware and connection configuration for the experiment. The 

expanded screen with the Advanced box checked is as follows: 
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The fields are: 

Experiment Type 

The type of experiment, representing a main category in which there can be a 

number of different hardware and connection configurations. The following 

options are available from the list box: 

Normal 

Sample & Reference  

Installation Test 

The default option is Normal. 

Instrument configuration 

The modules required for the experiment. The available options depend on the 

selected Experiment type, as follows: 

Experiment Type: Available Instrument configurations 

Normal Mat only 
Mat + HV 
Mat + Femto Ammeter 
Mat + HV + Femto Ammeter 
Mat + 2A 
Mat + HV + 2A 

Sample & Reference Mat only 
Mat + HV 
Mat + Femto Ammeter 
Mat + HV + Femto Ammeter 

Installation Test Mat only 
Mat + HV 
Mat + Femto Ammeter 
Mat + Sample & Reference 
Mat + 2A 

A connection diagram and description is displayed when a selection is made from 

these two list boxes, and the circumstances in which each configuration may be 

used are given in the Hardware and Connection Configurations. 

 Hardware and Connection Configurations, Section 3.3, including the sub-

Sections. 

The default option is Mat only. 

Instrument Group to use 

The instrument group to be used for this experiment. The list box contains all the 

groups installed in the system, according to the names that they have been given 

in the Instrument Group Setup. 

 Instrument Group Setup, Section 4.2.3. 

If there is more than one instrument group, the name will be appended by the slot 

numbers and chassis number, for example “Group 1” becomes “Group 1 in slots 

1 to 7 of Chassis 1”. 
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The default option is the first group that is found by the system, that matches the 

requirements of the experiment, based on the Experiment type and Instrument 

configuration. These two fields respectively default to Normal and Mat only, 

when adding a new experiment, so any group could be used in the Instrument 

Group to use field because they all have a core module. The default is therefore 

the first group in the chassis, according to their slots, and if a group is not found it 

defaults to Custom. 

The Custom option enables you to set up an experiment without necessarily 

matching it to any specific hardware. For example, you might have problems with 

the hardware, or you may be changing the hardware configuration, or you may be 

setting up an experiment for a third party system where the installed modules may 

be different from those in your own system. The Custom option makes the 

experiment fully transportable between systems, and if all the experiments in a 

project use this option, it means the project is independent of the Equipment 

library. 

Advanced 

If this box is checked, the sub-screen expands to display the materials core 

module and optional modules in the selected Instrument Group to use, according 

to their model identifiers. If an instrument group is selected from the installed 

hardware, the fields will be greyed out and cannot be changed. Otherwise, if the 

Custom option has been selected, the list boxes become available for you to select 

a model. 

 If the experiment requires optional modules, according to the Experiment 

type and Instrument configuration, and a core module is selected that 

does not have the optional modules fitted, a red error icon will appear 

alongside the appropriate module fields. The experiment will not run 

when there is an error. 

The following fields appear under the check box: 

Materials Core Module 

The model of the core module that is being used. There is only one model, as 

follows: 

MAT 1MHz 

FRA option 

The option to use an FRA if required. There is only one model, so the field 

may be either of the following: 

Not fitted 

MFRA 1MHz 

Femto Ammeter option 

The option to use a femto ammeter if required. There is only one model, so 

the field may be either of the following: 

Not fitted 

MFA 
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Sample & Ref option 

The option to use a sample and reference module if required. There is only 

one model, so the field may be either of the following: 

Not fitted 

MREF 

High Current option 

The option to use a 2A booster if required. There is only one model, so the 

field may be either of the following: 

Not fitted 

MBST 2A 

High Voltage option 

The option to use a high voltage module if required. There is only one model, 

so the field may be either of the following: 

Not fitted 

MHV 100 

Bypass High Voltage 

The high voltage module is fitted with a bypass circuit, so that if this box is 

checked, the signal passes through the module unchanged. 

This box can be checked only if a high voltage module is available and is 

used in the experiment, otherwise it is greyed out. The High Voltage option 

field must indicate a model, and the Instrument configuration field must 

include a high voltage module (for example Mat + HV). 

Ground 

The type of grounding to be used. The options are: 

Internal The ModuLab XM system is internally grounded, with the 

LO point connected to ground through an internal switch (no 

cable required). This option should only be used if the sample 

is not grounded. 

External The ModuLab XM system is externally grounded through the 

sample (LO floating). This option should only be used if the 

sample is grounded. 

 

 An amber warning icon appears if the selected grounding is 

inappropriate for the experiment. 

NOTE: The LO point is a common reference voltage for modules within a 

group. 

 Installation Guide. 
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5.3.3 Sample Setup 

 

The Sample Setup sub-screen, in the experiment setup screen, specifies the 

sample configuration for the experiment as follows: 

 

The fields are: 

Electrode Diameter 

The diameter of the sample electrode. A value specified in this field will cause 

the Electrode Area to be calculated and highlighted in green. 

Electrode Area 

The area of the sample electrode, used for the calculation of current density. A 

value specified in this field will cause the Electrode Diameter to be calculated and 

highlighted in green. 

Thickness 

The thickness of the sample, used to calculate permittivity and modulus. 

Empty Cell Cap 

The capacitance of the empty space between the sample holder electrodes, when 

there is no sample between them. 

If the box is checked you can specify a value. 

If the box is unchecked, the field will be greyed out and will display a value 

calculated from the Electrode Area and Thickness. 
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Sample and Ref 

The sample and reference module may be configured to use it’s own internal 

reference capacitors, or it can be connected to an external reference supplied by 

the user. The options are: 

Internal Reference The sample and reference module is configured 

to use it’s own internal references. The 

connection diagram will show the Ref sockets 

connected to the Int Ref sockets (Figure 5-1). 

User Reference The sample and reference module is connected to 

an external reference, supplied by the user. The 

connection diagram will show the Ref sockets 

connected to the external user reference 

(Figure 5-2). 

 
 

Figure 5-1 Sample and reference 
module with internal reference 

Figure 5-2 Sample and reference 
module with user reference 

The following fields become available when User Reference is specified in the 

Sample and Ref field, otherwise they are greyed out. They specify the properties 

of the external user reference. 

Ref Capacitance 

The capacitance of the user reference. 

Ref Conductance 

The conductance of the user reference, measured in Siemens. 

 These fields are only applicable when Sample & Reference has been 

specified as the Experiment Type, in the Hardware Requirements, 

Section 5.3.2, and Sample & User Ref has been specified as the 

Measurement Mode, in the Impedance Setup, Section 5.7.1. 
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5.3.4 Instrument Experiment Setup 

 

The Instrument Experiment Setup sub-screen, in the experiment setup screen, 

specifies the instrument configuration for the experiment as a whole. A more 

specific setup is available for steps within the experiment, from the Instrument 

Step Setup. 

 Section 5.7.4. 

NOTE:  These setup screens are for the experiment and step. There is also 

an Instrument Group Setup for the hardware, defined in the 

Equipment library. 

 Instrument Group Setup, Section 4.2.3. 

The Instrument Experiment Setup screen is as follows: 

 

The fields are: 

Connections 

The number of connections to the sample. The options are: 

Default The connections are 2 Terminal or 4 Terminal, 

depending on the Experiment Type and Instrument 

Group to Use, specified in the Hardware 

Requirements. 

 Hardware Requirements, Section 5.3.2. 

2 Terminal Only the generator (Gen) and current return (I) are 

connected to the sample. This configuration is always 

used for experiments that use the Sample and 

Reference module. 

4 Terminal The generator, current return and two voltage 

measurement connectors (Vhi and Vlo) are connected 

to the sample. This configuration is always used for 

experiments that use the 2A booster module. 



Software Reference: Project  ModuLab XM MTS Materials Test System: User Guide 

5-18  21006013_AE 

Voltage range 

The voltage range of the core module. The options are: 

Auto 

0:  8V 

1:  3V 

2:  300mV 

3:  30mV 

4:  3mV 

Each range, other than Auto, is prefixed by a range number so that the ranges can 

be recorded and displayed with the data. 

The default value is Auto, displayed in a single list box and this selects a voltage 

range appropriate to the measurements. If any other value is selected, a second 

list box appears so that you can specify an upper value of the voltage range. 

Each value represents a range, so that a pair of values represents the limits of the 

ranges to be used. For example, if the first list box specifies 300mV and the 

second one specifies 8V, the system will switch between three ranges as required 

(300mV, 3V, 8V). To maintain the core module on a fixed range, both list boxes 

have to be the same. 

If the auxiliary channels are enabled, they will find their own voltage ranges 

within the limits set for the core module. 

Current range 

The current range of the core module. The options are: 

Auto 

1:  100mA 

2:  30mA 

3:  3mA 

4:  300µA 

5:  30µA 

6:  3µA 

7:  300nA 

8:  30nA 

Each range, other than Auto, is prefixed by a range number so that the ranges can 

be recorded and displayed with the data. 

If any value other than Auto is selected, a second list box appears so that you can 

specify an upper value of the current range. A pair of values represents the limits 

of the ranges to be used, same as for the Voltage range. 

The default value is Auto, displayed in a single list box, and this selects a current 

range appropriate to the measurements. The range should be limited by a pair of 

values in cases where Auto would give inappropriate ranges or an excessive 

number of changes in range. 



ModuLab XM MTS Materials Test System: User Guide Software Reference: Project 

21006013_AE  5-19 

Auto range speed 

This feature is available to limit the speed at which current range changes can 

occur, for example when the measurements pass through zero or the data is noisy. 

The options are: 

Fast 

Medium 

Slow 

Very Slow 

The appropriate option should be selected, depending on how it affects the 

collection of data. The faster options may produce an excessive number of range 

changes, while the slower options may occasionally use a less accurate range. 

Force recording range changes 

When an experiment is running and generating data, and the core module changes 

from one voltage or current range to another, the system may record the range 

numbers so that they can be displayed in graphs and tables, together with the data. 

Normally, range numbers are only included in the data when the measurement 

rate is less than 500 samples/second. However, if this box is checked, range 

numbers will be included at higher measurement rates, even if it slows down the 

collection of data. 

 Measurement Ranges, Section 5.11.2, for details of how to display range 

information with the data. 

Enable Auxiliary Voltage Inputs 

This group of fields determines how the auxiliary channels are to be used in the 

experiment. These channels are for connection to accessories such as temperature 

probes, not for taking measurements on the sample. 

DC 

The four check boxes, A, B, C, D, indicate the auxiliary channels that are 

used for DC measurement. 

 Installation Guide, for details of auxiliary channel cable connections and 

grounding. 
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5.3.5 Experiment Limits 

 

The Experiment Limits sub-screen, in the experiment setup screen, specifies 

the upper and lower limits of voltage, current and charge to be output to the 

sample, as follows: 

 

To apply a limit, check the appropriate box, then specify the value and units from 

the associated numeric field and drop-down list box. 

NOTE: Experiment limits are also imposed by the ModuLab XM hardware. 

The Materials Core Module is fitted with short circuit protection so 

that a switch opens when the current reaches an unsafe level. If this 

happens, the Error (red) LED on the module front panel will come on, 

but it is unlikely to happen because of various built-in safeguards. 

 Installation Guide. 

If a limit is reached during an experiment, whether imposed by the hardware or 

software, the appropriate cells in the status grid will turn red and the experiment 

will pause, but it can be made to continue under appropriate circumstances using 

the control buttons at the right of the status grid. 

 Paused Experiments, Section 2.6.1. 

5.4 LOOP 

 

A loop defines a set of measurements to be taken repeatedly, and may contain 

additional loops, nested at multiple levels. Measurements are taken by 

including steps within the loops. 

5.4.1 Adding a Loop 

In the navigation panel, a loop can be added under an experiment Setup or 

another loop as follows: 

1. Right-click on the experiment Setup or loop to display the drop-down menu. 

Move the cursor to Add New, then select Loop. The new loop appears under 

the experiment Setup or loop, prefixed by a number, for example: 

1: Loop 

The number is incremented by 1 for each successive loop at the same level. 

However, loops and steps belong to the same sequential numbering system, so 
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that if there is already a step at the same level and you add a loop, it will be 

given the next number, for example: 

1: Step 

2: Loop 

2. Add some more loops or steps under the loop. You can add as many nested 

loops as you like, but there has to be some steps within the structure, 

otherwise the loop doesn’t do anything. 

NOTE: Decisions can also be included in the structure of loops and steps. 

 Decision, Section 5.5. 

5.4.2 Loop Setup 

When you click on a loop in the navigation panel, the Loop Type and 

corresponding Loop Setup are displayed as follows: 

 

The Loop Setup sub-screen depends on the selected Loop Type. The default is 

Loop and the sub-screen has a single field: 

Number of times to cycle 

When the experiment is run, it will cycle round the loop the specified number 

of times, implementing all the steps and sub-loops each time round. 

The remaining fields in the Loop Type sub-screen are for setting up scanning 

loops, where the steps use AC amplitude or DC bias levels from the loop. 

 Loop Types, Section 5.9. 
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5.5 DECISION 

 

A decision enables the instrument to optionally run a sequence of steps, from a 

choice of alternatives, depending on the state of the sample at the end of the 

previous step. 

The following schematic shows an example of how a decision might be used.  

 

Figure 5-3 Schematic diagram of decision process 

In this example, the decision is based on the last measurement of an Open Circuit 

step, and there are three possible outcomes, depending on the result: 

• Option 1 is evaluated first, and if the Open Circuit measurement is less than 

2V, the step within the option is performed, in this case Constant Level at 1V. 

• If the Open Circuit measurement is greater than 2V, Option 2 is evaluated, 

and if the result is less than 5V, the steps within the option are performed, in 

this case a Constant Level Impedance step followed by an Open Circuit step. 

• If neither of the conditions are met, because the result is greater than 5V, none 

of the steps in Options 1 or 2 are performed. 

Finally, at the end of the decision process, regardless of the result, the system 

proceeds to the next step in the experiment, which is Constant Level at 10mV. 

Open 

Circuit

?

Constant 

Level 

Impedance

Open 

Circuit

Constant 

Level 10mV

Constant 

Level 1V

Option 1: 

Voltage <2
Option 2: 

Voltage <5

Neither:
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The corresponding structure in ModuLab XM is as follows: 

 

Figure 5-4 Navigation panel corresponding to decision process 

A decision may contain any number of options, each with a set of conditions to be 

tested. The options are performed from top to bottom, first Option 1, then 

Option 2, and so on. As soon as the conditions for an option are fulfilled, the 

steps under that option are performed and then the system goes to the end of the 

decision process, ignoring all further options. 

The conditions to be tested within an option are specified in the Option 

Conditions sub-screen. 

 Decision Option Conditions, Section 5.5.1, based on the Step Termination, 

Section 5.7.3. 

A decision can be added to an experiment, using the drop-down menus associated 

with the items in the usual way. The rules for creating decision structures are as 

follows: 

• A decision can be added under an experiment Setup, a loop, or an existing 

decision option if there is one. 

• A decision has to be preceded by at least one step, somewhere in the 

experiment structure, so that there are measurements on which the decision 

can be based. 

• Decisions can be nested up to eight levels. 

• There has to be at least one step within the structure under each option, 

otherwise it doesn’t do anything. 
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5.5.1 Decision Option Conditions 

 

When you click on a decision option element in the navigation panel, the 

Option Conditions screen is displayed as follows: 

 

This screen specifies a single test to be performed, according to the entries you 

make in the fields, and you can add more tests using the AND / OR buttons. The 

fields and buttons in this screen are described in detail under Step Termination, 

which has similar functionality. 

 Step Termination, Section 5.7.3. 

5.6 STEP 

 

A step defines an excitation signal to be applied to the sample, in terms of a 

voltage or current, and a set of measurements to be taken. A variety of 

different step types are available, divided into the following categories: 

General 

Voltage Waveforms (DC) 

Voltage Controlled Impedance (AC, C-V, Mott-Schottky) 

5.6.1 Add a New Step 

 

When a new experiment is added to a project or folder, it always contains a 

single step called: 

1: Step 

This can be assigned a step type, but you can add new steps to the experiment and 

each of them will be given a sequential number. 

 Add New Experiment, Section 5.2.1. 

 Assign a Step Type, Section 5.6.2. 

Steps can also be added under loops, so that they are repeated according to the 

specified number of cycles. 

To add a step under an experiment Setup or loop, proceed as follows: 

1. Right-click on the experiment Setup or loop to display the drop-down menu 

and select Add New, then Step. An item appears under the experiment Setup 

or loop called: 

n: Step 

The number n depends on the number of items that already exist at the same 

level, which may be steps or loops, and is incremented by 1 for each 

successive addition. 
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The new step will be highlighted in the Navigation Panel, and the system 

displays the categories of step types as follows: 

 

 Step Types, Section 5.8. 

NOTE: It is also possible to add a step by selecting New Step from the 

drop-down menu, instead of Add New, then Step. However, if a 

loop is selected, the step will be added directly under the 

experiment Setup, outside of the loop. 

 Add New in the File menu, Section 2.4.1 and New Step in the 

Experiment menu, Section 2.4.4. 
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5.6.2 Assign a Step Type 

When a new step appears in a project, as part of a new experiment, or because it 

has been added, it has to be given a step type before it can be used. 

To assign a step type, proceed as follows: 

1. Click on the item labelled n: Step in the Navigation Panel (where n is the 

sequential item number), to display the categories of step types. 

 Add a New Step, Section 5.6.1. 

2. Expand the sub-screens to display the step types in the appropriate categories 

as follows: 

 

3. Click on the required step type. An appropriate screen will appear so that you 

can specify the detailed configuration, and the item name will change to the 

chosen step type. 

4. Configure the step as described in the Step Setup (next section). 
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5.7 STEP SETUP 

The screens for each step type are all slightly different, but they have the same 

general layout, in the Step Setup screen as follows: 

 

The main window (to the right of the navigation panel) is divided into two 

sections: 

• The left column is a set of sub-screens that you can expand and collapse, and 

they vary according to the step type. 

• The right column is a set of graphs, for illustration and setup purposes only. 

They also vary according to the step type, but they do not represent any 

actual data. The upper graph shows the excitation waveform and the lower 

graph shows a typical result that might be obtained. 

NOTE: The term Step Setup is used as a generic term in this documentation, 

although it does not appear in the software. Instead, the screens are 

identified by their step type at the top of the column of sub-screens, 

for example Triangular Sweep, as follows: 
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The sub-screens are as follows: 

Comments 

This sub-screen is the same for all step types and enables you to enter a 

comment about the step. 

 

Scan Setup 

This sub-screen specifies values associated with the excitation signal that is 

applied to the sample. The shape of the waveform varies according to the step 

type and there are a number of variations of this sub-screen. 

 Scan Setup, Section 5.8.4 and its sub-sections. 

 Temperature Settling Step, Section 5.9.3.1. 

Impedance Setup 

This sub-screen appears only for step types that use impedance, and specifies 

the frequency range to be tested. 

 Impedance Setup, Section 5.7.1. 

Time Domain Measurement Setup 

This sub-screen specifies how measurements are to be taken during an 

experiment. 

 Time Domain Measurement Setup, Section 5.7.2.  

Step Termination 

This sub-screen specifies the conditions under which the step is terminated, 

using tests on the measured values (voltage, current, etc). 

 Step Termination, Section 5.7.3.  

Instrument Step Setup 

This sub-screen specifies an instrument configuration for the step, including 

the voltage and current range. This setup takes priority over the more general 

Instrument Experiment Setup. 

 Instrument Step Setup, Section 5.7.4, and Instrument Experiment Setup, 

Section 5.3.4.  
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Control Outputs 

This sub-screen operates the Control Outputs on the ModuLab XM rear panel, 

which can be used to control external devices such as heaters, stirrers, flow 

controllers and fans. 

 Control Outputs, Section 5.7.5.  

Graph Setup 

This sub-screen specifies the graphical display of data generated by the step. 

 Graph Setup, Section 5.7.6.  

5.7.1 Impedance Setup 

 

This sub-screen in the Step Setup screen exists only for AC step types. The 

system superimposes a frequency, or a range of frequencies, on top of the DC 

scan that has been specified from the Scan Setup. 
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The fields are: 

Measurement Mode 

This field configures the step to use the Sample and Reference module, according 

to the following options: 

Sample only Measurements are taken from the sample without 

using the Sample and Reference module. 

Sample & Reference Measurements from the sample are compared with 

measurements from known reference capacitors, 

which may be internal or supplied by the user. 

This option should only be used when the 

Experiment Type, in the Hardware Requirements, 

is Sample & Reference, otherwise the following 

error message will appear when you try to run the 

experiment: 

Sample & Reference Measurement Mode can only 
be used in Sample & Reference experiments. 

 Hardware Requirements, Section 5.3.2. 

 The choice between internal and user 

references is made in the Sample Setup, 

Section 5.3.3. 

Technique 

The type of AC stimulus applied to the sample. The options are: 

Single frequency A single sinewave is applied to the sample at a 

fixed frequency. 

Frequency sweep A single sinewave is swept from the start frequency 

to the end frequency. 

Multisine Multiple sinewaves, according to a Fast Fourier 

Transform, are swept from the start frequency to 

the end frequency. 

Amplitude (rms) 

The RMS amplitude of the AC signal, maintained at a fixed level during the step. 

The units are: 

µV 

mV 

V 

The Relative Values field associated with this field contains the following 

options: 

Absolute The value is specified in absolute terms without 

reference to any other values. 

AC Scan Value The value has been specified in the Loop Setup for an 

AC amplitude scanning loop, so that it can be applied 
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to impedance steps within the loop. There is no need 

to specify a value here and the fields will be greyed 

out. 

This option should only be used for a step that is 

inside an AC amplitude scanning loop. 

 Section 5.9.1. 

Frequency 

The frequency of the AC stimulus. If the Technique is Single frequency, this is a 

single field (with a units field). If the Technique is Frequency sweep or Multisine, 

there are two fields representing the Start Frequency and End Frequency of the 

sweep. The following units are available on all frequency fields: 

µHz  

mHz  

Hz  

kHz  

MHz 

ω 

Repeat every 

This field exists only for linear sweeps, including cyclic sweeps such as 

Triangular Sweep, and defines the DC voltage interval for the start of each new 

impedance measurement. 

Start delay 

This field appears for non-linear sweeps, including non-linear cyclic sweeps such 

as Staircase Triangular Sweep, and specifies the delay after every change in DC 

voltage, before an impedance measurement is taken. It also appears in the case of 

Constant Level, and the delay occurs only once, at the beginning. 

Advanced 

The following additional fields appear if this box is checked. 

Auto-integration 

The signal applied to the FRA can be integrated to reject noise. The effect is 

to narrow the measurement bandwidth and thus increase the signal to noise 

ratio.  Integration increases the measurement time, so there is a trade-off 

between the accuracy you require and the measurement speed. 

Auto-integration can be used when there is uncertainty about the degree of 

interference generated by the sample, so that the integration time is adjusted 

automatically to obtain a specified statistical accuracy in the measurement 

result. 

Auto-integration selects an integration time appropriate for the interference 

from the noisiest input, and measurement continues until the standard 

deviation of the input data is reduced to a target value. 
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The options in this field are: 

Off Auto-integration is not applied, and instead you can 

specify an Integration Time. 

Long Aims for a standard deviation of ±1% of reading 

± 0.001 % of full scale on the noisiest input. 

Short Aims for a standard deviation of ± 10 % of reading 

± 0.001 % of full scale on the noisiest input. 

Integration 

When auto-integration is off, this field can be used to specify a fixed 

integration time. The units can be seconds or cycles, and a value in seconds is 

rounded up to cover the nearest number of whole cycles. 

When auto-integration is on (long or short), this field specifies the maximum 

time allowed to reach the required accuracy, although there will always be at 

least three cycles. 

Sweep type 

The method of variation of frequency during the sweep. This field only exists 

when the Technique is Frequency Sweep. The options are: 

Linear 

Logarithmic 

Points 

The number of measurement points during a linear sweep. This field only 

exists when the Technique is Frequency Sweep and the Sweep Type is Linear. 

Points per decade 

The number of measurement points per decade during a logarithmic sweep. 

This field only exists when the Technique is Frequency Sweep and the Sweep 

Type is Logarithmic. 

Harmonics 

This field is available when the Technique is set to Multisine, and the list box 

opens up a dialogue box  where you can specify the stimulus to the sample in 

terms of a list of harmonic frequencies to be added to the fundamental 

frequency. The list of harmonics is returned to the list box as one of the 

following options: 

Pseudo-log 

All 

Custom 

 Impedance Setup - Harmonics, Section 5.7.1.1. 

Measure delay 

A measurement delay can be used in swept sine analyses, to allow the sample 

to stabilise after a frequency change before the next measurement begins. The 

units range from µs to days. This field only exists when the Technique is 

Frequency Sweep or Multisine. 
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V Range 

This field sets the internal voltage range to be used by the FRA. 

The options are: 

Auto 

3mV 

30mV 

300mV 

3V 

I Range 

This field sets the internal range of the FRA when measuring voltages that 

represent a current in the core module. 

The options are: 

Auto 

3mV 

30mV 

300mV 

3V 
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5.7.1.1 Impedance Setup – Harmonics 

In the Impedance Setup, a Harmonics field is available when the Technique is set 

to Multisine, so that you can specify the harmonics to be added to the 

fundamental frequency. 

 Impedance Setup, Section 5.7.1. 

When you click on the Harmonics list box, a dialogue box appears as follows: 

 

There are three radio buttons, and the selected option appears in the list box when 

the dialogue box is closed. There is a text box below the radio buttons, giving the 

list of harmonics associated with the selected option. 

The fields are as follows: 

Pseudo-log 

This radio button selects a list of harmonics which is approximately logarithmic 

over three decades from 1 to 1000. 

All 

This radio button selects the complete set of harmonics from 1 to 1024. 

Custom 

This radio button enables you to create your own harmonics by editing the list. 

(Text box) 

This text box displays the list of harmonics associated with the selected radio 

button. The number 1 is the fundamental frequency, and all the others are 

multiples of the fundamental frequency. 

Measure non-stimulated harmonics 

When this box is checked, the system measures all harmonics generated from the 

sample, regardless of whether or not they belong to the specified list of harmonic 

frequencies. 
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5.7.2 Time Domain Measurement Setup 

 

This sub-screen, in the Step Setup screen, specifies how DC measurements are 

to be taken during an experiment. The available fields depend on the selection 

from the first field as follows: 

Measurement mode 

This field specifies whether measurements are to be taken on a regular basis, or 

when there are changes to the sample excitation. The options, according to the 

step types, are: 

Option Available for step types: Default for step types: 

Periodic All step types Open Circuit 

Run External Program 

Temperature Settle 

Constant Level 

Constant Level Impedance 

V change Open Circuit 

Run External Program 

Temperature Settle 

Linear Sweep Impedance 

Triangular Waveform Impedance 

All DC step types except Constant 
Level 

Linear Sweep 

Triangular Sweep 

Linear Sweep Impedance 

Triangular Waveform Impedance 

I change Run External Program 

Temperature Settle 

All DC step types 

None 

Per pulse Sweep Pulse 

Differential Pulse 

Square Wave 

Pulse 

Sweep Pulse 

Differential Pulse 

Square Wave 

Pulse 

Per step Staircase Linear Sweep 

Staircase Triangular Sweep 

Staircase Linear Sweep 
Impedance 

Staircase Triangular Waveform 
Impedance 

Staircase Linear Sweep 

Staircase Triangular Sweep 

Staircase Linear Sweep Impedance 

Staircase Triangular Waveform 
Impedance 

NOTE: The Time Domain Measurement Setup sub-screen specifies 

Measurement mode options for both AC and DC steps. This is 

because impedance measurements are taken by superimposing a 

frequency on a DC scan. 

 Impedance Setup, Section 5.7.1. 
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The screens for each of these options are as follows: 

• Measurement mode: Periodic 

 

This screen defines how periodic measurements are taken at specified 

intervals. The fields are: 

Integration period 

The integration period for noise reduction purposes. A short period displays a 

detailed response to the waveform, but it may be affected by noise. A longer 

period gives less detail but filters out noise. 

The integration period can be specified in the following units: 

µs per sample  

ms per sample  

s per sample  

Mains cycle The duration of a cycle of the mains power 

supply, based on the Mains Frequency specified 

in the General Settings of the User Preferences 

 Section 4.1.1. 

 

These two buttons set the Integration period to match the Measurement rate 

and vice-versa. 

The Integration period should not exceed the Measurement rate (as a time 

interval). 

Measurement rate 

The rate at which periodic measurements are taken, specified as an interval 

(seconds) or a frequency (per second). 

Cycle selection 

These check boxes select the cycles in which measurements are to be taken in 

a cyclic step such as Triangular Sweep. For non-cyclic steps, these check 

boxes do not appear. The options are: 

All 

Take measurements during all cycles. 
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First 

Take measurements during the first cycle, regardless of whether or not 

All has been checked. 

Last 

Take measurements during the last cycle, regardless of whether or not All 

has been checked. 

Every n 

Take measurements every n cycles, according to the specified value. If 

the First box has been checked, measurements will be taken on the first 

cycle, otherwise the system will wait (n-1) cycles and then take 

measurements on the nth cycle. 

• Measurement mode: V change / I change 

For these measurement modes, the type of Time Domain Measurement Setup 

sub-screen depends on whether or not it is possible to define the measurement 

rate by comparing the amount of change per measurement with the Scan rate 

specified in the Scan Setup sub-screen. For example, the Scan Setup screen 

for a linear sweep and the corresponding Time Domain Measurement Setup 

screen with the Measurement mode set to V change is as follows: 

 

 Linear Sweep I-V Characterisation, Section 5.8.4.7. 

The measurement rate is the Scan rate divided by the Amount of change, and 

in this example it works out at 20 measurements per second. When expressed 

as an interval, this becomes one measurement every 0.05 seconds, and this is 

the maximum Integration period that the system will use. If the specified 

Integration period exceeds this value, the system will ignore it and use the 

calculated maximum. 

This type of calculation can only be performed for step types that have linear 

sweeps, including linear cyclic sweeps such as Triangular Sweep, but 

excluding sweeps where something else is superimposed on a linear scan. For 

example, staircase scans are not suitable for this calculation, even though they 



Software Reference: Project  ModuLab XM MTS Materials Test System: User Guide 

5-38  21006013_AE 

have a Scan rate field in the Scan Setup, because the measurements are 

dependent on the steps. 

If the measurement rate cannot be calculated from the Scan rate and 

Amount of change, it has to be calculated from other values in an expanded 

Time Domain Measurement Setup screen, for voltage or current as follows: 

 

 

In this case, the Maximum rate is the rate at which the system takes 

measurements for internal use, but if multiple measurements occur at similar 

values, they will not be reported until a significant change occurs, defined by 

the Amount of change. In this case, the Integration period should not exceed 

the Maximum rate. 

The fields for the Measurement mode options V change and I change are as 

follows: 

Integration period 

The integration period for noise reduction purposes. The value is limited to 

the calculated measurement rate or the specified Maximum rate, as follows: 

• If the Scan Setup and Measurement mode are suitable for calculation of a 

measurement rate from the Scan rate and Amount of change, the 
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maximum Integration period is limited to the calculated measurement rate 

(expressed as a time interval). 

• If the measurement rate cannot be calculated from a Scan rate and 

Amount of change, the Integration period is limited to the Maximum rate 

(expressed as a time interval). 

In either case, a value of the Integration period that exceeds the limit will be 

ignored. 

 Integration period for Measurement mode: Periodic. 

 

These two buttons set the Integration Period to match the Maximum Rate and 

vice-versa. 

Maximum rate 

The rate at which data points are collected by the system for internal use, 

regardless of whether or not they are reported to the user as measurements. 

All data points are used as measurements when the sample excitation is 

changing rapidly, so the measurement rate becomes the Maximum rate. 

Minimum rate 

The rate at which measurements are taken when the sample excitation does 

not change sufficiently to trigger a measurement (although the system 

continues to collect data for internal use regardless of whether or not they are 

reported as measurements). 

Amount of change 

The change that has to occur in order to trigger a measurement. If there is 

insufficient change, measurements will continue at the Minimum rate. 

Cycle selection 

These check boxes only appear for cyclic steps such as triangular sweep, and 

they are used to select the cycles in which measurements are to be taken. 

 Cycle Selection, in Measurement Mode: Periodic. 

• Measurement mode: Per pulse 

The Time Domain Measurement Setup sub-screen for this Measurement 

mode is as follows: 

 

In this case, measurements are taken when each pulse occurs, and if the pulses 

occur on a changing baseline, an additional measurement will be taken at each 

interval between pulses. 
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There is just one field in this sub-screen (in addition to the Measurement 

mode). 

Integration period 

The integration period for noise reduction purposes. The value must not 

exceed the Pulse width defined in the Scan Setup. 

In addition to the units available for Periodic measurements, this field can be 

specified in the following units: 

% of pulse width 

 Integration period for Measurement mode: Periodic. 

• Measurement mode: Per step 

The Time Domain Measurement Setup sub-screen for this Measurement 

mode is as follows: 

 

In this case, measurements are taken at the beginning and end of each step. 

The fields for this Measurement mode are as follows: 

Integration period 

The integration period for noise reduction purposes. The value must not 

exceed the step width, calculated from the Scan rate and Step, specified in the 

Scan Setup. 

In addition to the units available for Periodic measurements, this field can be 

specified in the following units: 

% of step width 

 Integration period for Measurement mode: Periodic. 

Cycle selection 

These check boxes only appear for cyclic steps such as triangular sweep, and 

they are used to select the cycles in which measurements are to be taken. 

 Cycle selection for Measurement mode: Periodic. 
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5.7.3 Step Termination 

 

This sub-screen in the Step Setup screen specifies the conditions under which 

the step is terminated, using a variety of tests that involve limiting values. The 

default sub-screen contains a single test as follows: 

 

Multiple tests can be performed using the AND / OR buttons so that successive 

IF / AND tests can be placed within OR groups as follows: 

 

There can be a maximum of four IF / AND tests within an OR group, and a 

maximum of four OR groups. The tests and groups are added using the following 

buttons: 

AND 

This button adds a new AND test to the current OR group, up to a maximum 

of four tests including the initial IF test. The button disappears when there are 

four tests in the group. 

OR 

This button adds a new OR group containing a single IF test to which more 

AND tests can be added. There can be a maximum of four OR groups. The 

button disappears from a group when a new group is added, and does not 

appear at all in the fourth group. 
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The fields associated with the tests and results are: 

IF / AND (Test) 

A test is performed on the excitation signal to the sample, giving a result that is 

true or false. 

The test is set up using three fields as follows: 

(variable) 

The variable to be tested is selected from a list box as follows: 

Voltage (V) 

Current (A) 

Time (s) 

Charge (C) 

dV/dt (V/s) 

dI/dt (A/s) 

(operator) 

The operator to be used in the test is selected from the list box as follows: 

>= 

<= 

(value) 

The numeric value to which the variable is compared. 

The following buttons are available alongside the test: 

 Click this button to move the test up to the previous OR group, if there is 

one. 

 Click this button to move the test down to the next OR group, if there is 

one. 

  This button toggles between active (green) and inactive (grey), and the 

test is only performed when the button is active. When a numeric value 

is specified for the test, and the cursor is moved to another field, the 

button automatically becomes active. When the numeric value is 

deleted, and the cursor is moved to another field, the button 

automatically becomes inactive. The default screen has a single test with 

a grey button. 

 Click this button to delete the test. 

Loop exit 

If the step is within a loop, this list box specifies how the step will terminate if the 

test is true. The options are: 

Go to next step Stay within the loop and go to the next step. This 

is the default option. 

Exit from loop Jump out of the loop and go to the next loop if 

there is one, or the next step in the experiment. 
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5.7.4 Instrument Step Setup 

 

This sub-screen in the Step Setup screen defines the Instrument Step Setup, 

taking priority over the more general Instrument Experiment Setup. 

 

 Instrument Experiment Setup, Section 5.3.4. 

The fields are: 

Override experiment settings 

If this box is checked, the values in this screen are applied to the step, and 

override the Instrument Experiment Setup. If the box is not checked, all the fields 

are greyed out. 

Voltage range 

The voltage range of the core module. This field is the same as in the Instrument 

Experiment Setup. 

Current range 

The current range of the core module. This field is the same as in the Instrument 

Experiment Setup. 

Auto range speed 

The speed at which current range changes can occur, for example when the 

measurements pass through zero or the data is noisy. This field is the same as in 

the Instrument Experiment Setup. 

Force recording range changes 

If this box is checked, range numbers will be included in the data regardless of 

their effect on data collection. This field is greyed out and displays the entry from 

the Instrument Experiment Setup. 

Enable Auxiliary Voltage Inputs 

This group of fields determines how the auxiliary channels are to be used in the 

experiment. 

DC 

The four check boxes, A, B, C, D, indicate the auxiliary channels that are 

used for DC measurements from accessories, for example temperature probes. 
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5.7.5 Control Outputs 

 

This sub-screen in the Step Setup screen specifies the control of external 

devices, for example heaters, stirrers, flow controllers and fans. Control is 

limited to switching the devices on and off,  by closing and opening a circuit, 

and does not specify how they will operate. 

 

Each core module has three control outputs, A, B and C, and the options for each 

of them are as follows: 

On The circuit is closed, to turn the device on at the 

beginning of the step, and remains closed throughout the 

whole step. 

Off The circuit is opened, to turn the device off at the 

beginning of the step, and remains open throughout the 

whole step. 

Since the On/Off values apply to the whole step, it will 

be necessary to start a new step every time the external 

device needs to be switched. 

The control outputs are available from D-type connectors on the rear panel. On an 

8-slot chassis, there are two connectors, representing slots 1-4 and 5-8, and the 

three control outputs for each slot are available from the appropriate pins. On a 

4-slot chassis, there is just a single connector. 

 Installation Guide, for details of how to connect external devices to the 

ModuLab XM system. 
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5.7.6 Graph Setup 

 

This sub-screen in the Step Setup screen specifies the graphical layout of data 

generated by the step. 

 

The fields are: 

Override settings from User Preferences 

If this box is checked, the values specified in this screen will be used for graphs 

generated by the step. Otherwise, the graphs will conform to the defaults for the 

step type, defined in the Graph Preferences sub-screen in the User Preferences. 

 Graph Preferences, Section 4.1.3. 

Graph 1, Graph 2 

These two fields represent the two graphs that appear in the Data screen when the 

experiment is run and results are obtained. 

 Data, Section 5.10. 

When a selection is made from these fields, a number of other fields appear 

representing the configuration of the axes as follows: 

 

These are described in detail in the Layout of Graphic Displays. 

 Section 5.11.1. 
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5.8 STEP TYPES 

 

When you add a step, you have to make a selection from a list of step types, 

arranged in categories which are available from a set of collapsed sub-screens 

as follows: 

 

The sub-screens can be expanded to display the appropriate step types, and then 

when you have completed the addition you can configure the step. 

 Add a New Step, Section 5.6.1 

 Step Setup, Section 5.7. 

The following sub-sections describe the categories of step types. 

  General, Section 5.8.1. 

  Voltage Waveforms (DC), Section 5.8.2. 

  Voltage Controlled Impedance (AC, C-V, Mott-Schottky), Section 

5.8.3. 

 The Scan Setup screens associated with the step types are described in 

Section 5.8.4. 

5.8.1 General 

 

The list of step types which appears when adding a step contains the General 

category as follows: 

 

 Add a New Step, Section 5.6.1 

.  
Open Circuit. The generator is disconnected from the sample and 

voltage measurements are taken. Open circuit experiments are typically 

used for checking voltage decay (or voltage hold) after a sample has 

been polarized to a particular voltage. 
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Run External Program. An external program can be run while a step 

is in progress. For example, it might be necessary to run some external 

equipment such as a multiplexer or temperature controller. 

 Section 5.8.4.15. 

NOTE: The Temperature Settling step also belongs to the General category, 

but it does not appear in the list of step types because it cannot be 

added to an experiment Setup in the usual way. Instead it appears 

automatically in a temperature scanning loop. 

 Temperature Settling Step, Section 5.9.3.1. 

5.8.2 Voltage Waveforms (DC) 

 

DC Voltage Waveforms are applied to an experiment by stimulating the 

sample with a signal from the generator. 

The step types in this category, which appear when adding a step, are shown in 

the following sub-screen: 

 

 Add a New Step, Section 5.6.1 

In these step types, the voltage from the generator follows a specified waveform 

as follows: 

 
Constant Level. The voltage is held at a constant value for a specified 

time period. 

 Section 5.8.4.5. 
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Linear Sweep I-V Characterisation. There is a linear scan of voltage 

between two limits. 

 Section 5.8.4.7. 

 
Triangular Sweep I-V Characterisation. There is a cyclic linear scan 

of voltage between two limits. 

 Section 5.8.4.8. 

 
Staircase Linear Sweep. There is a scan of voltage between limits, 

according to a step function. 

 Section 5.8.4.9. 

 
Staircase Triangular Sweep. There is a scan of voltage between limits, 

according to a step function, but the direction is periodically reversed, 

creating a cyclic waveform. 

 Section 5.8.4.10. 

 
Pulse. There is a series of pulses of voltage, of constant amplitude. 

 Section 5.8.4.11. 

 
Sweep Pulse. There is a series of pulses of varying voltage, so that each 

pulse differs from the previous one by a specified step. 

 Section 5.8.4.12. 

 
Differential Pulse. There is a scan of voltage between limits, according 

to a step function, but a pulse is added to each step. 

 Section 5.8.4.13. 

 
Square Wave. There is a scan of voltage between limits, according to a 

step function, but a square wave is superimposed on each step. 

 Section 5.8.4.14. 

 
Any combination of the above tests may be used to create arbitrary 

waveforms that include sweeps, steps, constant levels and pulses. 
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5.8.3 Voltage Controlled Impedance (AC, C-V, Mott-Schottky) 

 

Voltage Controlled Impedance is applied to an experiment by adding an 

alternating voltage to a sample that is already stimulated with DC voltage 

waveforms, and applying a range of frequencies. An FRA is required to 

supply the alternating voltage, and the frequency range is defined in the 

Impedance Setup sub-screen. 

 Impedance Setup, Section 5.7.1. 

The step types in this category, which appear when adding a step, are shown in 

the following sub-screen: 

 

 Add a New Step, Section 5.6.1 

In these step types, the voltage from the generator follows a specified DC 

waveform, and an alternating voltage is superimposed on it to provide impedance 

measurements. The step types are as follows: 

 
Constant Level Impedance. The DC voltage is held at a constant value. 

 Section 5.8.4.6. 

 
Linear Sweep Impedance. The DC voltage follows a linear variation 

between two limits.  

 Section 5.8.4.7. 

 
Triangular Sweep Impedance. The DC voltage follows a cyclic linear 

scan between two limits.  

 Section 5.8.4.8. 

 
Staircase Linear Sweep Impedance. The DC voltage follows a step 

function. 

 Section 5.8.4.9. 

 
Staircase Triangular Sweep Impedance. The DC voltage follows a 

step function which periodically reverses.  

 Section 5.8.4.10. 
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NOTE: The complete step names, including the word “Impedance” are in the 

left-hand navigation panel. 

5.8.4 Scan Setup 

 

When you configure a step, as described in the Step Setup, you have to fill in a 

set of sub-screens which may vary according to the step type. 

 Step Setup, Section 5.7. 

The Scan Setup sub-screen defines the output signal to the sample, and varies 

according to the shape of the waveform (linear sweep, triangular, staircase, etc.) 

The following sub-sections describe general considerations that apply to all 

output signals to the sample: 

 Relative Values, Section 5.8.4.1. This specifies how a voltage is defined as 

the difference between two values. 

 Units, Section 5.8.4.2. These may have to be specified for duration, level, 

scan rate and frequency. 

 Voltage Compensation for Output Impedance, Section 5.8.4.3. The voltage 

output to the sample has to take into account the impedance of the module. 

The following sub-sections describe all the variations of the Scan Setup sub-

screen: 

 Open Circuit, Section 5.8.4.4. 

 Constant Level DC Measurement, Section 5.8.4.5.  

 Constant Level Impedance, Section 5.8.4.6.  

 Linear Sweep, Section 5.8.4.7.  

 Triangular Sweep, Section 5.8.4.8.  

 Staircase Linear Sweep, Section 5.8.4.9.  

 Staircase Triangular Sweep, Section 5.8.4.10.  

 Pulse, Section 5.8.4.11.  

 Sweep Pulse, Section 5.8.4.12.  

 Differential Pulse, Section 5.8.4.13.  

 Square Wave, Section 5.8.4.14. 

 Temperature Settle, within Temperature Loop, Section 5.9.3.1. 

5.8.4.1 Relative Values 

Voltage is always defined as a difference between two values, although it is 

normally only necessary to specify one value against an arbitrary base value, for 

example ground. 

Most of the Scan Setup sub-screens have fields where a voltage has to be 

specified, and an additional list box is available in case a specific base value is 

required. For example, in the screen for Constant Level Impedance, a DC voltage 

level can be specified relative to the end of the previous step is as follows: 
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Alongside the value and units fields, there is a list box with the following options: 

vs. Open Circuit The value is specified relative to the open circuit 

voltage of the sample, measured at the end of the last 

open circuit step. For example, if a sample generates 

1.5V in open circuit, and you specify a voltage of 1V, 

the overall voltage will be 2.5V. 

When this option is selected, it is recommended that 

the previous step should be open circuit, because open 

circuit potential is only measured during an open 

circuit step, and at the beginning of the experiment. 

Absolute The value is specified in absolute terms without 

reference to any other values. 

vs. Previous The value is specified relative to the voltage measured 

at the end of the previous step. 

DC Scan Value Only applicable to steps within DC bias scanning 

loops. 

 DC Bias Scanning Loop, Section 5.9.2 and Scan 

Setup for DC Bias Scanning Loop, Section 

5.9.2.1. 

This list box does not appear in fields where a change of voltage is being 

specified, for example a pulse or step. 

5.8.4.2 Units 

The same units are generally available for similar fields that occur repeatedly 

throughout the Scan Setup sub-screens as follows: 

Duration 

µs 

ms 

s 

Minute 

Hour 

Day 

Level 

µV 

mV 

V 

Scan rate 

µV/s  

mV/s  
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V/s  

kV/s  

MV/s  

Frequency 

µHz  

mHz  

Hz  

kHz  

MHz 

ω 

5.8.4.3 Voltage Compensation for Output Impedance 

The voltage output from a module is applied across two impedances: 

• The impedance of the sample. 

• The impedance of the module that supplies the generator output to the 

sample. These are: 

Module Output Impedance 

Materials Core Module 50Ω 

High Voltage Module 50Ω 

2A Booster <1Ω 

Femto Ammeter Not applicable, used for measurement only. 
Generator signal to sample is applied from 
core module, HV module or booster. 

Sample and Reference Module Not applicable, uses generator output from 
core module or HV module. 

In cases where the output impedance of the module constitutes a significant 

proportion of the total impedance, the voltage levels specified in the Scan Setup 

screen have to be increased to account for it, but the measured results are based 

on the voltage that is actually applied to the sample. 

For example, if a 2A booster with 0.4Ω output impedance is connected to a 

sample with 0.1Ω resistance (as in the ModuLab XM MTS 0.1Ω Test Unit), and a 

voltage level of 800mV is specified in the Scan Setup screen, the voltage will be 

split between 640mV for the module and 120mV for the sample. However, the 

measurements will be based on the voltage applied to the sample, so that a value 

of 120mV will appear in the results. 

5.8.4.4 Open Circuit 

For open circuit experiments, the Scan Setup sub-screen which appears in the 

Step Setup is as follows: 

 

 Step Setup, Section 5.7. 
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The following step type uses this sub-screen: 

Step Type Category 

Open Circuit General 

There is a single field as follows: 

Duration 

The time period for the scan. 

5.8.4.5 Constant Level  DC Measurement 

In this step type, the sample is maintained at a constant voltage for a specified 

time period. The Scan Setup sub-screen which appears in the Step Setup is as 

follows: 

 

 Step Setup, Section 5.7. 

The following step type uses this sub-screen: 

Step Type Category 

Constant Level Voltage Waveforms (DC) 

The fields are as follows: 

Duration 

The time period for the scan. 

Level 

The constant voltage at which the sample is maintained, relative to an 

appropriate base value. 

 Relative Values, Section 5.8.4.1. 

5.8.4.6 Constant Level Impedance 

In this step type, the sample is maintained at a constant DC voltage and a 

frequency is applied. The Scan Setup sub-screen which appears in the Step Setup 

is as follows: 

 

 Step Setup, Section 5.7. 
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The following step type uses this sub-screen: 

Step Type Category 

Constant Level Impedance Voltage Controlled Impedance 

There is a single field are as follows: 

DC Level 

The constant level at which the sample is maintained, relative to an 

appropriate base value. 

 Relative Values, Section 5.8.4.1. 

NOTE: A duration is not specified because it is defined by the 

Impedance Setup. The scan terminates at the end of the sweep, 

or at the end of the integration time in the case of a Single 

Frequency step. 

 Impedance Setup, Section 5.7.1. 

5.8.4.7 Linear Sweep 

In this step type, the sample follows a waveform with a linear variation of voltage 

between two limits. 

 

time

Voltage Linear Sweep I-V Characterisation

End 

voltage

Start 

voltage

Scan rate
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The corresponding Scan Setup sub-screen which appears in the Step Setup is as 

follows: 

 

 Step Setup, Section 5.7. 

The following step types use this sub-screen: 

Step Type Category 

Linear Sweep I-V Characterisation Voltage Waveforms (DC) 

Linear Sweep Impedance Voltage Controlled Impedance 

The voltage levels are specified relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 

The fields are: 

Start level 

The voltage level at which the scan begins. 

End level 

The voltage level at which the scan ends. 

Scan rate 

The constant rate of change of voltage, between the start and end voltage. 



Software Reference: Project  ModuLab XM MTS Materials Test System: User Guide 

5-56  21006013_AE 

5.8.4.8 Triangular Sweep 

In this step type, the sample follows a waveform with a cyclic linear scan of 

voltage between two limits as follows: 

 

The corresponding Scan Setup sub-screen which appears in the Step Setup is as 

follows: 

 

 Step Setup, Section 5.7. 

The following step types use this sub-screen: 

Step Type Category 

Triangular Sweep I-V 

Characterisation 

Voltage Waveforms (DC) 

Triangular Sweep Impedance Voltage Controlled Impedance 

The voltage levels are specified relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 

time

Voltage Triangular Sweep I-V Characterisation

1st vertex 

voltage

2
nd

  vertex 

voltage

End 

voltage

Start 

voltage

Cycle 1 Last Cycle 

Scan rate

Cycle 2 … (n-1)
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The fields are: 

Start level 

This field consists of a check box and a numeric value. If the box is checked, 

the field specifies the voltage level at which the scan begins during the first 

half of a cycle before it reverses direction. 

If the box is not checked, the scan begins at the 1st vertex level. 

The check box affects the 1st and 2nd vertex level fields as follows: 

• If the box is checked, the 1st vertex level represents the mid-point of a 

cycle where the scan direction is reversed, and the 2nd vertex level will 

be at the start and end point of each cycle. 

• If the box is not checked, the 1st vertex level represents the start and end 

point of each cycle, and the 2nd vertex level represents the mid-point of a 

cycle where the scan direction is reversed. 

The specified start level should not be outside the range of the 1st and 2nd 

vertex levels. 

1st / 2nd vertex levels 

These two fields specify the voltage levels at the vertices of the triangular 

sweep. One field represents the start and end point of each cycle, while the 

other field represents the mid-point of a cycle, depending on whether or not 

the Start Level box has been checked. 

End level 

This field consists of a check box and a numeric value. If the box is checked, 

the field specifies the voltage level at which the scan ends during the second 

half of the last cycle, after it has reversed direction. 

If the box is not checked, the scan ends on completion of the last cycle. 

The specified end level should not be outside the range of the 1st and 2nd 

vertex levels. 

Scan rate 

The constant absolute rate of change of voltage as it rises and falls between 

the two vertices. The scan may start in the direction of increasing or 

decreasing voltage, depending on how the start level and vertex fields have 

been set. 

No. of cycles 

The number of cycles to be fully or partially completed. 
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5.8.4.9 Staircase Linear Sweep 

In this step type, the sample follows a waveform with a voltage that varies 

according to a linear step function. 

 

The corresponding Scan Setup sub-screen which appears in the Step Setup is as 

follows: 

 

 Step Setup, Section 5.7. 

The following step types use this sub-screen: 

Step Type Category 

Staircase Linear Sweep Voltage Waveforms (DC) 

Staircase Linear Sweep Impedance Voltage Controlled Impedance 

Voltages in this sub-screen are specified relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 

The fields are: 

Start level 

The voltage at which the scan begins. 

time

Voltage Staircase Linear Sweep

End 

voltage

Start 

voltage

Step

Sample

Scan 

Rate
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End level 

The voltage at which the scan ends. 

Scan rate 

The constant rate of change of voltage, between the start and end level, 

defining the linear scan on which the staircase is superimposed. 

Step 

The voltage level of each step that is superimposed on the linear scan. 

5.8.4.10 Staircase Triangular Sweep 

In this step type, the sample follows a waveform with a voltage that varies 

according to a cyclic step function. 

 

The corresponding Scan Setup sub-screen which appears in the Step Setup is as 

follows: 

 

 Step Setup, Section 5.7. 

time
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The following step types use this sub-screen: 

Step Type Category 

Staircase Triangular Sweep Voltage Waveforms (DC) 

Staircase Triangular Sweep Impedance Voltage Controlled Impedance 

Voltages in this sub-screen are specified relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 

The fields are: 

Start level 

This field consists of a check box and a numeric value. If the box is checked, 

the field specifies the voltage level at which the scan begins during the first 

half of a cycle before it reverses direction. 

If the box is not checked, the scan begins at the 1st vertex level. 

The check box affects the 1st and 2nd vertex level fields as follows: 

• If the box is checked, the 1st vertex level represents the mid-point of a 

cycle where the scan direction is reversed, and the 2nd vertex level will 

be at the start and end point of each cycle. 

• If the box is not checked, the 1st vertex level represents the start and end 

point of each cycle, and the 2nd vertex level represents the mid-point of a 

cycle where the scan direction is reversed. 

The specified start level should not be outside the range of the 1st and 2nd 

vertex levels. 

1st / 2nd vertex levels 

These two fields specify the voltage levels at the vertices of the triangular 

sweep. One field represents the start and end point of each cycle, while the 

other field represents the mid-point of a cycle, depending on whether or not 

the Start Level box has been checked. 

End level 

This field consists of a check box and a numeric value. If the box is checked, 

the field specifies the voltage level at which the scan ends during the second 

half of the last cycle, after it has reversed direction. 

If the box is not checked, the scan ends on completion of the last cycle. 

The specified end level should not be outside the range of the 1st and 2nd 

vertex levels. 

Scan rate 

The constant absolute rate of change of voltage as it rises and falls between 

the two vertices. The scan may start in the direction of increasing or 

decreasing voltage, depending on how the start level and vertex fields have 

been set. 
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Step 

The voltage of each step that is added to the rising scan, or subtracted from 

the falling scan. 

No. of cycles 

The number of cycles to be fully or partially completed. 

5.8.4.11 Pulse 

In this step type, the sample is stimulated with a series of voltage pulses of 

constant amplitude above a base level. 

 

The corresponding Scan Setup sub-screen which appears in the Step Setup is as 

follows: 

 

 Step Setup, Section 5.7. 
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The following step type uses this sub-screen: 

Step Type Category 

Pulse Voltage Waveforms (DC) 

The fields are: 

Duration 

The duration of the scan, until it terminates. 

Base level 

The voltage between pulses, specified relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 

Pulse amplitude 

The voltage level of each pulse, relative to the Base Level. 

Pulse period 

The time period between successive pulses. This is made up of the interval 

between pulses followed by the pulse width. 

Pulse width 

The duration of each pulse, excluding the interval between pulses. 

5.8.4.12 Sweep Pulse 

In this step type, the sample follows a waveform with a series of pulses of varying 

voltage, so that each pulse differs from the previous one by a specified step. 
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The corresponding Scan Setup sub-screen which appears in the Step Setup is as 

follows: 

 

 Step Setup, Section 5.7. 

The following step type uses this sub-screen: 

Step Type Category 

Sweep Pulse Voltage Waveforms (DC) 

Voltages in this sub-screen are specified relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 

The fields are: 

Base level 

The voltage during the interval between pulses. 

Start level 

The voltage of the first pulse. 

End level 

The terminating voltage, so that the scan ends after a pulse has exceeded this 

value. 

Step 

The voltage of each successive pulse, relative to the previous pulse. 

Pulse period 

The time period between successive pulses. This is made up of the interval 

between pulses (when the voltage is at the base value), followed by the pulse 

width. 

Pulse width 

The duration of each pulse, excluding the interval between pulses. 
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5.8.4.13 Differential Pulse 

In this step type, the sample follows a waveform with a voltage that varies 

according to a step function, but a pulse is added at the entry to each step. 

 

The corresponding Scan Setup sub-screen which appears in the Step Setup is as 

follows: 

 

 Step Setup, Section 5.7. 

The following step type uses this sub-screen: 

Step Type Category 

Differential Pulse Voltage Waveforms (DC) 

Voltages in this sub-screen are specified relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 
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The fields are: 

Start level 

The voltage that precedes the first pulse, before any steps have been added. 

End level 

The terminating voltage, so that the scan ends after a pulse has occurred, 

beginning with a voltage that exceeds this value. 

Step 

The change in voltage at the entry to each successive pulse, relative to the 

previous pulse. 

Pulse amplitude 

The voltage of each pulse, as it rises above the level at the entry to the pulse. 

Pulse period 

The time period between successive pulses. This is made up of the interval 

between pulses (when the voltage is at the entry level), followed by the pulse 

width. 

Pulse width 

The duration of each pulse, excluding the interval between pulses. 

5.8.4.14 Square Wave 

In this step type, the sample follows a waveform with a voltage that varies 

according to a step function, but a square wave is superimposed on each step. 
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The corresponding Scan Setup sub-screen which appears in the Step Setup is as 

follows: 

 

 Step Setup, Section 5.7. 

The following step type uses this sub-screen: 

Step Type Category 

Square Wave Voltage Waveforms (DC) 

Voltages in this sub-screen are specified relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 

The fields are: 

Start level 

The starting voltage of the step function, before the squarewave has been 

added. 

End level 

The terminating voltage, so that the scan ends after a squarewave has 

occurred on a step that exceeds this value. 

Step 

The voltage of each successive step, relative to the previous one. 

Pulse amplitude 

The amplitude of the squarewave, above and below the step. 

Pulse Frequency 

The frequency of the squarewave, consisting of the upper and lower sections, 

superimposed on its corresponding step. 
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5.8.4.15 Run External Program 

This step type runs an external program, for example to control a multiplexer so 

that a single instrument group can take sequential measurements from multiple 

samples. 

This step type is available in the General category in the Scan Setup sub-screen 

which appears in the Step Setup is as follows: 

 

 Step Setup, Section 5.7. 

The fields are: 

Program to run 

The full pathname of the program to be run (or the file to be opened, causing a 

program to run), while this step is running. 

Find 

Use this button to navigate the filing system to find the program or file. 

Parameter 

Any command line parameters that need to be appended to the program or 

filename. 

Special 

This button adds the following characters to the Parameter field, which have a 

special meaning in ModuLab XM: 

^L Loop iteration. If the step is within a loop, this represents the 

iteration number (1, 2, etc.) 

^S Step ID. This represents the step number, when this step is 

placed alongside other steps at the same level. If the step is 

within a loop, or a set of nested loops, the Step ID will consist 

of a pair of numbers for each level of looping, followed by the 

step number at the bottom level. For example, 1.2.3.4.5 means 

the second time round the first step (which is a loop) at the top 

level, and the fourth time round the third step (which is a loop) 

at the next level, and this step is fifth in the loop. 

^^ This represents a single ^ character, in case it is needed as a 

normal command line parameter. 
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While running 

This represents the signal to be applied to the sample while the step is running. 

The options are: 

Open circuit 

Constant Voltage 

 Sections 5.8.4.4 and 5.8.4.5. 

Open Circuit / Voltage 

This field has the appropriate title, depending on the selection from the previous 

field, and represents the signal level as follows: 

Open circuit The field is greyed out because no signal is applied. 

Voltage Specify a voltage signal in the appropriate units, 

relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 

Wait for program to end? 

If this box is checked, the step continues running until the program has ended or 

the Timeout has been reached. If the step has to terminate because the Step 

Termination conditions have been reached, the program will stop. 

 Step Termination, Section 5.7.3. 

If the box is not checked, the step terminates when the program starts. It takes 

about one second to detect that the program has started. 

Timeout 

If the Wait for program to end box has been checked, this field specifies the 

maximum amount of time that the step continues running while waiting for the 

program to end. 
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5.9 LOOP TYPES 

 

When a loop is selected from the left-hand navigation panel, a selection of 

Loop Types and their corresponding Loop Setup sub-screens appears as 

follows: 

 

The Loop Types are as follows: 

Loop 

This is the standard loop where the corresponding Loop Setup contains a single 

field: 

Number of times to cycle 

When the experiment is run, it will cycle round the loop the specified number 

of times, implementing all the steps and sub-loops each time round the cycle. 

Scan Impedance AC Amplitude 

The loop contains a list of AC voltage amplitude levels and performs a cycle for 

each entry in the list. Each impedance step within the loop may optionally use the 

amplitude from the loop, or its own amplitude defined within the step. 

 Sections 5.9.1 and 5.9.1.1. 

Scan DC / Impedance Bias Level 

The loop contains a list of DC bias levels and performs a cycle for each entry in 

the list. Each constant level DC or impedance step within the loop may optionally 

use the DC bias from the loop, or its own bias defined within the step. 

 Sections 5.9.2 and 5.9.2.1. 

Scan Temperature 

The loop contains a list of temperatures and performs a cycle for each entry in the 

list. Each cycle begins with a temperature settling step followed by any additional 

steps with the sample at the required temperature. 

 Sections 5.9.3 and 5.9.3.1. 
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NOTE: All loop types, including scanning loops, can be nested at multiple 

levels. In the case of scanning loops, the steps underneath them will 

take values from the nearest appropriate parent. If a temperature loop 

is included, it should normally be the outer loop so that the sample 

can reach the specified temperature. 

5.9.1 AC Amplitude Scanning Loop 

 

When a loop is selected from the left-hand navigation panel, and Scan 

Impedance AC Amplitude is selected from the Loop Type sub-screen, the loop 

can be configured to perform one cycle for each entry in a list of AC 

amplitude voltage levels. The specified amplitude is applied to each 

impedance step within the loop, but only if AC scan value has been selected 

from the Impedance Setup. 

 Impedance Setup for AC Amplitude Scanning Loop, Section 5.9.1.1. 

The Loop Setup sub-screen for this loop type is as follows: 

 

The fields at the left of this sub-screen are used to generate the list of AC 

amplitudes at the right, which can then be directly edited, in case specific values 

are required. The fields are: 

Scan AC amplitude between 

If this radio button is selected, the interval between two AC voltage amplitudes is 

divided into a series of values. The fields under this button are: 

Start 

The AC amplitude to be applied on the first cycle round the loop. 

End 

The AC amplitude to be applied during the last cycle round the loop. 

Step 

The change of AC amplitude between successive cycles, until the End value 

is reached. 

If this radio button is selected, the Points / decade and Total Points fields will 

be greyed out but will display appropriate values. If a value is specified in this 

field, the Total Points field will be recalculated, giving the points required 

between the Start and End values. 
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Points / decade 

The number of values to be applied at logarithmic intervals during each 

decade of AC amplitude change. 

If this radio button is selected, the Step and Total Points fields will be greyed 

out but will display appropriate values. If a value is specified in this field, the 

Total Points field will be recalculated, giving the points required between the 

Start and End values. 

Total Points 

The number of values to be applied between the Start and End values. 

If this radio button is selected, the Step and Points / decade fields will be 

greyed out but will display appropriate values. If a value is specified in this 

field, the Step field will be recalculated, giving the change of amplitude 

between successive cycles. 

Repeat for each AC amplitude (mV) 

This radio button enables the list of AC amplitudes underneath it to be directly 

edited, in case specific values are required. Otherwise, the list is greyed out and 

contains the values calculated from the fields on the left. 

New values can be typed or pasted in, separated by any of the following 

delimiters: 

Tab 

Space 

New line 

Semi-colon (;) 

Comma (,) unless it is used as the decimal separator character. 

When the screen is re-displayed, the delimiters will be converted to line breaks so 

that each value appears on a new line. 
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5.9.1.1 Impedance Setup for AC Amplitude Scanning Loop 

An impedance step under an AC amplitude scanning loop can be optionally 

configured to take its amplitude from the loop as follows: 

1. Click on the step, in the left-hand navigation panel, to display the sub-screens 

for the step configuration. 

2. In the Impedance Setup sub-screen, set the Amplitude (rms) field to AC scan 

value as follows: 

 

The fields for entering the value and units have become greyed out because the 

step takes its amplitude from the loop. 

NOTE: AC scan value should only be specified for a step that is inside an AC 

amplitude scanning loop, otherwise the experiment will not run. 

NOTE: Any step type may be included in an AC amplitude scanning loop, but 

only impedance steps can take values from the loop. DC steps will 

use their own specified voltage levels. 
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5.9.2 DC Bias Scanning Loop 

 

When a loop is selected from the left-hand navigation panel, and Scan DC / 

Impedance Bias Level is selected from the Loop Type sub-screen, the loop 

can be configured to perform one cycle for each entry in a list of DC bias 

voltage levels. The specified bias is applied to each constant level DC or 

impedance step within the loop, but only if DC scan value has been selected 

from the Scan Setup. 

 Scan Setup for DC Bias Scanning Loop, Section 5.9.2.1. 

The Loop Setup sub-screen for this loop type is as follows: 

 

The fields at the left of this sub-screen are used to generate the list of AC 

amplitudes at the right, which can then be directly edited, in case specific values 

are required. The fields are: 

Voltages are: 

This field applies to all the voltage fields in this sub-screen, so that they can be 

defined relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1, but special considerations apply to the 

following: 

vs. Previous This refers to the last step before the loop, not the 

previous step within the loop. 

vs. Open circuit This refers to the most recent open circuit step, even if 

it is within the loop. 

Scan DC bias level between 

If this radio button is selected, the interval between two DC bias voltages is 

divided into a series of values. The fields under this button are: 

Start 

The DC bias to be applied on the first cycle round the loop. 

End 

The DC bias to be applied on the last cycle round the loop. 
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Step 

The change of DC bias between successive cycles, until the End value is 

reached. 

If this radio button is selected, the Points / decade and Total Points fields will 

be greyed out but will display appropriate values. If a value is specified in this 

field, the Total Points field will be recalculated, giving the points required 

between the Start and End values. 

Points / decade 

The number of values to be applied at logarithmic intervals during each 

decade of DC bias change. 

If this radio button is selected, the Step and Total Points fields will be greyed 

out but will display appropriate values. If a value is specified in this field, the 

Total Points field will be recalculated, giving the points required between the 

Start and End values. 

Total Points 

The number of values to be applied between the Start and End values. 

If this radio button is selected, the Step and Points / decade fields will be 

greyed out but will display appropriate values. If a value is specified in this 

field, the Step field will be recalculated, giving the change of DC bias 

between successive cycles. 

Repeat for each DC bias level (V) 

This radio button enables the list of DC bias levels underneath it to be directly 

edited, in case specific values are required. Otherwise, the list is greyed out and 

contains the values calculated from the fields on the left. 

New values can be typed or pasted in, separated by any of the following 

delimiters: 

Tab 

Space 

New line 

Semi-colon (;) 

Comma (,) unless it is used as the decimal separator character. 

When the screen is re-displayed, the delimiters will be converted to line breaks so 

that each value appears on a new line. 
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5.9.2.1 Scan Setup for DC Bias Scanning Loop 

A constant level DC or impedance step under a DC bias scanning loop can be 

optionally configured to take its DC level from the loop as follows: 

1. Click on the step, in the left-hand navigation panel, to display the sub-screens 

for the step configuration. 

2. In the Scan Setup sub-screen, set the Level, or DC Level field to DC scan 

value as follows: 

 

The fields for entering the value and units have become greyed out because the 

step takes its DC bias level from the loop. 

NOTE: DC scan value should only be specified for a step that is inside a DC 

bias scanning loop, otherwise the experiment will not run. 

NOTE: Any step type may be included in a DC bias scanning loop, but only 

constant level DC or impedance steps can take values from the loop, 

otherwise the Scan Setup sub-screen does not contain the option to 

select DC scan value, and the step uses its own specified voltage 

level. 
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5.9.3 Temperature Loop 

 

When a loop is selected from the left-hand navigation panel, and Scan 

Temperature is selected from the Loop Type sub-screen, the loop can be 

configured to perform one cycle for each entry in a list of temperatures. A 

Temperature Settling step is automatically inserted as the first step in the loop, 

and the experiment will generally remain within this step until the sample has 

reached the specified temperature. 

 Temperature Settling Step, Section 5.9.3.1. 

The Loop Setup sub-screen for this loop type is as follows: 

 

The fields at the left of this sub-screen are used to generate the list of 

temperatures at the right, which can then be directly edited, in case specific 

values are required. The fields are: 

Scan Temperature between 

If this radio button is selected, the interval between two temperatures is divided 

into a series of values. The fields under this button are: 

Start 

The temperature to be applied on the first cycle round the loop. 

End 

The temperature to be applied during the last cycle round the loop. 

Step 

The change of temperature between successive cycles, until the End value is 

reached. 

If this radio button is selected, the Points / decade and Total Points fields will 

be greyed out but will display appropriate values. If a value is specified in this 

field, the Total Points field will be recalculated, giving the points required 

between the Start and End values. 

Points / decade 

The number of values to be applied at logarithmic intervals during each 

decade of temperature change (in K so that the lower end of the scale 

approaches zero). 
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If this radio button is selected, the Step and Total Points fields will be greyed 

out but will display appropriate values. If a value is specified in this field, the 

Total Points field will be recalculated, giving the points required between the 

Start and End values. 

Total Points 

The number of values to be applied between the Start and End values. 

If this radio button is selected, the Step and Points / decade fields will be 

greyed out but will display appropriate values. If a value is specified in this 

field, the Step field will be recalculated, giving the change of temperature 

between successive cycles. 

Repeat for each Temperature (°C) 

This radio button enables the list of temperatures underneath it to be directly 

edited, in case specific values are required. Otherwise, the list is greyed out and 

contains the values calculated from the fields on the left. 

New values can be typed or pasted in, separated by any of the following 

delimiters: 

Tab 

Space 

New line 

Semi-colon (;) 

Comma (,) unless it is used as the decimal separator character. 

When the screen is re-displayed, the delimiters will be converted to line breaks so 

that each value appears on a new line. 

5.9.3.1 Temperature Settling Step 

When a loop is selected from the left-hand navigation panel, and Scan 

Temperature is selected from the Loop Type sub-screen, a Temperature Settling 

step appears as the first step within the loop, above any other steps that may 

already exist. If a new temperature scanning loop is being added, there will be a 

Temperature Settling step followed by a single undefined step as follows: 

1: Temperature Settle 

2: Step 

You can click on the undefined step and give it any step type. 

The Temperature Settling step belongs to the General category, and the default 

graph types can be specified from the Graph Preferences, but it does not appear in 

the list of step types when adding a new step. A Temperature Settling step cannot 

be added to an experiment Setup in the usual way. It can only exist within a 

temperature scanning loop, where it appears automatically. 

 Graph Preferences, Section 4.1.3. 

 Step Types, General, Section 5.8.1. 

When you click on a Temperature Settling step in the left-hand navigation panel, 

a Step Setup screen appears with all the appropriate sub-screens, which can be 

configured to take measurements in the usual way. 
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 Step Setup, Section 5.7. 

The Scan Setup sub-screen for a Temperature Settling step is as follows: 

 

The fields are: 

While running 

This represents the signal to be applied to the sample while the step is running. 

The options are: 

Open circuit 

Constant Voltage 

 Sections 5.8.4.4 and 5.8.4.5. 

Open Circuit / Voltage 

This field has the appropriate title, depending on the selection from the previous 

field, and represents the signal level as follows: 

Open circuit The field is greyed out because no signal is applied. 

Voltage Specify a voltage signal in the appropriate units, 

relative to an appropriate base value. 

 Relative Values, Section 5.8.4.1. 

Wait for Temperature to reach set point? 

If this box is checked, the step continues running until the sample reaches the 

temperature specified for the current cycle of the loop. If the sample fails to reach 

the specified temperature, the step will continue until it reaches the specifed 

Timeout. 

If the box is not checked, the step will not wait for the temperature to be reached 

and will continue to the next step in the loop. In that case, the loop behaves the 

same as a standard loop, with one cycle for each specified temperature, and the 

sample progresses toward the temperature during the remaining steps in the loop. 

This box effectively gives you the choice to run the loop with or without 

temperature scanning. 

NOTE: The temperature is considered to have reached the set point when the 

latest measurement is within a specified tolerance value of the set 

point, or when a collection of the latest measurements has a standard 

deviation below a specified value. The temperature may be measured 

by a thermocouple directly on the sample, or in the space between the 
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sample and the heating or cooling element. These criteria are defined 

in the Temperature Stability settings for the controller. 

 Temperature Stability, Section 4.2.4.3. 

Timeout 

The timeout to be applied if the box has been checked to Wait for Temperature to 

reach set point. 

5.10 DATA 

 

When an experiment is run, a data item representing the results will appear in 

the left-hand navigation panel, with a structure of sub-items based on the 

structure of the experiment. When an item in the data structure is selected, 

measurements will appear in the right-hand window in the form of graphs and 

a tabulated list, depending on the configuration of the Axes sub-screen. 

 Axes, Section 5.10.2. 

The graphs and tabulated list will be updated as the experiment progresses and 

new measurements are taken, until the activity represented by the selected item is 

complete. Each item in the data structure is linked to a corresponding item in the 

experiment structure. For example, the following structure has a data item called 

Constant Level Impedance, and when selected it displays the results of the 

corresponding step in the experiment. 

 

The data structure in this example is as follows: 

• At the top level there is the data file name that is specified when the 

experiment is run. 

 Start Experiment, Section 5.2.2. 

• At the next level there is the core module, identified by the name specified in 

the Instrument Group Setup. 
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 Instrument Group Setup, Section 4.2.3.  

• At the next level there is the step, identified by the step type. 

NOTE:  When a project is closed and re-opened, the core module will not 

appear in the data structure if there is only one of them. Also a loop 

will not appear if there is only one pass through the loop. 

The sub-screens in the data screen are described in the following sub-sections: 

 
 Graph, Section 5.10.1. 

 
 Axes, Section 5.10.2. 

 
 Data Selection, Section 5.10.3. 

 
 Trace Setup, Section 5.10.4. 

 
 Advanced Options, Section 5.10.5. 

5.10.1 Graph 

 

This sub-screen in the data screen contains a set of buttons so that you can 

save, print and export the currently displayed results. 

 

The buttons are as follows: 

Save 

Save the data as a Graph File which appears in the navigation panel. If this button 

is used more than once, the Graph File is overwritten. 

 Graph File, Section 5.11.3. 

 

An asterisk appears alongside the Save button if any changes 

have been made to the graph, since it was last saved, by 

editing the associated sub-screens (Axes, Data Selection, 

Trace Setup and Advanced Options). The asterisk disappears 

next time the Save button is used. 

Save Copy 

Save the data as a Graph File which appears in the navigation panel. This button 

is the same as the Save button, but in the Graph File, which has the same set of 

buttons, it has a different functionality. 
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Print 

Open a print dialogue box and print the displayed graph. If there are two graphs 

they will be printed on separate pages. 

Print Preview 

Display a preview of the graphs before printing. 

Export All 

Export the data as an appropriate file type, depending on your selection from the 

list box at the right of the button. The options are: 

Text Export the data as a CSV file, which appears in the navigation 

panel, and display the results in the default application for this 

file type (for example Excel). The complete data set is 

exported, regardless of the displayed table. 

This is the default option, and is used if you click the button 

without selecting anything from the list box. 

Zplot Export the data to Zplot, a software package for 

electrochemical impedance spectroscopy. The data will 

appear in Zview, if installed. (Must be version 3.1c or later) 

Corrware Export the data to Corrware®, a software package for 

electrochemical data acquisition, for corrosion analysis. The 

data will appear in Cview, if installed. (Must be version 3.1c 

or later) 

Export Table 

Export the data as a CSV file, which appears in the navigation panel, and display 

the results in the default application for this file type (for example Excel). The 

data is filtered so that a maximum of 2000 points are exported. 

You can close the application and open it again from the File Information 

dialogue box. 

 Filenames and Extensions, Section 2.3. 

 
 Zplot and Corrware are trademarks of Scribner Associates. 
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5.10.2 Axes 

 

This sub-screen in the data screen enables you to specify the axes on which 

the data is to be displayed. By default they will be the same as the Graph 

Setup for the step in which the data was created. 

 

The fields follow the general layout of graphic displays. 

 Layout of Graphic Displays, Section 5.11.1. 

5.10.3 Data Selection 

 

This sub-screen in the data screen enables you to select the data to be displayed. 

The sub-screen, together with the left-hand navigation panel and graph, is as 

follows: 
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An enlarged view of the Data Selection sub-screen is as follows: 

 

This example shows what the sub-screen might look like after running an 

experiment just once and selecting a step called Constant Level Impedance within 

a data folder called Impedance Test.  The pathname of a data file called 

Impedance Test.data appears in the upper panel, and a series of steps appears in 

the middle panel, under the group name Group 1. The first step is Constant Level 

Impedance, then there is a loop with two iterations, each containing a step called 

Constant Level Impedance followed by the iteration number. 

The lower panel displays the step that has been selected from the left-hand 

navigation panel, in this case the one outside of the loop, and this is the step that 

appears in the graphic display. 

The fields are as follows: 

Data Files 

This window displays a list of data files generated by experiments. Initially there 

is just one file corresponding to the results of this experiment, but other files can 

be added, for the purpose of comparison. The additional files can be created by 

running the same experiment several times, or by running other experiments, and 

then the data files can be imported into this sub-screen. If a file is no longer 

required in the list, it can be removed. 

When you click on a file, the list of steps within the file will appear in the 

Data file steps window. 
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This button opens a dialogue box so that you can browse for a data 

folder and add it to the Data Files window. Only folders are displayed, 

not the files within them, and you can only add folders with the DATA 

extension. If you try to add any other folder, the system will return an 

error. 

 

This button removes the selected folder from the Data Files window. 

Data file steps 

This window displays the complete list of steps within the file that has been 

selected in the Data Files window. You can select any step from the list and add it 

to the Data sets window, for graphic display. 

 

This button adds the selected step in the Data file steps window to the 

Data sets window. 

Data Sets 

A data set is the data generated by a single step in the experiment, and this 

window contains a list of data sets to be displayed in the graphs and tabulated 

lists. By default, it contains a single data set generated by this experiment, but 

other data sets can be added from the Data file steps window. 

 

This button removes the selected step from the Data sets window. 

5.10.4 Trace Setup 

 

This sub-screen in the data screen enables you to define the appearance of the 

graphs, in terms of line types, colours and symbols. 

 

The fields are as follows: 

Style 

This list box displays lines or symbols on the graph, as follows: 

Auto Automatically choose to display data as lines or symbols on 

the graph, depending on the number of measurement points. 

Lines Display data as lines on the graph. 

Symbols Display data as symbols on the graph. There will be one 

symbol for each measurement taken. 

Both Display data as both lines and symbols. 
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Colours 

This list box specifies how colours are to be displayed on the graph, as follows: 

Colour Change all traces to their default colours 

Black Change all traces to black. 

Advanced Trace Setup 

When this list box is clicked, a popup window appears as follows: 

 

This window contains a number of properties that you can apply to the lines and 

symbols on the graph. There is a header row, followed by one row for each data 

set, graph and vertical axis that is displayed. In this example there are three data 

sets (listed in the Data Selection sub-screen) and two graphs with three vertical 

axes between them, (defined in the Axes sub-screen) so there are nine rows 

altogether, numbered from 0 to 8. 

 Data Selection, Section 5.10.3. 

 Axes, Section 5.10.2 

 The fields are as follows: 

Trace 

The trace number, starting at 0 and incrementing by 1 for each successive 

row. 

Data Set 

The data set name, according to the list in the Data Selection sub-screen 

(which defaults to the item selected from the left-hand navigation panel). 

Axis 

The graph number (Graph 1 or Graph 2) and the axis, (Y1 or Y2). 

Colour 

The colour of the trace. The list box displays a colour palette. 

Style 

The line style used for the trace. The list box displays a list of styles 

(continuous, dotted, dashed, etc.) 

Width 

The line width used for the trace. The list box displays a list of numeric values 

from 1 to 5. 

Symbol 
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The symbol used for each data point on the trace. The list box displays a list 

of symbols (circles, squares, etc.) 

Size 

The size of the selected symbol. The list box displays a list of odd numbers 

from 1 to 15. 

Legend 

The legend for the axis. The text field defaults to the selected units, but you 

can change it. 

5.10.5 Advanced Options 

 

This sub-screen in the data screen enables you to specify options for data 

reduction, to speed up the drawing of graphs that would otherwise involve a 

large number of measurement points. 

 

The fields are as follows: 

Measurement types 

This list box specifies the type of measurement to which filtering is applied. The 

options are: 

Auto The system automatically selects All Measurements 

or Impedance Only, depending on which one is most 

appropriate. This is the default option. 

All measurements Apply data filtering to all measurements. 

Impedance only Discard all DC measurements and apply data 

filtering to the impedance measurements only. 

Data reduction 

This list box specifies the type of data filtering to be applied. The options are: 

None Display all data points without filtering. This option 

should not be used if there are more than a million 

points, or while the experiment is running. 

First Display the first 2000 points. 

Last Display the last 2000 points. When 2000 points have 

been accumulated, the oldest ones will be discarded. 

Regular Display every n’th point, where n is calculated so that 

2000 points are displayed. 
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Random Divide the data into 2000 sections, each containing 

an equal number of points, and display one point at 

random from each section. 

MinMax Divide the data into 1000 sections, each containing 

an equal number of points, and display the minimum 

and maximum values from each section. 

RegularTime Display every n’th point, where n is calculated so that 

2000 points are displayed, each from an equal time 

interval. 

MinMaxTime Divide the data into 1000 equal time intervals, and 

display the minimum and maximum values from 

each interval. 

Auto The system automatically chooses an option from the 

list, depending on what is most appropriate for the 

data, which may include DC or impedance 

measurements. This is the default option. 

5.11 GRAPHIC DISPLAYS 

 

Graphic displays are generated by the ModuLab XM system and are available 

both during and after an experiment. 

 Data, Section 5.10. 

The data generated by experiments is divided into data sets for each step. The 

layout of the graphs in each data set is defined in the Graph Setup sub-screen for 

the step, and there is an option to use the default layout for the step type, defined 

in the Graph Preferences screen. The layout can subsequently be changed, when 

the results have been generated, using the Axes sub-screen. In each of these 

screens, where graphs are defined, the general layout is the same. 

 Graph Setup, Section 5.7.6. 

 Graph Preferences, Section 4.1.3. 

 Axes, Section 5.10.2. 

 Layout of Graphic Displays, Section 5.11.1. 

Data from other experiments can be retrieved into the data file, including data 

that has been generated by users of other ModuLab XM systems. Sub-sets of 

data from multiple experiments can be compared with each other, so that this 

feature provides a powerful tool for data analysis. 

 Data Selection, Section 5.10.3.  

Data from any experiment can also be displayed using the Graph file. This has 

the same graphic display features as the data file, but it can be manually added to 

the system and does not need to be generated by an experiment. It also makes the 

data available to reports. 
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 Graph File, Section 5.11.3. 
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5.11.1 Layout of Graphic Displays 

 

Graphic displays are defined in a number of different dialogue boxes in the 

ModuLab XM software, but they have the same general layout, with fields for 

defining two graphs called Graph 1 and Graph 2. The following screen defines 

the Graph Setup for a step and includes an option to use the settings from the 

User Preferences. 

 

 Graph Setup, Section 5.7.6. 

When an entry is selected in the Graph 1 and Graph 2 fields, the display is 

expanded with additional fields to define the axes as follows: 

 

When an experiment has been run and results are generated, the Axes sub-screen 

is available so that you can change the displays. 

 



Software Reference: Project  ModuLab XM MTS Materials Test System: User Guide 

5-90  21006013_AE 

The Axes sub-screen is the same as the Graph Setup sub-screen, except for the 

following: 

• It doesn’t have the Override settings from User Preferences check box 

because the option to override these settings has already been decided in the 

Graph Setup. 

• It has a Table field to display tabulated data. 

• It has a Refresh button to redisplay the graphs and tabulated data after 

changing the fields. 

The complete set of fields in the Graph Setup and Axes sub-screens is as follows: 

Override settings from User Preferences 

If this box is checked, the selections in the Graph Setup screen are used to define 

the graphs, otherwise they conform to the defaults for the step type, defined in the 

Graph Preferences screen. 

 Graph Preferences, Section 4.1.3. 

If the entries in the Graph Setup screen are to be used for an experiment, this box 

should always be checked. 

If the box is cleared, the entries in the Graph Setup screen are ignored, and when 

the experiment is run and the results are produced, the Axes screen will conform 

to the Graph Preferences, not the Graph Setup, but the fields can be changed. 

This check box does not affect the Table field, which exists only in the Axes 

screen, and uses the Graph Preferences if the Auto option is selected. 

Graph 1, Graph 2 

The type of graph to be displayed. Two graphs can be displayed simultaneously, 

with axes depending on the selections from these fields. The options for DC plots 

are as follows: 

None  

V vs. Time  

I vs. Time  

Q vs. Time  

V + I vs. Time  

V vs. I  

I vs. V  

V vs. Log (I)  

Log (I) vs. V  

V + Temp vs. Time  

I + Temp vs. Time  

The additional options for impedance plots are as follows: 

Bode (|Z|, θ)  

Bode (Z′, Z″)  

Complex (Z)  
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|Z| + θ vs. V  

|Z| + θ vs. Ampl  

Bode (|Y|, θ)  

Bode (Y′, Y″)  

Complex (Y)  

Bode (|C|, θ)  

Bode (|C|, Tan δ)  

Bode (C′, C″)  

Complex (C)  

Mott Schottky  

Bode (|ε|, θ)  

Bode (|ε|, Tan δ)  

Bode (ε′, ε″)  

Complex (ε)  

|ε| + θ vs. V  

|ε| + θ vs. Ampl  

Bode (|εr|, θ)  

Bode (|εr|, Tan δ)  

Bode (εr′, εr″)  

Complex (εr)  

Bode (|M|, θ)  

Bode (|M|, Tan δ)  

Bode (M′, M″)  

Complex (M)  

Bode (|Mr|, θ)  

Bode (|Mr|, Tan δ)  

Bode (Mr′, Mr″)  

Complex (Mr)  

If anything other than “None” is selected, a drop-down box appears alongside the 

Graph 1 or Graph 2 list box, and the display is expanded with the X, Y1, Y2 

fields as follows: 
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Graph 1, Graph 2 (details) 

The drop-down box alongside the Graph 1 or Graph 2 list box displays the graph 

configuration details as follows: 

 

The fields are: 

Show Graph Title 

If this box is checked, the title specified in the text box will appear above the 

graph. 

Show Legend 

If this box is checked, a legend will appear under the graph, representing each 

trace. 

Isotropic Axes 

If this box is checked, the axes are scaled so that the measurement units 

occupy an equal length on the X, Y1 and Y2 axes. 

Link Y1 & Y2 axis scales 

If this box is checked, the Y2 axis is mapped onto the Y1 axis and uses the 

same scale, so the left-hand vertical axis represents both Y1 and Y2. This box 

is checked by default for graph types representing real and imaginary values. 

X, Y1, Y2 

These represent the horizontal axis (X), the vertical axis (Y1) and a second 

vertical axis (Y2) which may be used in some graphs. 

 

For each of these fields that displays a variable other than “None”, two additional 

fields appear to the right, a list box of units, and a drop-down box for 

configuration of the axis with labels, limits, tick marks, etc. 
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Each axis defaults to an appropriate setting for the graph type that has been 

selected in Graph 1 or Graph 2, but they can be changed by selecting the 

following options: 

None 

Time 

Voltage 

Current Density 

Charge Density  

Power Density 

Resistance 

Temperature 

Range 

Frequency 

Impedance 

Admittance 

AC Capacitance 

Permittivity 

Rel Permittivity 

Modulus 

Rel Modulus  

AC Voltage 

AC Current 

The Y2 axis defaults to None for graph types that involve two axes, but it defaults 

to an appropriate variable for graph types that require three axes, for example 

Current Density if the graph type is V + I vs. Time. 

X, Y1, Y2 (units) 

This field appears to the right of any axis field (X, Y1 or Y2) that has not been set 

to None. It has a drop-down list box of units which depend on the variable being 

displayed by the axis. For example, if the axis represents time, the available units 

are: 

ms 

s 

Minute 

Hour 

Day 

X, Y1, Y2 (details) 

This drop-down box appears to the right of the units field for any axis field 

(X, Y1 or Y2) that has not been set to None. It displays a detailed configuration 

of the axis. 

 Axis Details, Section 5.11.1.1. 
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Table 

This list box appears at the bottom of the Axes sub-screen (but not the 

Graph Setup sub-screen) as follows: 

Tabulated data may be displayed alongside the graphs at the appropriate 

positions. The options from the list box are as follows: 

None Do not display tabulated data. 

Auto Display tabulated data at the default positions specified in 

the Graph Preferences sub-screen in the User Preferences. 

 Graph Preferences, Section 4.1.3. 

Right Display tabulated data to the right of the graphs. 

Bottom Display tabulated data below the graphs. 

Refresh 

This button appears at the bottom of the Axes sub-screen (but not the 

Graph Setup sub-screen), and refreshes the graphs and tables according to any 

changes that have been made. 

 An amber warning icon appears alongside the button when changes have 

been made to the screen and the graphs need to be refreshed. 
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5.11.1.1 Axis Details 

The Graph Setup and Axes sub-screens contain a set of fields representing the 

graph type and the X, Y1 and Y2 axes as follows: 

 

 Layout of Graphic Displays, Section 5.11.1. 

Each axis field with an entry other than None has two additional fields, one for 

the units, and the other for additional details about the axis. 

The drop-down box on the details field varies according to the quantity 

represented by the axis, but for Voltage it is as follows: 

 

The default values for some of these fields depend on the graph type. For 

example, on a Bode plot where the Graph 1 field is Bode (|Z|, θ), the Logarithmic 

axis scale box will be checked for the impedance magnitude and frequency axes, 

but unchecked for the phase angle axis. 

In this display, the fields are as follows: 

Auto 

In this group of fields, a check box is followed by one or more text or numeric 

fields. The boxes are normally checked, indicating that the fields are 

automatically given appropriate values, according to the displayed data, but if the 

fields are changed the boxes automatically become unchecked. 
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The fields are: 

Label 

The axis label, which defaults to the variable and units represented by the 

axis. 

Minimum 

The minimum value of the variable to be displayed on the axis. 

Maximum 

The maximum value of the variable to be displayed on the axis. 

Major tick 

The interval at which major tick marks and values appear on the axis. The 

numeric field is followed by a list box with the following options: 

None Tick marks are not displayed. 

Inside Tick marks are displayed inside the axis. 

Outside Tick marks are displayed outside the axis. 

Cross Tick marks are displayed both inside and outside the axis. 

Minor tick 

The interval at which minor tick marks, without values, appear on the axis. 

The numeric field is followed by a list box, same as for major ticks. 

X axis crosses at 

This field specifies the value of the Y axis where the X axis crosses it. This is 

useful, for example, when placing the axis on zero, between positive and 

negative limits. 

Logarithmic axis scale 

The axis has a logarithmic scale. This box is checked by default if the axis for the 

graph type is normally logarithmic. For example, in a Bode plot, the impedance 

and frequency are logarithmic, but the phase angle is linear, so the box is checked 

or unchecked depending on the axis that it represents. The sign is ignored if the 

value is negative. 

Invert axis 

If this box is checked, the axis will be inverted so that the values increase in the 

reverse direction. (X axis from right to left, Y axis from top to bottom). 
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Data Scaling 

The scaling of the data, before it is plotted, which can be one of the following, 

selected from a radio button: 

Linear No scaling applied 

Absolute Negative values converted to positive 

Log Logarithm to the base 10 

Ln  Logarithm to the base e 

Square root  

1/Square root  

Reciprocal  

Power Scale the axis according to the power specified in the 

field alongside the radio button, for example: 

2 Squared 

3 Cubed 

0.5 Square root 

-1 Reciprocal 

Channels 

 

This group of fields represents the channels to be displayed as separate traces on 

the graph, each with its own legend. A check box is available for each channel, 

and any number of them can be checked, as long as at least one of them is 

checked. 

This group appears for all axes except those representing the following variables: 

Current density 

Temperature 

Time 

Range 

The fields within the group depend on the variable represented by the axis, as 

follows: 

Main 

If this box is checked, the graph displays the measurements taken from the 

main channel (Vhi, Vlo). This field appears in the Channels group for all axis 

variables that display the group. 
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Aux A, Aux B, Aux C, Aux D 

If any of these boxes are checked, the graph displays the measurements taken 

by the appropriate auxiliary channel. 

Measurements will only be available if they have been enabled from the 

Instrument Experiment Setup, by checking the appropriate boxes under 

Enable Auxiliary Voltage Inputs. 

 Instrument Experiment Setup, Section 5.3.4. 

These fields appear in the Channels group for axes representing the following 

variables: 

Voltage 

Impedance 

Admittance 

AC Voltage 

AC Current 

Current 

 

This group of fields exists only for an axis representing current density, and has 

the following check boxes: 

Forward I 

The current density in the forward direction. This will be at the top of a pulse 

or step for a differential pulse or square wave. 

Reverse I 

The current density at the bottom of a pulse or step for a differential pulse or 

square wave. This check box has no meaning for other step types because 

there is no reverse data. 

Differential 

The difference in current density between the top and bottom of a pulse or 

step, for a differential pulse or square wave. This check box has no meaning 

for other step types because there is no reverse data. 
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Temperature 

 

This group of fields exists only for an axis representing temperature, and has the 

following check boxes: 

Set point 

The temperature specified in the scanning loop, so that the sample progresses 

toward this temperature. 

Sample 

The temperature of the sample, measured by a thermocouple. 

Control 

The temperature of the heating or cooling device, measured by a 

thermocouple close to the heating or cooling element. 

Time vs 

 

This group of fields appears only for a time axis, and represents the offset of the 

zero value on the axis, which can be one of the following, selected from a check 

box: 

Experiment 

The time axis has the zero value at the beginning of the experiment. 

Loop Start 

The time axis has the zero value at the beginning of the current iteration round 

a loop. 

Step Start 

The time axis has the zero value at the beginning of the current step or cycle. 
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Measurements 

 

This group of fields appears only for a range axis, and represents the 

measurement ranges used during the experiment, according to their range 

numbers. The check boxes are: 

Current 

The current range used by the core module. This box is checked by default. 

Voltage 

The voltage range used by the core module. 

Aux A, Aux B, Aux C, Aux D 

The voltage ranges used by the auxiliary channels. 

5.11.2 Measurement Ranges 

 

When an experiment is running and generating data, and the core module 

changes from one voltage or current range to another, the system may record 

the range numbers so that they can be displayed in graphs and tables, together 

with the data. 

Normally, range numbers are only included in the data if they do not significantly 

slow down the data collection rate. However, if the Force recording range 

changes box is checked, in the Instrument Experiment Setup, range numbers will 

be included regardless of their effect on data collection. 

 Instrument Experiment Setup, Section 5.3.4. 

The range numbers can be displayed in graphs and tables, together with the data, 

by selecting the appropriate options in the Graph Setup and Axes sub-screens. 

Here is an example of an Axes sub-screen with Range selected as the Y2 axis and 

Bottom selected as the Table option: 
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This displays a graph and table as follows: 

 

In this experiment, the data has been generated from a Constant Level Impedance 

step where the impedance varies with frequency. This causes a change in the 

measured current, so that the range number changes when required. The range 

numbers are associated with voltage and current ranges in the Instrument 

Experiment Setup, so that the least sensitive ranges use the lowest range numbers. 

By default, a Range axis displays only the current range, so that in this example 

there is only one trace associated with the Range axis, and only one Range 

column in the table. Additional traces and columns will appear if voltage or 

auxiliary channel options are selected in the Measurements group, in the Axis 

Details drop-down box. 

 Axis Details, Section 5.11.1.1. 
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5.11.3 Graph File 

 

A Graph file can be added to the Navigation panel, under a project, 

experiment or folder, to display data that has been generated by experiments. 

It has the same graphic display features as the data screen, but has the 

following additional functionality: 

• It can be manually added to the system and does not need to be generated 

from an experiment. In this case, it initially accesses no data, and you have to 

browse through the filing system to find the data that you want to display. 

• It can make the data accessible to reports. 

 Data, Section 5.10. 

 Reports, Section 5.13. 

This feature enables you to create your own collections of data from different 

ModuLab XM experiments and store them in folders that are structured according 

to your requirements. It is also the most convenient way of displaying data that 

has been exchanged between users of different ModuLab XM systems. 

To add a Graph file independently of an experiment and then display some data, 

proceed as follows: 

1. Right-click on a project, experiment or folder in the navigation panel to 

display the drop-down menu. 

2. Click on Add New, then Graph. A screen appears, similar to the Data screen, 

but the Data Selection sub-screen will be empty as follows: 

 

3. Browse the filing system and select the appropriate data file, then select the 

data to be displayed. 

 Data Selection, Section 5.10.3. 
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To add a graph file from a data file and display the data: 

1. Click on the data item, in the left-hand navigation panel. (The data item will 

be selected automatically if the experiment has just been run.) 

The data screen contains the Graph sub-screen as follows: 

 

 Graph, Section 5.10.1. 

2. Click on the Save or Save Copy buttons to add a Graph file containing all the 

results from the data item. 

NOTE: The Graph file displays the same sub-screens as the Data screen, 

including the Graph sub-screen. The Save button is the same, 

overwriting the existing Graph file, but the Save Copy button creates a 

new Graph file in the navigation panel, alongside the existing one, with 

the filename appended by a number. The Save and Save Copy buttons 

are both the same in the Data screen, overwriting the existing file. 
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5.12 MATHEMATICAL FUNCTIONS AND CIRCUITS (FITTING) 

 

Graphical displays generated by ModuLab XM can be represented by simple 

mathematical functions, including straight lines and circles, which are fitted to 

the results using statistical algorithms. It is also possible to construct electrical 

circuits representing the results. 

To access these features of ModuLab XM, proceed as follows: 

1. In the left-hand navigation panel, click on a data item. If there are no data 

items, you will need to generate one by running an experiment. 

2. Display the results as the appropriate graph types, depending on the 

mathematical function to be fitted. 

3. Click the Fitting tab, to the right of the navigation panel, to display the Fitting 

Options as follows: 

 

The fields available in this screen depend on the Fitting Method, selected from 

the Method list box which contains the following options: 

None Do not fit any functions or circuits to the data. 

Line Fit a straight line through the data. 

 Section 5.12.1. 

Circle Fit a circle to the data.  

 Section 5.12.2. 

Equivalent circuit Fit an equivalent circuit to the data.  

 Section 5.12.4.  

The circuit is drawn by the user and the model 

calculates the values of the components, including 

resistors, capacitors and inductors. This method can 

only be used for impedance data. 
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In all cases, data can be selected by clicking two points on a graph, and the model 

calculation will include all the data between the points. Alternatively, the 

calculation can be based on the complete set of data, so that no points need to be 

specified. 

To select the data for fitting, proceed as follows: 

1. Click the appropriate points on the graph. Each successive point will be 

labelled A, B, C etc. For most plots, only two points will be needed. If 

required, for greater precision, hold the cursor over a position on the graph 

and the X and Y values will appear, then click on the point.  

2. If a point needs to be moved, hold the cursor on the label and drag it along the 

line of data. As the cursor moves, the label will display the X and Y values, 

which will animate as the values change. When you arrive at the required 

values, release the mouse and the label will re-appear. 

3. If a graph contains two traces, for example voltage and current density against 

time, complementary labels will appear on the second trace, but only if the 

two traces are based on the same data set. The trace that is currently selected 

for fitting will have green labels, while the non-selected trace will have blue 

labels. If the second trace is selected, by clicking on a blue label, the colours 

will be reversed so that the blue labels turn green and the green labels turn 

blue. 

4. When the points have been set up, select the required Method in the Fitting 

Options screen and set the appropriate options for the Method, then click the 

Run button. The plot will be fitted to the data, and the parameters will appear 

in the Fitting Results box, under the Run button. 

 Line and Circle Methods, Sections 5.12.1 - 5.12.2. 

5. If the graph contains two traces, you can click a label on the second trace and 

click the Run button again, and the function will be fitted to the second trace. 
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The following example shows a result produced from a Linear Sweep (plotted as 

V + I vs. Time), with a straight line fitted between two points on the voltage  

trace. 

 

The line definition, in terms of the X and Y intercepts, gradient and fit error 

appear in the Fitting Results box as follows: 

 



ModuLab XM MTS Materials Test System: User Guide Software Reference: Project 

21006013_AE  5-107 

5.12.1 Line 

The Line method in the Fitting Options screen fits a straight line through the data, 

as shown in the previous section. The Fitting Options screen is as follows: 

 

The fields are: 

Method 

Defines the type of plot, in this case Line. The text box below this field gives 

instructions about how to use the cursors to identify the region where the plot 

is to be fitted. 

Run 

This button performs the calculation, and displays the results as a simulated 

trace on the graph and a set of values in the Fitting Results box. 
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Fitting Results 

When the calculation is performed, this box displays the line definition as 

follows: 

X intercept The point where the plot crosses the X axis (Y=0) 

Y intercept The point where the plot crosses the Y axis (X=0). 

The constant c in the Model equation: 

y = mx + c 

Gradient The gradient m in the Model equation: 

y = mx + c 

Fit error The error introduced by the scattering of data points 

around the line, calculated from the Chi2 test. A value of 

zero indicates a perfect fit. 

Y intercept (=1) The value of Y on an impedance plot where the X axis 

represents frequency, at the point where X = 1/2 Hz 

(angular frequency  = 1 rad/sec). This result only 

appears for impedance plots. 

Estimated C Estimated capacitance, calculated as: 

C = 1 / Y intercept (=1) 

Options 

The following options are available: 

Model 

The model used for the line definition. Only one model is available for 

this Method: 

y = mx + c 

where: 

y is the vertical axis measurement of a point on the plot. 

x is the horizontal axis measurement of a point on the plot. 

m is the gradient 

c is the intercept on the y axis. 

Data selection 

This list box selects the range of data through which the line is to be 

fitted. The options are: 

Between Cursors Fit the line to all the data between two 

specified points on the graph. 

All Points Fit the line to all the data on the graph, so that 

there is no need to specify cursors. 
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Mode 

This list box specifies how the model is applied to the data. The options 

are: 

Fit Fit the mathematical model to the data and calculate 

a set of parameters to produce simulated results. 

Simulate Evaluate the model from a set of parameters 

specified by the user, which may be an approximate 

representation of a previous fit.  

Parameters 

This table contains details of the parameters used to produce the simulated 

results. The parameters are listed in the Name column as follows: 

Gradient The gradient m in the model equation: 

y = mx + c 

Intercept The Y intercept c in the model equation: 

y = mx + c 

Chi2 The fit error, based on the Chi2 test. A value of zero 

indicates a perfect fit. 

For each of these parameters, the remaining columns are as follows: 

Value The value of the parameter, which may be calculated by 

the system or specified by the user. 

Units The units in which the value is specified or calculated. 

This field depends on the selected Method: 

• A list box of units, appropriate to the selected 

component, is available for an Equivalent Circuit. 

• There are no units for the Line or Circle Method. 

Fit type The value may change during a calculation, according 

to the following options: 

 Fixed The value remains fixed and does not 

change during a calculation. 

 Free The value can change, either up or down, 

during a calculation. This is the default 

option for all Methods except Equivalent 

Circuit. 

 Positive The value can increase during a calculation. 

This is the default option for the Equivalent 

Circuit method. 

 Sub The value can decrease during a calculation. 

Error The margin of error associated with the parameter. A 

small value represents high accuracy. 
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5.12.2 Circle 

The Circle method in the Fitting Options screen fits a circular arc through the 

data, and is typically used in complex plane plots as follows:  

 

The Fitting Options screen is as follows: 
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The fields are: 

Method 

Defines the type of plot, in this case Circle. 

Run 

This button performs the calculation, and displays the results as a simulated 

trace on the graph and a set of values in the Fitting Results box. 

Fitting Results 

When the calculation is performed, this box displays the circle definition as 

follows: 

Real center The center of the circle, measured on the real (X) 

axis. 

Imaginary center The center of the circle, measured on the imaginary 

(Y) axis. 

Diameter The diameter of the circle. 

Deviation The maximum distance of a data point from the 

circle, in terms of magnitude consisting of both real 

and imaginary components. 

Low intercept The low point where the circle intercepts the real (X) 

axis. 

High intercept The high point where the circle intercepts the real 

(X) axis. 

Depression angle The angle between the real (X) axis and a line drawn 

from the low intercept to the centre. 

 max The frequency corresponding to the maximum value 

of imaginary impedance (the top of the circle). The 

value is specified in two sets of units, rad/s and Hz. 

Estimated Rs Estimated solution resistance. 

Estimated Rp Estimated polarisation resistance. 

Estimated C Estimated capacitance. 

Options 

The following options are available: 

Model 

The model used for the circle definition. The options are: 

Normal Perform an iterative fit, using the current values 

from the table of parameters as initial values. 

Prefit Draw the circle through three points on the data. 

This method can be used to obtain initial values of 

the parameters for a Normal Fit, in case the currently 

specified values are unsuitable. 
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Iterations 

The maximum number of iterations to be performed during a Normal Fit. 

Data selection 

This list box selects the range of data through which the line is to be 

drawn. The options are: 

Between Cursors All the data between two specified points on 

the graph. 

All Points All the data on the graph, so that there is no 

need to specify points. 

Epsilon 

Stop performing iterations of a Normal Fit when the change between 

iterations is less than this value. 

Mode 

This list box specifies how the model is applied to the data. The options 

are: 

Fit Fit the mathematical model to the data and 

calculate a set of parameters to produce 

simulated results. 

Simulate Evaluate the model from a set of parameters 

specified by the user, which may be an 

approximate representation of a previous fit. 

This mode only applies to the Normal model, 

not Prefit. 

Parameters 

This table contains the following parameters, identified in the Name column: 

Real The real center of the circle, measured on the X axis. 

Imag The imaginary center of the circle, measured on the Y 

axis. 

Radius The radius of the circle. 

W max The frequency corresponding to the maximum value of 

imaginary impedance. 

For each of these parameters, the remaining columns (Value, Units, Fit Type 

and Error) are the same as in the Line method. 

 Line method, Section 5.12.1. 

5.12.3 Tafel 

This feature is applicable to the ModuLab XM Electrochemical System and has 

no relevance to materials testing. 
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5.12.4 Equivalent Circuit 

A circuit can be constructed by the user, to represent the electrical properties of 

the sample, and the values of the components can be calculated in terms of 

resistance, capacitance and inductance. These calculations are only available for 

impedance data and cannot be applied to DC experiments. 

Values that contribute to impedance are calculated, where possible, whenever a 

curve is fitted to impedance data. For example in the Circle method, the Fitting 

Results include the following estimated properties: 

Rs Solution resistance. 

Rp Polarisation resistance. 

C Capacitance. 

 Circle method, Section 5.12.2. 
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These properties are used in the equivalent circuit in the following Fitting Options 

screen: 

 

The fields are: 

Method 

Defines the type of plot, in this case Equivalent Circuit. 

Run 

This button performs the calculation, and displays the results as a set of values in 

the Fitting Results box. 

 Section 5.12.4.5, Running the Equivalent Circuit Calculations. 
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Fitting Results 

Reserved for future use. Not used for the Equivalent Circuit method in this 

release. 

 (Buttons) 

The two rows of buttons above the drawing space are as follows: 

New 

Clear the drawing space, ready for building a new circuit. 

Adjust 

Move the whole circuit, together with the title, to the top left of the drawing 

space. 

Load 

Load a previously saved circuit. 

Save 

Save the current circuit under a specified filename with the .BIN extension. 

Run 

Run the calculation, same as the Run button at the top of the sub-screen. 

 Section 5.12.4.5, Running the Equivalent Circuit Calculations. 

Options 

Display a dialogue box to specify how the calculation is to be performed. 

 Equivalent Circuit Fitting Options, Section 5.12.4.4. 

Print 

Print the circuit. A print dialogue box will appear. 

Help 

Display help text about this topic. 

(Toolbar) 

The toolbar above the drawing space has the following buttons: 

 
Select an element of the circuit, for editing. 

 
Draw a wire. 

 
Insert a resistor. 

 
Insert a capacitor. 

 
Insert an inductor. 

 
Insert a distributed element. 
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Insert a constant phase element. 

 
Insert a Gerisher element. 

 
Insert a Warburg open circuit element. 

 
Insert a Warburg short circuit element. 

 Specialised Circuit Elements, Section 5.12.4.3. 

Circuit Title 

This element within the drawing space gives a title for the circuit. A drop-down 

menu appears when it is right-clicked, with the following options: 

Set Font A font dialogue box appears so that you can specify a 

font, size, style and colour. 

Rename A text box appears so that you can change the title. 

The Circuit Title is a permanent feature of the drawing space and cannot be 

removed. 

Ref 

This element within the drawing space represents a reference electrode. 

Gnd 

This element within the drawing space represents a grounded electrode. 

The circuit has to be drawn between the Ref and Gnd elements, so they are 

permanent features of the drawing space and cannot be removed. 

 (Element Table) 

The Element Table, below the drawing space, has one row for each element in the 

circuit. The columns are: 

Element 

The element name. This defaults to an appropriate character or abbreviation 

followed by a number, but can be changed. For example, if resistors are added 

to a blank circuit, they will be called R1, R2, etc., but might be renamed to 

Rs, Rp. 

Value 

The value of the element, which can be specified by the user or calculated by 

the system. 

Unit 

In the case of resistors, capacitors and inductors, this field gives the units in 

which the element is measured, and they can be changed from a drop-down 

list box. For all other elements, a dialogue box appears so that the element 

properties can be specified. These dialogue boxes are also available by right-

clicking on the elements in the drawing space and selecting Properties. 
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Fit Type, Error 

These fields are the same as in the Line method. 

 Line method, Section 5.12.1. 

5.12.4.1 Drawing a Circuit 

A circuit is drawn by starting with a blank drawing space, containing only the 

Title and the two permanent elements labelled Ref and Gnd. New elements can be 

added, including wires to join them up at the intersections which are called 

Nodes. 

The Fitting Options screen contains a simple circuit containing two resistors and a 

capacitor. To build this circuit, proceed as follows: 

1. Click the New button to clear the drawing space, leaving only the default 

Title and the Ref and Gnd elements as follows: 

 

2. Specify a suitable Title for the circuit. This circuit will have an impedance, as 

a consequence of combining resistance and capacitance elements, so we will 

call it Impedance Circuit. 

Click the Selection  toolbar button, then right-click on the Circuit Title 

element to display the drop-down menu and select Rename to display the title 

in a text box. Overtype the title, then click anywhere outside the text box to 

close it. The screen will be as follows: 
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3. Click on the Resistor  toolbar button, then click on the drawing space to 

the right of the Ref element, to insert a resistor labelled R1. Click again to the 

right of R1 to insert a second resistor labelled R2, so that the screen is as 

follows: 

 

4. Click on the Capacitor  toolbar button, then click on the drawing space 

above the resistor R2 to insert a capacitor C1 as follows: 

 

We will now see how to join up the elements, and the letter N will appear 

whenever the cursor is over a node. 

5. Click on the Wire  toolbar button, then position the cursor over the node 

to the right of the Ref element, so that the letter N appears, and click the node. 

Then move the cursor to the right, so that the letter N disappears, and position 

it over the node to the left of the R1 element and the letter N will re-appear. 

Click on the node so that the two elements become joined up as follows:  
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6. Similarly, click the two nodes between R1 and R2, and the two nodes 

between R2 and Gnd, so that they become joined up as follows: 

 

7. Hold the cursor over the wire between R1 and R2 so that the letter W appears, 

then click on the wire to create a new node, and the letter W will change to N. 

Then move the cursor vertically upwards and click in the space to the left of 

C1 (but not on the node), to create a corner. Then move the cursor to the right 

and click on the node to the left of C1 so that the screen becomes as follows: 

 

8. Similarly, click on the node to the right of C1, then move the cursor to the 

right and click to create a corner. Then move the cursor down to the wire 

between R2 and Gnd, so that the letter W appears, then click to create a new 

node and the screen will be as follows: 
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NOTE: The small dot to the left of Gnd is part of the element, and it’s 

already joined to a wire, so you can’t click on it. You need to 

click on the wire. 

9. Finally, the labels need to be changed to represent the required component 

names. 

Click on the Selection  toolbar button, then right-click on R1 and select 

Rename from the drop-down menu. The element will turn red and the cursor 

will jump to the label in the element table as follows: 

 

10. Overtype the label in the element table with the appropriate name, for 

example Rs, then click on the drawing space to complete the edit. The new 

name will appear over the resistor, and the element will turn black. Similarly, 

change the other element names so that R2 becomes Rp and C1 becomes C. If 

you like, after overtyping R1, you can click directly on R2 in the element 

table and this will complete the edit of R1 and start the edit of R2, so that R1 

turns black and R2 turns red. Then you can move directly to C1 and when 

editing is complete you can finish by clicking on the drawing space. The 

screen will be as follows: 
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5.12.4.2 Circuit Editing 

The following actions are available when drawing and editing a circuit. 

Move an Element 

All elements, including the permanent elements (Circuit Title, Ref and Gnd) can 

be moved to appropriate positions as follows: 

1. Click the Selection  button, then do either of the following: 

• Click on a single element to be moved. 

• Click on an empty drawing space and drag the cursor to select multiple 

elements. 

2. Drag the element(s) across the drawing space. An element can be moved 

along a wire to which it is attached, but if it is moved perpendicular to a wire, 

the wire will move so that it remains attached to the element. Any other 

elements attached to the wire will also move, and the movement will be 

perpetuated throughout the diagram, as far as is necessary to keep all the 

connections in place. 



Software Reference: Project  ModuLab XM MTS Materials Test System: User Guide 

5-122  21006013_AE 

Join Elements 

All elements must be joined up using wires, otherwise the calculations cannot be 

performed and the elements cannot be given values. Elements are joined as 

follows: 

1. Click the Wire  button on the toolbar, then click the nodes on the 

adjacent elements. If the drawing space is clicked between nodes, it will 

create a corner. When the elements are joined, the nodes will disappear 

leaving a continuous line between the elements. However, a node will remain 

visible if the end point of a wire is joined to the middle of another wire, away 

from its end points. In this case, to achieve a closed-up joint, the node has to 

be held over the wire so that the N label changes to W, then you can click the 

node and it will change back to N and the joint will be closed.  

2. To check that all the joints are closed, click the Selection  button on the 

toolbar and attempt to move the elements. If the elements are joined, the wires 

will move with the elements, creating corners as required, but will not open 

up any gaps. 

If any gaps open up, you will need to select the wire  button and close 

them.  

Rotate Element 

All elements that contribute to impedance (everything except Title, Ref, Gnd and 

wires), can be rotated so that they are horizontal or vertical, but only if they are 

on their own, not connected to anything. 

1. Click the Selection  button on the toolbar, then right click the element to 

display the drop down menu and click Rotate. This is a toggle action, so the 

element will change from horizontal to vertical and vice-versa.  

Rename Element 

All elements can be renamed, except Ref, Gnd, and the wires which have no 

names. 

1. Click the Selection  button on the toolbar, then right click the element to 

display the drop down menu and click Rename. The cursor will jump to the 

Element Table so you can overtype the name. Alternatively you can go 

straight to the element table and edit the name without using the drop-down 

menu.  

When editing the Title, which does not appear in the element table, you have 

to right-click the element and display the drop-down menu, then select 

Rename and a text box will appear so you can overtype the text. 
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Delete Element 

All elements can be deleted, except Title, Ref and Gnd. 

1. Click the Selection  button, then do either of the following: 

• Hold the cursor over a single element so that it turns red. 

• Click on an empty drawing space and drag the cursor across multiple 

elements, so that they all turn red. 

2. Press the Delete key on the keyboard to delete the highlighted element(s). 

Alternatively, to delete an element that contributes to impedance (resistors, 

capacitors etc.): 

1. Click the Selection  button. 

2. Right-click on the element, then select Delete from the drop-down menu. 

5.12.4.3 Specialised Circuit Elements 

The Equivalent Circuit toolbar contains the following specialised elements: 

 
Distributed element 

 
Constant phase element 

 
Gerisher element 

 
Warburg open circuit element 

 
Warburg short circuit element 

These elements are complete self-contained circuits, each representing an 

impedance, in accordance with a combination of resistance, capacitance and 

inductance, and they can be combined with other elements to create larger 

circuits. These elements are normally used for specific applications, and are 

described in the LEVM Manual. 

 LEVM Manual (J. Ross Macdonald and Solartron Group Ltd), available on 

the Solartron website: 

www.solartronanalytical.com/downloads/software/levm_manual.pdf 

Each of these elements has a Parameters dialogue box which can be displayed 

using either of the following methods: 

• Right-click on the element to display the drop-down list box and click 

Properties. 

• Select the Unit field in the Element Table below the drawing space, then 

click on the field again. 
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The appropriate dialogue box will appear. For example, in the case of a DE 

element it will be as follows: 

 

5.12.4.4 Equivalent Circuit Fitting Options 

When you click the Options button above the Equivalent Circuit toolbar, the 

following dialogue box appears: 

 

The fields are: 

Type of test 

This set of radio buttons specifies how the circuit, with calculated values of the 

components, is fitted to the data. The options are: 

Fitting Fit the circuit to the data and calculate a set of 

component values to produce simulated results. 

Simulation Evaluate the circuit from a set of component values 

specified by the user, which may be an approximate 

representation of a previous fit.  

Subtraction Produce a simulated set of data, then subtract it from 

the real data and plot the result. 
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Weighting 

Unit No weighting. 

Data-proportional Uncertainty of the real and imaginary components 

of the data is proportional to their magnitudes. 

Data-Modulus Uncertainty of the real and imaginary components 

of the data is proportional to their modulus (square 

root of sum of squares of real and imaginary 

components). 

Calc-proportional Same as Data-proportional, but based on model 

calculations. 

Calc-Modulus Same as Data-modulus, but based on model 

calculations. 

Special Special FRA weighting. 

Further details of weighting are in the LEVM manual. 

 LEVM Manual (J. Ross Macdonald and Solartron Group Ltd), available on 

the Solartron website: 

www.solartronanalytical.com/downloads/software/levm_manual.pdf 

Select All Points 

If this box is checked, all the data points are used for fitting, otherwise the data 

points defined by the cursors are used. 
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5.12.4.5 Running the Equivalent Circuit Calculations 

Equivalent circuit calculations can only be performed if you have set up a circuit 

with the appropriate elements, to match the characteristics of the sample and the 

data it is likely to produce. The correct design of a circuit may therefore be a 

matter of trial and error, until you find something that works. 

An example circuit is provided to represent the Test Circuit in the dielectric 

reference module, and it can be used to fit a pair of curves to the impedance and 

phase angle traces of a Bode plot. To use this example, you need a materials core 

module and a frequency response analyzer, and you should have completed the 

Frequency Response Analyzer Test using the Getting Started project during the 

Installation Tests. 

 ModuLab XM Installation Guide 

To use the example circuit, proceed as follows: 

1. Open the Getting Started project and expand the Additional Tests item in the 

left-hand navigation panel, then open the FRA Test experiment folder, then 

the FRA Test data folder, and click on Constant Level Impedance. This will 

display the data in the default format for the step, normally a Bode plot of 

impedance magnitude and phase angle against frequency. 

2. If any other format is displayed, change the Graph 1 field in the Axes sub-

screen to Bode (|Z|, θ) to display the data as follows: 
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3. Click the Fitting tab at the top left of the central column of sub-screens to 

display the Fitting Options as follows: 

 

4. In the Method field, select Equivalent Circuit to display a blank circuit 

display panel and the control buttons as follows: 
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5. Click the Load button to display a filing system dialogue box with a list of 

Fitting Models. The system will go to the folder that was used last time a file 

was loaded, but initially it will be: 

C:\My Data\ModuLab\Fitting Models\ 

6. Select the model file ModuLab TestCircuit.bin and click the Open button to 

display the circuit as follows: 

 

7. If you want to specify a section of the data for fitting, click on either of the 

curves on the Bode plot to add the points A and B. Alternatively, if you want 

to apply fitting to the entire data, do not add any points. 
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8. Click the Run button (the one above the circuit, or the one at the top of the 

Fitting Options sub-screen), to display the fitting results as follows:  

 

The results have appeared as traces on the graph, and in the tabulated list under 

the circuit. In this example, the points A and B are at the ends of the curves, but 

they can be moved and you can click the Run button again to obtain new fitting 

results. 

5.13 REPORTS 

 

A report is a document describing an experiment, which can be opened in a word 

processor for editing and printing. The document may contain experiment 

settings and results, including connection diagrams, graphs, tables and user 

comments. 

The data displayed in a report is based on the graph files associated with the 

experiments. These are generated when an experiment is run and the graphic and 

tabulated results are appropriately configured for display, and the Save or 

Save Copy buttons are clicked in the Graph sub-screen. Alternatively, graph files 

can be generated independently of an experiment and the data can be added. 

 Data, Graph and Graph File, Sections 5.10, 5.10.1 and 0. 
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A report can be generated in a project, experiment or general-purpose folder, and 

in each case there will be a report folder at the appropriate position in the 

navigation tree. This may contain any number of RTF document files, each with a 

specified filename, referencing a list of graph files. The list will default to all the 

graph files in the same structure as the report folder, at the same level, but other 

files can be added. 

Here is an example which uses data from the Getting Started project, where the 

MAT Test has been performed three times and the FRA Test has been performed 

once. To follow this example, you need to have performed the MAT Test and one 

of the Additional Tests at least once. 

To create the report: 

1. Open the Getting Started project and expand the experiment structures in the 

left-hand navigation panel, for the MAT Test and one of the additional tests 

(in this case the FRA Test), and click on the data folder for the MAT Test, so 

that the screen is as follows: 

 

2. Click the Save button in the Graph sub-screen to save the contents of the 

MAT Test data folder as a graph file, which will appear at the bottom of the 

experiment structure. 

3. If the MAT Test has been run more than once, select the appropriate data 

folders, for example MAT Test (2) and MAT Test (3), and in each case click 

the Save button in the Graph sub-screen to add a graph file. 

4. In the structure under the Additional Tests folder, select a data folder for any 

experiment that has been run, for example FRA Test, and click the Save 

button in the Graph sub-screen to add a graph file. 
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A screen showing three graph files for the MAT Test and one graph file for 

the FRA Test is as follows: 
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5. Right-click on the experiment item for the MAT Test to display the drop-

down menu and click on Add New, then Report. A report folder called New 

Report will appear in the navigation panel, under the graph files, and the 

pathnames of the graph files will appear in the Report Writer sub-screen, in 

the list of Included Graphs, as follows: 

 

Only the graph files for the MAT Test have been listed, not the graph file for 

the FRA Test, because it is in a different part of the structure. 

The lower panel gives a brief description of how to generate a report. 

6. Rename the New Report folder in the navigation panel to something more 

suitable, for example Getting Started. 

7. Type a suitable name in the Report Filename field, in the Report Writer sub-

screen, for example MAT Test. 
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8.  

 

Click the Generate Report button, to the right of the 

Report Filename field, to create an RTF file with the specified 

name in the report folder, and display the contents of the report 

in the lower panel as follows: 

 

9. Scroll down the lower panel to view the complete report. 

The report contains the report date, and then the following information from each 

successive graph file in the upper panel. 

• An experiment comment, from the Comments sub-screen in the experiment 

setup screen. 

 Section 5.3.1. 

• A list of steps within the experiment, and the excitation waveforms from the 

associated Scan Setup screens. 

 Section 5.8.4. 

• A connection diagram. 

• A list of equipment items used in the experiment, including the core module 

and optional modules. 
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• The graphs associated with the experiment, according to the formatting that 

has been applied to the results. 

 Data, Section 5.10. 

• The tabulated data associated with the experiment, according to the formatting 

that has been applied to the results. 

 Data, Section 5.10.  

• Data file comments, from the Comment field in the Start Experiment screen. 

 Section 5.2.2.  

• Fitting results. 

 Section 5.12.  

At the bottom of the display, at the end of the data from the last graph file, there 

is a list of files that make up the report, beginning with the RTF file that 

represents the document, followed by all the associated graph files. 

NOTE: It is also possible to add a report folder by selecting New Report 

from the drop-down menu, instead of Add New, then Report. 

However, if a general-purpose folder under the experiment is 

selected, the report folder will be added directly under the 

experiment, outside of the folder. 

 Add New in the File menu (Section 2.4.1) and New Report in 

the Experiment menu (Section 2.4.4). 
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5.13.1 Add Data to Report 

When a new report folder is added to the data structure in a project, the Report 

Writer will automatically contain all the graph files within the same part of the 

structure, at the same level. The example in the previous section showed how to 

create a report that would include three graph files from the MAT Test, but the 

graph file for the FRA Test was missed out because it was in a different part of 

the structure. To continue this example and add the FRA Test to the list of 

Included Graphs, proceed as follows: 

1.  

 

Click the Add Graphs button, in the Report Writer sub-screen, to 

display a filing system dialogue box, listing the data files and 

graph files associated with the MAT Test. Navigate upwards one 

level and open the Additional Tests folder, then the FRA Test 

experiment, then the FRA Test.graph file. The file will appear in 

the Report Writer, in the list of Included Graphs. 

Alternatively, drag and drop the graph file from the left-hand navigation panel 

to the list of Included Graphs (but make sure you hold down the mouse 

button, because if you click and release, the Graph Setup screen will appear). 

The Report Writer sub-screen, after addition of the FRA Test, will be as 

follows: 

 

2. Change the Report Filename field to something more suitable, for example 

MAT and FRA Tests. 
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3.  

 

Click the Generate Report button, to the right of the 

Report Filename field, to create an RTF file with the specified 

name in the report folder, and display the contents of the report 

in the lower panel as follows: 

 

Scroll down and review the report, and you will find that it contains the 

results of the three MAT Tests, followed by the FRA test. 

The report will remain on display only temporarily, until you click another 

item in the navigation panel. To redisplay the report, you need to click on the 

appropriate RTF file under the Getting Started report folder. There are 

currently two of them (as a consequence of choosing a new name for the 

report to include the FRA test), as follows: 

 

4. If you want to redisplay the contents of the one of these reports, proceed as 

described in the next section. 
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5.13.2 Open Report 

A report can be opened using any Windows application that supports the RTF file 

format, for example word-processing programs, then you can view and process 

the report, using the features of the program, such as editing and printing. 

To open a report, proceed as follows: 

1. In the left-hand navigation panel, expand the report folder and click on the 

RTF file. The File Information screen will appear as follows:  

 

 The fields in this screen are described in Section 5.14. 

2. Click the Open button to open the report file in the default application on 

your computer that uses the RTF file extension. Alternatively, click the 

Open Folder button to open the Windows filing system folder where the file is 

located, then use the standard Windows features to open the file in any 

application that uses the RTF format. 

3. Use the features of the application to do whatever you want with the report, 

for example editing and printing. 
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5.13.3 Report Writer 

The Report Writer sub-screen, which appears when a report folder is selected 

from the navigation panel, is as follows: 

 

The fields and buttons are: 

Included Graphs 

This field contains the full pathnames of all the graph files to be included in the 

report. The list defaults to all the graph files in the navigation tree, alongside the 

report folder at the same level. Files can be added to the list using the 

Add Graphs button (see the list of buttons below), or by dragging the graph items 

from the left-hand navigation panel. They can be removed from the list using the 

Remove Graphs button. 

Report Filename 

This field contains the filename (without the RTF extension) for the document 

that is generated when the report is run. The filename defaults to the report folder 

in the left-hand navigation panel, but you can change it. There is no need to 

specify the extension as this will be added automatically. The report can be run 

using the Generate Report button (see the list of buttons below). 

 

Add Graphs 

Click this button to add a graph to the list of Included Graphs. 

A dialogue box will open so that you can browse the filing system and 

select any file with the GRAPH extension. 

 

Remove Graphs 

Select a graph, or any number of graphs, from the list of Included 

Graphs, then click this button to remove them from the list. 

 

Generate Report 

Click this button to generate a report from the list of Included Graphs. 

The report will appear in the lower window, and an RTF file will be 
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created in the report folder, based on the specified Report Filename. 

5.14 FILE INFORMATION 

The files that are used by ModuLab XM are stored in the directory structure that 

appears in the filing system browser window when a project is opened. 

 Introduction to the User Interface, Section 2.1, and Open Project from the 

File menu, Section 2.4.1. 

ModuLab XM interprets the files within this directory structure (particularly 

those with the INFO and DATA extensions), to build the structure of items in the 

left-hand navigation panel and display the screens in the right-hand window. The 

item names in the navigation panel are based on the filenames, but do not display 

the extensions. 

If a file exists within the structure, that is not used by ModuLab XM, or has been 

created by ModuLab XM for use with other applications, it will appear in the 

navigation panel with the file extension. This will include the following: 

• CSV files containing tabulated lists of results. These can be created using 

Export Table or Export All from the Graph sub-screen, and can be opened 

from spreadsheet applications. 

 Graph, Section 5.10.1. 

• RTF files containing reports. These can be created using the Report Writer. 

 Reports, Section 5.13, and Report Writer, Section 5.13.3. 

• Z files for use with Zplot, for displaying exported data. 

• COR files for use with Corrware, for displaying exported data. 

 Data can be exported to Zplot and Corrware from the Export All button 

in the Graph sub-screen, Section 5.10.1.  

If you click on a file in the navigation panel that displays an extension, for example a 

report file, the File Information screen will appear as follows: 



Software Reference: Project  ModuLab XM MTS Materials Test System: User Guide 

5-140  21006013_AE 

 

This screen gives information about the file, and you can open it from other 

applications using the Open or Open Folder buttons. The fields and buttons are as 

follows: 

Name 

The filename, including the extension. 

Location 

The directory path where the file is located. 

Browse 

 
This button appears only if the File Information screen represents a 

shortcut folder, and enables you to browse the filing system and locate a 

folder. 

 Shortcut Folder, Section 5.14.1. 

Size 

The size of the file. 

Created 

The date and time when the file was created. 

Modified 

The date and time when the file was last modified. 

Open 

This button opens the file in the default application on your computer that 

uses the specified extension. 
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Open Folder 

This button opens the Windows filing system folder where the file is located. 

The file can then be opened in any application that supports the appropriate 

file format, according to the extension. 

WARNING: The File Information dialogue box provides a safe method of 

opening files that are not used by ModuLab XM. Do not open 

files from the project directory using the standard Windows 

features, unless you have already seen that files with the same 

extension appear in the ModuLab XM navigation panel. 

Otherwise, you could edit a file that is used by ModuLab XM, and 

the project might become corrupt. 

5.14.1 Shortcut Folder 

In addition to referencing files, the File Information dialogue box can represent a 

shortcut folder which points to a folder anywhere on the filing system, containing 

a collection of files. This provides a convenient method of opening files from 

other applications that might be relevant to ModuLab XM. A Shortcut folder is 

created as follows: 

1. From the File Menu, select Add Shortcut. A shortcut folder will appear at the 

bottom of the navigation tree. (It doesn’t matter which item in the tree has 

been selected. The shortcut folder always appears at the bottom). 

2. Select the Shortcut folder to display the File Information screen as follows: 

 

This is the same as the File Information dialogue box described in the 

previous section, except that it represents a shortcut folder instead of a file, 

and there is a Browse button so that you can select a destination folder from 

the filing system. The fields are initially blank because a destination folder 

has not been specified. 

3. Click the Browse button and navigate to a destination folder, then click OK. 

The shortcut folder in the left-hand navigation panel will be re-named 

according to the destination folder, and will be populated with all the files and 

sub-folders. The Browse button will disappear from the File Information 
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screen and the fields (except the Size) will be filled in with the folder 

information. 

The following screen shows a shortcut representing a folder that contains a 

copy of this manual.  

 

4. Open the file in the usual way, using the Open or Open Folder buttons. 
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6. Appendix  

6.1 WAVEFORM GENERATION AND MEASUREMENT 

The ModuLab XM system applies a waveform to the sample, according to the 

Step Setup, and then measures the resulting voltage or current using the 

appropriate connections (2-terminal or 4-terminal). 

 Step Setup, Section 5.7. 

 Connections field in the Instrument Experiment Setup, Section 5.3.4. 

The materials core module has three amplifiers, and the circuit representing 

4-terminal connections is shown in Figure 6-1. 

 

Figure 6-1 Waveform generation and measurement, 4-terminal 

An input is applied to the amplifier A1 such that the output is the required 

waveform. This passes through a 50 resistance for cable matching and is 

applied to the sample as the generated voltage (GEN). 

The resulting potential difference across the sample (Vhi, Vlo) is passed through 

amplifier A2 to the voltage measurement circuit. 

The output current (I) is passed through the amplifier A3 which produces a 

voltage for measurement purposes, proportional to the current. 
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The corresponding circuit for 2-terminal connections, normally used for high 

impedance measurements, is shown in Figure 6-2. 

 

Figure 6-2 Waveform generation and measurement, 2-terminal 

In this case, the cable impedance becomes less significant compared with the 

impedance of the sample, and instead the current losses through the amplifier A2 

become more important. To compensate for this, the Vhi and Vlo connections to 

the sample are not used, and the sockets are internally connected to the output 

from the 50Ω impedance on A1 and the LO input on A3. 

6.2 ENVIRONMENTAL INTERFERENCE AT LOW CURRENT 

Low current measurements in the femto-amp range can be affected by electrical 

interference from the environment, such as electric lighting, office equipment and 

cables. Mechanical vibrations can also have an effect, if they generate electrical 

interference within the cables that are used for measurement purposes. These 

effects are likely to be important in experiments that use the femto ammeter under 

conditions of low current and high impedance. 

 High Impedance Materials Testing, Section 3.3.2.3 

 High Voltage / High Impedance Materials Testing, Section  3.3.2.4 

To mitigate these effects, every effort should be made to eliminate electrical and 

mechanical interference from the environment, by removing equipment that is not 

needed for the experiment. 
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The following precautions can also be taken: 

 A Faraday cage can be used to reduce electrical interference from the 

environment. (Section 6.2.1) 

 Tribo-electric precautions can be taken to reduce vibrations that may induce 

electrical interference within the cables. (Section 6.2.2) 

6.2.1 Faraday Cage 

To reduce electrical interference from the environment, the sample should be 

totally enclosed in a Faraday cage, consisting of an electrically conducting metal 

enclosure which captures the signals from the environment and evenly distributes 

them in the space around the sample. 

The cage must be a continuous metal conducting enclosure with no gaps or empty 

holes. If the enclosure consists of multiple components (for example a box with a 

lid), all parts of the box must be electrically connected. 

Sockets must be fitted to the cage so that there is good electrical connection 

between the outer shell of the socket and the metallic body of the cage, and there 

must not be any insulating washers. The insulating material within the socket, 

which separates the core from the outer shell, must be PTFE (not PEEK 

dielectric). BNC connectors will meet these requirements. 

The dielectric reference module, supplied with ModuLab XM MTS for testing the 

system, is designed as a Faraday cage with BNC connectors as shown in 

Figure 6-3: 

 

Figure 6-3 Dielectric reference module 

The ModuLab XM MTS system is supplied with shielded BNC cables so that the 

shield connects to the body of the cage and the inner core goes through to the 

appropriate sample electrode. 

6.2.2 Tribo-Electric Effects 

If there is mechanical vibration in the environment, the inter-connecting cables 

between the ModuLab XM system and the sample will generate small electric 
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currents, caused by the inner shielding braids and dielectrics rubbing together. 

These induced currents are normally insignificant, but will cause problems when 

measuring currents in the pico or femto-amp range. 

To mitigate these effects, the sample and all the connecting cables should be 

secured to a rigid surface, and the Faraday cage, if used, should be internally and 

externally secure. 

6.3 SAMPLE HOLDER 

The 12962A sample holder passes a current between two electrodes, across a 

measured thickness of the sample, for accurate testing of materials at room 

temperature. It includes a micrometer for measuring sample thickness, which can 

range from 0.2 to 25.4mm. The impedance measurement range, when using the 

sample holder with the ModuLab XM system, is <1Ω to >100TΩ. 

The sample holder, shown in Figure 6-4, has two 

parallel electrodes as follows: 

• The ‘Hi’ electrode is a standard sized 45mm 

diameter disc, which can be moved into 

contact with the sample by adjustment of the 

micrometer. This electrode is used for 

measuring all samples, solid or liquid. 

• The ‘Lo’ electrode is fixed in position, but can 

be replaced by a number of alternative 

versions to suit the diameter of the sample. 

The standard version, supplied with the 

sample holder, is for testing solid materials 

and has a 20mm diameter active area. 

 Section 6.3.3, Changing The Fixed 

Electrode Assembly. 

The alternative fixed electrodes are available in 

two accessory kits as follows: 

• A solid sample electrode kit, consisting of 

three fixed electrodes for testing solid 

materials of different sizes. The active 

electrode diameters are 10mm, 30mm and 

40mm. 

• A liquid sample electrode kit, with a single 

electrode for testing liquid samples.  

Figure 6-4 Sample 
holder with standard 
20mm fixed electrode 

All fixed electrodes, solid or liquid, utilise guard ring techniques to reduce the 

fringing effect of stray fields at the edge of the sample. In the case of solid 
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samples, the diameter of the sample should be at least 10% greater than the 

electrode diameter to avoid fringing. 

 Section 6.3.2, Electrode Assemblies and Guard Ring. 

NOTE: The diameter of the solid sample fixed electrode assembly, including 

the guard ring, is 45mm, same as the adjustable electrode. The active 

electrode area is the smaller disc at the centre. 

If you wish to improve the accuracy of your measurements, you can use 

measurement normalisation. 

 Section 6.3.6, Normalisation 

The sub-sections below apply to the 12962A sample holder and the available 

accessories. For information about other sample holders, including those for high 

and low temperature applications using cryostats and furnaces, please contact 

Solartron. 

6.3.1 Sample Geometry 

The ModuLab XM MTS software requires knowledge of the geometry of the 

sample, in terms of thickness and electrode area. 

 Section 5.3.3, Sample setup. 

The thickness of the sample can be read from a micrometer digital display that is 

included as part of the sample holder. The area of the sample is defined by the 

area of the central Lo electrode. These dimensions are used by the ModuLab XM 

MTS software to calculate the permittivity of the material (which is independent 

of the size of the sample), using the formula: 

ε = C.d/A 

where: 

ε = permittivity (F/m) 

C = capacitance (F) 

d = thickness (m) 

A = area (m2) 

This allows results from materials of different sizes to be compared. 

Results can be displayed using the ModuLab XM software as absolute or relative 

permittivity. Relative permittivity of the material, also known as the “dielectric 

constant” is calculated as: 

εr = ε / ε0 

where 

εr = relative permittivity 

ε0 = permittivity of free space (8.85419E-12 F/m) 
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6.3.2 Electrode Assemblies and Guard Ring 

The solid or liquid material sample is measured between the Hi electrode, 

adjustable from the micrometer, and the fixed Lo electrode assembly which 

includes a guard ring, separated from the electrode by a layer of insulation. 

(Figures 6-5 and 6-6). 

The purpose of the guard ring is to reduce the effect of stray field lines at the edge 

of the sample that would otherwise lead to measurement errors. It ensures that the 

electric field lines are parallel throughout the part of the sample that contributes 

to the impedance measurement. 

 

Figure 6-5 Solid sample and electrodes 

The guard ring is connected to ground on the sample holder, while the Lo 

electrode is virtually the same ground potential because the current to voltage 

converter in the ModuLab XM system (core module and femto ammeter) is a 

‘virtual earth’ device. There is no potential difference between the Lo electrode 

and the guard ring and therefore the field lines at the edge of the “Lo” electrode 

are maintained parallel to each other. The impedance of the sample is calculated 

from the voltage drop across the sample and the current flowing through the 

central part alone of the sample where the field lines are parallel. The current 

flowing through the edge of the sample and the air surrounding the sample is not 

measured – it goes directly to earth and therefore does not contribute to the 

measurement. 

For measuring liquid samples (Figure 6-6), the fixed Lo electrode assembly has a 

guard ring to maintain parallel electric field lines through the sample, but has the 

following additional features: 

• It is shaped like a dish so that it can hold small samples of liquid. 

• It can be disassembled for cleaning. 
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Figure 6-6 Liquid sample and electrodes 

The ModuLab XM system should be internally grounded when connected to the 

solid or liquid sample holders. 

6.3.3 Changing The Fixed Electrode Assembly 

The fixed Lo electrode assembly can be changed as follows: 

1. Using the micrometer, move the travelling electrode as far away as possible 

from the fixed electrode assembly. 

2. Carefully unscrew the fixed electrode assembly from the body of the sample 

holder, using finger pressure only. 

3. Store the electrode assembly in a safe place. 

4. Screw the new electrode assembly into the body of the sample holder, taking 

care to keep the assembly properly aligned with the sample holder to avoid 

crossing the threads. Tighten the electrode gently against the body, using 

finger pressure only. 

CAUTION: Do not over tighten the fixed electrode. 

CAUTION: Do not attempt to separate the components of the fixed electrode 

assemblies for solid samples (electrode, insulation and guard 

ring). Any attempt to do so will adversely affect measurement 

accuracy, and will render the warranty invalid. 

6.3.4 Measuring Solid Samples 

To measure the electrical properties of solid samples, proceed as follows: 

1. Make sure the correct fixed electrode is fitted, according to the sample size. 

 Section 6.3.3. 

2. Remove the sample if it is currently held between the electrodes. 

3. Turn the micrometer so that the electrodes move into contact with each other. 

4. Press the ‘Zero/Abs’ button, to zero the micrometer display. 

5. Toggle the in/mm button to set the display to the required units. 
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6. Turn the micrometer and place the sample between the electrodes, and adjust 

it so that the sample is held gently but firmly. 

7. Note the reading on the micrometer display. 

8. Set up the experiment in ModuLab XM MTS, and enter the sample thickness 

and electrode area in the Sample Setup. (The area is based on the diameter of 

the fixed Lo electrode, without the insulation and guard rail). 

 Section 5.3.3, Sample Setup. 

9. Run the experiment and take measurements using the ModuLab XM MTS 

software. 

6.3.5 Measuring Liquid Samples 

To measure the electrical properties of liquid samples, 

with the liquid sample electrode fitted, proceed as follows: 

1. Make sure all liquid is removed from the liquid 

sample electrode. 

2. Zero the micrometer, same as for the solid sample 

electrode. 

 Section 6.3.4, steps 3 to 5. 

 

Figure 6-7 Liquid 
sample holder 

3. Turn the micrometer and adjust the position of the upper electrode so that it is 

slightly greater than the required sample thickness. 

4. Place the sample liquid into the lower dish electrode so that it almost reaches 

the upper electrode. 

5. Move the upper electrode carefully towards the lower electrode until the 

required sample thickness is displayed. The upper electrode is slightly smaller 

than the dish of the lower electrode assembly so that excess liquid can escape 

around the side of the upper electrode. Make sure a small amount of liquid 

rises up, as this will ensure that the upper electrode is fully in contact with the 

liquid and there are no air spaces. However, do not go past the required 

thickness, otherwise too much liquid will rise up, and it will distort the results 

because it is not in contact with the front face of the upper electrode. 

6. Set up the experiment in ModuLab XM MTS and enter the sample thickness 

and electrode area in the Sample Setup. (The area is based on the diameter of 

the fixed Lo electrode, without the insulation and guard rail). 

 Section 5.3.3, Sample setup. 

7. Run the experiment and take measurements using the ModuLab XM MTS 

software. 

6.3.6 Normalisation 

For optimum accuracy when using liquid or solid sample holders, you should 

make use of the normalisation technique. This will reduce the errors due to 

fringing, connections, etc. 
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There are two possible methods of normalisation: matched cell geometry and 

matched cell capacitance. Both have advantages. Matched cell capacitance gives 

the best cancellation of instrumentation errors, whereas matched cell geometry 

optimises the cancellation of fringing effects. Select the one that gives you the 

best results. 

6.3.6.1 Method 1 - Matched Cell Geometry 

1. Take measurements on the sample in the usual way, making a note of the 

micrometer setting. 

 Sections 6.3.4 and 6.3.5. 

2. Remove the sample, clean the electrodes if necessary, and reset the 

micrometer to the setting noted above. This will create an air gap cell with the 

same dimensions as the cell used for the sample. 

3. Measure the impedance of this air gap cell at the same frequencies as before, 

and use this data as the normalisation data. 

6.3.6.2 Method 2 - Matched Cell Capacitance 

1. Take measurements on the sample in the usual way and note the capacitance 

of the sample. 

 Sections 6.3.4 and 6.3.5. 

2. Remove the sample and clean the electrodes if necessary. Calculate the air 

gap, d (in m.), required to create an air gap cell with the same capacitance as 

the sample, using the equation: 

d = Aε0/C 

where: 

A is the area of the cell (m2) 

C is the required capacitance (F) 

ε0 is the permittivity of free space (8.85419E-12 F/m) 

3. Set the micrometer to the calculated air gap, measure the impedance of this 

air gap cell at the same frequencies as those used for the sample 

measurements, and use this data for normalisation. 

6.4 CRYOSTAT 

The 129610A Cryostat system is available for testing materials in the following 

temperature ranges: 

• From 78K to 600K using liquid nitrogen. 

• From 5K to 600K using liquid helium. 
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This model of the cryostat system (shown in Figure 

6-8) is a special design, produced by Janis Research 

Company in collaboration with Solartron, to meet 

specific requirements of temperature range control, and 

to place the sample in a static thermal exchange gas (for 

example dry helium), to provide repeatable tests on 

materials that could otherwise be affected by contact 

with cryogen vapor in flowing vapor type systems. 

The cryostat may be used for the following typical 

applications: 

• Development of advanced polymer materials; 

• Pharmaceutical applications including drug delivery 

and freeze drying; 

• Semiconductor materials; 

• Composite materials and coatings; 

• Display materials; 

• Aerospace materials. 

 

Figure 6-8 Cryostat 
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The internal assembly of the cryostat system is shown in Figure 6-9. 

 

Figure 6-9 Cryostat internal assembly 

The sample is located in a sample space containing an inert atmosphere of helium 

gas. Outside the sample space there are two vacuum chambers separated by a heat 

shield, to provide insulation from the external environment. Temperature control 

is achieved by a cooling capillary and two heating coils, located in the inner 

vacuum chamber around the sample space. The flow of cryogen through the 

capillary and the power to the heaters are adjusted so that they work against each 

other to achieve the required control, while minimising the loss of cryogen. The 

heaters are turned off to achieve the lowest temperature, and the cryogen is turned 

off when temperatures above ambient are required. 

The cryostat has the following features: 

• Solid and liquid sample holders are included for testing a wide range of 

materials including solids, gels, oils, powders, pastes, etc. 

• The sample holders use guard ring techniques to reject "fringing" effects at 

the edge of the sample.  

• High and low impedance material samples can be accurately tested using two 

or four terminal sample connections. 

 The connection type is identified in the ModuLab XM MTS software, 

in the Instrument Experiment Setup, Section 5.3.4. 

• Fast and accurate temperature settling using a dual channel temperature 

controller. There are two heaters, one to achieve the required temperature 

quickly, and the other to maintain accurate temperature control. 
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• The system operates with continuous flow of cryogen via a transfer line from 

the dewar.  

• The cryogen may be either liquid nitrogen or liquid helium, which must be 

selected at the beginning of the experiment, and there is no mixing of 

cryogens. 

• The inert atmosphere of helium gas in the sample space prevents cracking 

and swelling that might otherwise occur if the sample was placed directly in 

the flow of cryogen. 
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7. ModuLab XM MTS Support  

7.1 RANGE OF SUPPORT PROVIDED 

Solartron Analytical provides you with full support to enable you to use the 

ModuLab XM system to your best advantage. The support includes: 

• A full set of user guides, available in printed form, on CD, and on-line from 

the Solartron Analytical website. 

• On-line Help from the ModuLab XM user interface, comprising: 

• The ModuLab XM Help Text. From the Help menu, select Contents or 

Index. 

• Answers to a list of Frequently Asked Questions, covering all aspects of 

ModuLab XM use. From the Help menu, select FAQ. 

• An on-line version of the User Guide for the ModuLab XM User 

Interface. Right-click on the project, in the left-hand navigation panel, 

and select Explorer, then open the Documents folder, under the ModuLab 

XM folder. 

• A check for new versions of the ModuLab XM software. From the Help 

menu, select Check for updates. 

• Technical support, including locations of support centres for worldwide 

servicing of equipment. From the Help menu, select Technical Support. 

• Access to the Solartron Analytical website, which contains a wealth of 

information and guidance on the use of Solartron Analytical precision 

instrumentation for your particular application. 

 Solartron Analytical Website, Section 7.2. 

7.2 VISITING THE SOLATRON ANALYTICAL WEBSITE 

To visit the Solartron Analytical website, click on in the appropriate button in the 

ModuLab XM toolbar, or alternatively enter the following address in your 

browser: 

www.solartronanalytical.com 

 

This site contains full information on the products available from Solartron 

Analytical for applications in the fields of electrochemistry, energy storage, 

corrosion, materials, control, electronics test, and metals analysis. Click on the 

various boxes in the site to find out which of our precision instruments may best 

suit your particular application. Solartron Analytical can provide a full range of 

technical expertise, in the form of technical notes and technical training to guide 

you in this. You can also contact our sales and marketing team through the 

website to get immediate expert advice. 

http://www.solartronanalytical.com/
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When you need an upgrade for your ModuLab XM software you can download 

this from our website. This enables you to keep your ModuLab XM system up to 

date, and in line with the very latest improvements. 
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8. Glossary of Terms  

This chapter contains a glossary of terms, including abbreviations, that are 

commonly used in the manuals associated with the ModuLab XM system. 

Term Meaning 

Analyzer The function that measures the frequency response of the test 

unit.  The analysis techniques used are single sine and Fast 

Fourier Transform. 

Auxiliary Used in the context of the measurement of elements within a 

test unit, i.e. through an auxiliary channel. 

Booster An internal module that can be used to stimulate the sample 

and take measurements at high power ratings. 

Channel The combination of input and output connections required to 

measure a single test unit. 

Chassis A mechanical structure, containing slots, that is used to house 

modules.  The chassis also embodies a power supply and an 

Ethernet hub. 

Core Product A module, within the system, that is able to make standalone 

measurements. 

Decision An item within the experiment structure that contains options to 

be evaluated so that steps can be carried out. 

Experiment An action to be performed on a sample, including a series of 

steps, using a specific hardware configuration. During each 

step a stimulation signal is applied to the sample and 

measurements are taken. Results are accumulated and may be 

presented as graphs and reports. 

In terms of the Windows filing system, an experiment is a folder 

which is recognised by ModuLab XM because of its contents. 

Experiment Type A category of experiments in which a number of hardware 

configurations are available for a range of similar applications. 

Experiment types include General Materials Testing, High 

Voltage Materials Testing, etc. 

Femto Ammeter An optional module that can be included in an instrument group, 

to provide low current measurements of high impedance 

samples. 

Folder A location in the Windows filing system containing data that is 

meaningful to ModuLab XM. A folder can be recognised by 

ModuLab XM as a project, experiment or report folder, 

depending on its contents. A folder may also be added, within a 

project structure, as a location for any data that is useful to the 

project, including sub-folders that represent experiments and 

report folders. 

FFT Fast Fourier Transform. 

High Voltage Module An optional module that can be included in an instrument group, 

together with a materials core module, to provide high voltage 

stimulus to a sample and take measurements. 
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Impedance The relationship between voltage and current in AC systems 

(the AC equivalent of DC resistance). 

Instrument Group A combination of modules that work together to stimulate a 

sample and take measurements. The group contains a 

materials core module and a number of optional modules as 

required. 

Loop A control feature within an experiment that enables other 

controls to accumulate data on a repetitive, cyclic basis. 

Loop Type A number of different types of loop are available. There is the 

standard loop, for repeating any specified sequence of steps, 

and there are loops which can be configured for repeating 

impedance steps with different AC amplitudes or DC bias 

levels. 

Module Any single product that can be fitted individually into a chassis 

slot. 

Noise Random fluctuations in sample voltage. 

Option A condition to be evaluated under a decision, to enable steps to 

be carried out 

Project A top-level folder in the Windows filing system which may 

contain experiments and other related items. ModuLab XM 

recognises the folder as a project because of its contents. 

Report A document describing an experiment, which can be opened in 

a word processor for editing and printing. The document may 

contain experiment settings and results, including connection 

diagrams, graphs, tables and user comments. The data 

displayed in a report is based on the graph files associated with 

the experiments. 

Any number of document files, each with the RTF extension, 

can be generated by the Report Writer under a report folder, 

and can then be displayed and edited using any Windows 

application that supports the RTF format. 

Report Folder A folder which is recognised by ModuLab XM as a container for 

reports. The Report Writer appears when the user clicks on the 

report folder in the navigation panel, and reports can be 

generated from any number of graph files. 

Slot A space in a chassis into which a single width module can be 

inserted. 

Step A definition of how an experiment will progress over a specific 

period of time, including the stimulation signal and the 

measurements to be taken. Any number of sequential steps can 

be included in an experiment. 

Step Type The general shape of the stimulation signal to be applied to the 

sample during a step, for example Linear Sweep, Triangular 

Sweep, etc. The complete definition of a step requires values to 

be applied to the step type, such as the signal level, duration, 

and upper and lower limits. 
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System A combination of one or more modules, in one or more 

chasses, and other equipment (temperature controllers, 

cryostats, ovens, etc.) all operating under software control from 

a PC. 

Temperature Control A control feature within an experiment that applies temperature 

variations to a sample. 

Test Unit Any item under test being measured by the system. 
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CSV file, 2-12, 5-85, 5-143. See also 

export data 

data separator, 4-3 

data 

data reduction, 5-90 

scaling, 5-101 

data (results of experiments), 2-8, 3-13, 5-

9, 5-83, 5-87, 5-130, 5-133 

DATA file extension, 2-12 

data selection, 5-86, 5-106 

data set, 5-88, 5-89, 5-92 

data selection, fitting, 5-112, 5-116 

differential pulse, 5-50, 5-67 

distributed element, 5-120, 5-127 

earth. See ground 

electrode 

area, 5-15 

empty cell capacitance, 5-15 

equipment library, 2-6, 2-13, 2-18, 4-8, 5-

17. See also virtual equipment 

equipment summary, 4-8 

equivalent circuit fitting, 5-117 

error icon, 2-27, 3-8, 5-13 

Ethernet, 1-1. See also IP address 

hub, 1-1, 8-1 

Eurotherm. See temperature 

controller:model 

exit ModuLab XM, 2-16, 2-28 

expanded system, 1-1, 1-3, 2-6 

experiment, 2-8, 5-5 

limits, 5-20 

new, 5-5 
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setup, 2-4, 2-8, 2-19, 3-6, 5-5, 5-10, 5-

21, 5-24, 5-26 

instrument, 5-8, 5-17, 5-29, 5-45 

start, 2-18, 2-23, 3-4, 3-12, 5-7 

explorer, Windows, 2-11 

explosive atmospheres, iii 

export data, 2-12, 3-18, 5-84. See also 

CSV file 

export all, 5-85 

export table, 5-85 

external program, 5-49, 5-70 

Faraday cage, 6-3, 6-4 

femto ammeter, 1-1, 3-28, 3-29, 4-8, 4-10, 

5-7, 5-12, 5-13, 5-14, 8-1 

femto amp, 3-28, 3-29 

file information, 2-12, 2-16, 5-85, 5-141, 

5-143, 5-145 

fitting, 5-108 

folder icon, 2-21 

FRA. See frequency response analyzer 

frequency response analyzer, 1-1, 1-2, 3-1, 

3-19, 3-22, 3-24, 3-25, 4-8, 4-14, 5-8, 5-

13, 5-32, 5-51, 5-129, 5-130 

IP address, 4-14, 4-15 

model, 4-9, 4-14 

test, 5-130, 5-134 

voltage range, 5-34 

voltage range representing current, 5-34 

fuses, iii 

generator, 3-13, 5-9, 5-48, 5-49 

Gerisher element, 5-120, 5-127 

graph, 2-8, 2-13, 3-17, 5-84, 5-92 

data reduction, 5-90 

default graph type, 4-6 

display graph, 2-27 

file, 5-106 

fitting mathematical functions, 5-108 

included in report, 5-136, 5-142 

layout of graphic displays, 5-93 

preferences, 3-3, 4-4, 5-47, 5-94 

setup, 5-30, 5-47, 5-93, 5-94, 5-99, 5-

139 

trace setup, 5-88 

ground, iii, 3-8, 3-24, 5-14, 5-120 

group. See instrument group 

guard ring, 6-6 

hardware requirements, 5-11 

high voltage module, 1-1, 1-2, 3-27, 3-29, 

3-31, 4-8, 5-7, 5-14, 8-1 

bypass, 5-14 

model, 4-9 

hub. See Ethernet 

impedance, 3-19, 3-25, 5-32, 5-36, 5-108, 

5-117, 5-121, 5-126, 5-127, 8-2 

constant level, 3-1, 3-19, 3-21, 3-23, 5-

36, 5-51, 5-56, 5-83 

harmonics, 5-35 

high, 1-1, 1-2, 3-28, 3-29 

imaginary, 5-115, 5-116 

logarithmic, 5-100 

magnitude, 2-24, 3-23, 5-99, 5-130 

plot, 5-95, 5-112 

setup, 3-21, 3-22, 5-29, 5-30 

step, 4-6, 5-8. See also step:AC 

voltage control, 2-8, 3-20, 3-24, 5-25, 5-

51 

INFO file, 2-12 

installation, 1-3 

instrument 

configuration, 2-27, 3-7, 3-11, 3-24, 5-7, 

5-12, 5-13, 5-14, 5-17 

experiment setup, 5-8, 5-17, 5-29, 5-45, 

5-102 

step setup, 5-29, 5-45 

instrument group, 1-1, 2-6, 2-13, 2-23, 2-

27, 3-5, 3-24, 4-8, 4-9, 5-8 

capability, 4-9, 5-8 

custom, 3-8, 5-9 

icon, 2-21 

item, 3-14, 3-17, 4-8 

name, 4-9, 4-13 

setup, 2-6, 4-8, 4-9, 4-13, 5-83 

status, 2-27, 4-10 

to use for experiment, 3-7, 3-12, 5-8, 5-

12 

interference, environmental, 6-2 

IP address 

chassis display, 4-11, 4-12 

FRA, 4-14, 4-15 

gateway address, 4-12 

materials core module, 4-13, 4-14 

subnet mask, 4-12 

isotropic axes, 5-96 

Lakeshore. See temperature 

controller:model 

legend, 5-90, 5-96, 5-101 

lifting and carrying, 1-3 

line fitting, 5-111 
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linear sweep, 3-10, 3-15, 3-17, 5-50, 5-57 

impedance, 5-51 

staircase, 5-50, 5-60 

staircase impedance, 5-51 

LO, 3-8, 3-24, 5-14 

loop, 2-8, 2-13, 5-5, 5-21, 5-72 

AC amplitude scanning, 5-73 

DC bias scanning, 5-76 

new, 5-21 

setup, 5-22 

temperature, 5-79 

matched cell 

capacitance, 6-9 

geometry, 6-9 

material sample. See sample 

materials core module 

communication, 1-3 

current range, 5-18, 5-45 

IP address, 4-13, 4-14 

test, 2-3, 2-4, 5-134 

voltage range, 5-18, 5-45 

measurement 

range. See range 

setup. See time domain measurement 

setup 

ModuLab XM support, 7-1 

module, 1-1, 8-2 

address. See IP address 

communication, 1-1 

information, 2-27, 4-10 

optional, 1-1, 2-6, 2-27, 3-1, 3-5, 3-8, 4-

8, 4-9, 4-13, 5-138 

specification, 5-8 

status, 2-5, 2-18, 2-22, 2-23 

navigation panel, 2-10 

network, 4-12, 4-13, 4-14 

new project, 2-14, 3-2, 5-2 

OC measure, 2-26, 3-5, 3-13, 5-9 

open circuit, 2-26, 3-5, 3-13, 5-9, 5-36, 5-

48, 5-53, 5-55. See also OC measure 

open project, 2-14, 2-21, 5-3 

PID control, 4-20, 4-22 

autotune, 4-19 

power, iv, 1-1, 1-2, 1-3, 3-1, 3-12, 3-26, 4-

3, 5-37, 5-97, 8-1. See also sample:high 

power 

preferences, 2-5, 4-2 

advanced, 4-7 

default graph types, 4-6 

general, 4-3 

graph, 4-4 

messages, 4-4 

print, 5-84, 5-119 

preview, 5-85 

project, 2-18, 5-1 

close, 2-14, 5-3 

folder, 2-9 

new, 2-14, 3-2, 5-2 

open, 2-14, 2-21, 5-3 

recent, 2-15 

save, 2-16, 2-21 

tab, 2-4, 2-7, 5-1 

pulse, 5-36, 5-50, 5-64 

differential, 5-50, 5-67 

sweep, 5-50, 5-65 

range, 5-104 

auto range speed, 5-19, 5-45 

current, 5-18, 5-45 

force recording, 5-19, 5-45 

voltage, 5-18, 5-45 

recent projects, 2-15 

reference voltage, 3-8, 3-24, 5-14 

relative values, 5-53 

report, 2-9, 2-13, 5-133, 8-2 

add data, 5-139 

filename, 5-142 

folder, 2-9, 2-19, 5-134, 5-139, 5-141, 

5-142, 8-2 

generate, 5-142 

included graphs, 5-136 

new, 2-19, 5-136 

open, 5-141 

writer, 5-136, 5-139, 5-142 

results. See data 

RTF file, 2-12, 5-134, 5-137, 5-140, 5-

141, 5-142, 5-143, 8-2. See also report 

safety, iii, 3-27, 3-29 

sample 

connection diagram, 2-9, 3-5, 3-6, 3-7, 

3-11, 3-24, 5-7, 5-8, 5-12 

geometry, 6-5 

high impedance, 3-28, 3-29, 8-1 

high power, 3-30, 3-31 

high voltage, 3-27, 3-29, 3-31 

holder, 6-4 

material, 1-3, 3-1, 3-12, 3-25, 3-26 

setup, 5-15, 5-32, 5-53 

save project, 2-16, 2-21 
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save all experiments, 2-16, 2-22 

scaling, 5-101 

scan rate, 3-10, 5-38, 5-54, 5-58, 5-60, 5-

61, 5-63 

scan setup, 3-10, 3-21, 5-29, 5-38, 5-52 

shortcut folder, 5-145 

Solartron website, 7-2 

square wave, 5-50, 5-68 

stability, temperature, 4-23 

staircase linear sweep, 5-50, 5-60 

impedance, 5-51 

staircase triangular sweep, 5-50, 5-62 

impedance, 5-52 

start experiment, 2-18, 2-23, 3-4, 3-12, 5-7 

status grid, 2-18, 2-22, 2-23 

step, 2-8, 2-13, 2-23, 5-5, 5-25, 8-2 

AC, 3-19, 5-30, 5-36. See also 

impedance:step 

category, 2-8, 3-9, 3-20, 5-25, 5-27, 5-

48 

general, 5-48 

voltage controlled impedance, 5-51 

voltage waveforms (DC), 5-49 

cyclic, 2-27, 5-38, 5-39, 5-40, 5-42 

DC, 3-9, 4-6, 5-36 

ID, 5-70 

impedance, 5-29 

item, 2-18 

linear, 5-39 

new, 2-19, 3-10, 3-19, 3-21, 5-6, 5-21, 

5-25, 5-27 

setup, 3-9, 5-28, 6-1 

instrument, 5-29, 5-45 

step selection icon, 2-21 

temperature settling, 5-80 

termination, 5-29, 5-43, 5-71 

type, 2-8, 3-9, 3-17, 3-20, 4-6, 5-25, 5-

27, 5-28, 5-36, 5-48, 5-49, 5-51, 5-52, 

8-2 

width, 5-42 

support, ModuLab XM, 7-1 

technical support, 2-20 

sweep pulse, 5-50, 5-65 

system tab, 2-4, 2-5, 3-2, 4-1, 4-2, 4-8 

table, 3-17, 4-5, 5-98 

export, 5-85 

technical support, 2-20 

temperature controller, 4-8, 4-10, 4-15 

diagnostics, 4-26 

manual control, 4-25 

model 

Eurotherm, 4-18 

Lakeshore, 4-21 

setup, 4-16 

test controller, 4-26 

temperature loop, 5-79 

temperature settling step, 5-80 

temperature stability, 4-23 

test unit, 1-3, 3-1, 3-12, 3-24, 3-26, 5-130 

time domain measurement setup, 3-11, 3-

21, 3-22, 5-29, 5-36, 5-37, 5-38, 5-39, 

5-41 

toolbar, 2-21 

trace setup, 5-88 

trace, selected for fitting, 5-109 

triangular sweep, 5-50, 5-58 

impedance, 5-51 

staircase, 5-50, 5-62 

staircase impedance, 5-52 

tribo-electric effects, 6-4 

user preferences. See preferences 

V=IR calculator, 2-19 

virtual equipment, 4-27 

voltage waveforms (DC), 2-8, 5-25, 5-49, 

5-51 

Warburg element, 5-120, 5-127 

warning icon, 2-27 

website, Solartron, 7-2 

Zplot, 5-85, 5-143 
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